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Introduction

Introduction

Welcome

About This Guide

Welcome to Gentran:Server® Windows® Application Integration subsystem, Sterling
Commerce’s Electronic Data Interchange (EDI) mapping software for the Windows
operating system.

Gentran:Server provides you with the tools you need to translate:

» your application files to EDI standard formats for documents you send to your
partners (outbound mapping)

» EDI standard formats to your application format for documents that you receive from
your partners (inbound mapping)

We believe that you will find this software and the supporting materials easy to use and
directly beneficial to your business.

Gentran:Server for Windows — August 2008 Forns Integration ANSI Tutorial Guide



About This Guide What’s in This Manual

What’s in This Manual

Assumptions This manual assumes that you are familiar with using a PC and with Microsoft® Windows
functions, including:

» The terminology used to describe mouse and cursor actions.

» The terminology used to describe Windows-specific attributes, including dialog
boxes, icons, windows, and buttons.

This manual also assumes that you are familiar with EDI concepts, EDI standard structure,
your internal application format, data mapping concepts, and the Gentran:Server product.

Description of  The majority of the Gentran:Server Application Integration documentation is contained in
contents the online Help system. This manual is intended to support the online Help by assisting
you in performing various tasks in the Application Integration subsystem. This task-
oriented approach is intended to answer any questions you may have about
Gentran:Server with step-by-step instructions.

The Application Integration User’s Guide is organized into chapters. A brief description
of the chapter contents follows.

» Chapter 1, Application Integration Basics, explains the content, organization, and
conventions in this guide, as well as the system requirements. This chapter also
describes how to use the extensive online Help system, how to get technical support,
and a brief outline of how to build maps using the Application Integration subsystem,
and gives you an introduction to mapping and Gentran:Server for Windows.

»  Chapter 2, Designing your Map, explains how to perform basic functions in the
Application Integration subsystem, including creating a new map; using fixed-format,
EDI, and CII files; opening, saving, and naming a map; compiling a map; and printing
a mapping report. This chapter also explains customizing display options; setting the
default date format; selecting which map components to use; cutting, copying, and
pasting; setting up the document name and reference; formatting your data; and using
field-to-field linking.

»  Chapter 3, Customizing the Properties of Map Components, explains how to
customize the properties of record, segments, looping structure, fields, elements,
composite elements, and TFDs. This chapter also explains how to use loop start (LS)
and loop end (LE) segments.

»  Chapter 4, Using Standard Rules, explains how to use the Application Integration
standard rules: select, update, constant, use accum, loop count, and use code. This
chapter also illustrates examples of when you would use certain standard rules.

»  Chapter 5, Setting Up the Import Process, explains all the facets of the import
process, defines import file restrictions, and describes how to create a system import
map.

»  Chapter 6, Setting Up the Export Process, explains all the export process and
describes how to use envelope information.

Forns Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 (



What’s in This Manual About This Guide

Description of
contents (contd)

Online Help
System

Chapter 7, Using Extended Rules, defines what extended rules are and when they are
used, and explains the proprietary programming language syntax.

Appendix A, Error Messages, describes Gentran:Server - Application Integration
error messages and specifies corrective actions.

Appendix B, User Exits, explains how to use user exits with Gentran:Server.

Appendix C, Using GentranEx.DLL, describes how to use GentranEx.DLL, the
Gentran:Server in-process automation server.

Appendix D, Using the Translator Command Line Interface, describes how to use the
command line to invoke the services of the TX32.EXE translator to perform
translation outside Gentran:Server, including generating a translator report in XML
format.

The Glossary contains mapping and Gentran:Server terms and concepts.

The majority of the documentation for Gentran:Server is contained in the online Help
system. This includes all the dialog box element definitions, detailed processing
information, and all the “how to” information from this manual.

Gentran:Server for Windows — August 2008
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About This Guide Getting Support

Getting Support

Introduction Sterling Commerce’s Gentran:Server software is supported by trained product support
personnel who are available to help you with product questions or concerns.

Note

Gentran:Server Customer Support does not support non-Sterling Commerce products
(e.g., SQL Server, Oracle, etc.), but can assist you in configuring non-Sterling Commerce
products to work with Gentran:Server.

Phone number For assistance, please refer to your Getting Started Guide to determine which support
phone number you should use.

Before calling  To help us provide prompt service, we ask that you do the following:

support » Attempt to recreate any problem that you encounter and record the exact sequence of

events.

»  When you call product support, you should be prepared to provide us with the
information below.

Information Description

Identification Your company name, your name, telephone number and
extension, and the case number (if the question refers to a
previously reported issue).

System Configuration The Gentran:Server version (and any service packs
installed) and information about the primary Gentran
system controller and all machines experiencing
problems, including: the Windows operating system
version, amount of memory, available disk space,
database version, Microsoft Data Access (MDAC)
version, and Internet Explorer version.

Also, please describe any recent changes in your
hardware, software, or the configuration of your system.

System Data Store Which machines contain folders in the system data store?

Error Messages Record the exact wording of any error messages you
receive and the point in the software where the error
occurred, as well as any log files.

Attempted Solutions Record any steps that you took attempting to resolve the
problem and note all the outcomes, and provide an
estimate on how many times the problem occurred and
whether it can be reproduced.

Forns Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()



Getting Support About This Guide

Accessing the The Sterling Commerce Customer Support Web Site contains valuable information about
Sterling getting support for Gentran:Server for Windows, including the:

Commerce ,  scope of support services,
Support Web Site .
» customer support policies,
» call prioritizing,
» customer support phone directory,
» how to create new Support on Demand cases,
» how to check the status of Support on Demand cases, and

» how to add information to Support on Demand cases.

The Customer Support Web Site is constantly updated and all Sterling Commerce
customers have access to it. This web site also contains the most recent product updates
and is a valuable source of product information.

Reference
Refer to the Getting Started Guide for information about how to access the Customer
Support website.

Documentation The Customer Support Web Site contains a documentation library, which has the entire
Gentran:Server for Windows documentation set. You can download the product manuals
in PDF format from this library at any time.

Gentran:Server for Windows — August 2008 Forns Integration ANSI Tutorial Guide
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Key Terms and Concepts Application Integration Basics

Introducing Mapping

Key Terms and Concepts

Map

Inbound mapping

Outbound
mapping

Source

A map is a set of instructions you define in the Gentran:Server Application Integration
subsystem that indicates the corresponding relationship between your application file and
the EDI standards (including the Japanese Center for the Information of Industry (CII)
standard), and defines how the system should translate data.

For inbound mapping, the system translates your trading partner’s EDI standard formatted
business document to your application file format. To translate inbound data, you need to
create an export map in Gentran:Server Application Integration (because the system is
exporting to your application file).

For outbound mapping, the system translates your application file format to EDI standard
formats, so you can send documents to your partners. To translate outbound data, you need
to create an import map and a system import map in the Gentran:Server Application
Integration subsystem.

Import map

You need to create an import map because the system is importing from your application
file. The import map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-formatted
documents that your partners expect to receive from you.

System import map

You need to create a system import map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the application file, so the
system knows which import map to use to process the document.

Reference
See How to Create a System Import Map on page 4 - 6 for more information.

After you create a map in the Application Integration subsystem, this map is the source
from which you compile a translation object.

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
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Application Integration Basics Key Terms and Concepts

Translation object A translation object is a set of rules that instruct the translator how to convert a file from
one format to another. Every function performed during translation requires a translation
object. Translation objects are used to control all the functions of Gentran:Server EDI
translation. Translation objects can belong to the following two categories: system
translation objects or user translation objects.

System translation objects

System translation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They are also used to generate and reconcile functional
acknowledgements.

User translation objects

User translation objects control data entry, importing, exporting, document turnaround,
and creating printed reports. All the required system translation objects are automatically
installed with the Gentran:Server system.

Application Integration User’s Guide Gentran:Server for Windows — August 2008 (



How to Use Application and Forms Integration Application Integration Basics

How to Use Application and Forms Integration

Introduction

Registering

translation objects

Partner
relationships

The Gentran:Server Application Integration subsystem enables you to generate import,
export, and document turnaround translation objects. The Gentran:Server Forms
Integration subsystem enables you to generate data entry and print translation objects.

Once you generate a translation object using the Gentran:Server Application Integration
subsystem (or the Gentran:Server Forms Integration subsystem), you must register the
translation object with Gentran:Server.

Reference
See Using Translation Objects in the Gentran:Server for Windows User s Guide for more
information.

In addition, you must establish correct trading relationships for all trading partners from
which you receive or to which you send data. During the process of establishing a trading
relationship, you need to specify the name of the appropriate translation object that the
translator uses to translate the data.

Reference
See Using Partners in the Gentran:Server for Windows User s Guide for more
information.

6
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Application Integration Basics Inbound and Outbound Translation Process

Inbound and Outbound Translation Process

Diagram

Outbound
translation

Inbound
translation

This illustration depicts the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound L» pp_»
Gentran:Server
Outbound -&——— -
EDI Application

!

Import Translation Object

When you create an import map, you need to define to Gentran:Server your application
file format (your data that you send to your partners) and the EDI standard format in
which your partners expect to receive the documents.

When you create an export map, you need to define to Gentran:Server the EDI standard
format in which your partners sends documents to you and your application file format
(how the data needs to be formatted for your application to process it).
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Application File Format

Introduction If you are creating an import or export map, you must define your application to the
Gentran:Server Application Integration subsystem. In Gentran:Server terminology, your
application file is also referred to as a fixed-format file or a positional file. Your
application file must contain all the information that you either need to extract from your
partner’s document (if the map is inbound) or need to send to your partner (if the map is
outbound), so that your system can accurately process the data.

Map components This table lists the icons that visually represent the map components you use to define
your application file.

Icon Description

Gl A group is a looping structure that contains related records and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted.

If you create a group that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (a loop
within a loop).

0 A record contains a group of related fields. A record can occur once
or can repeat multiple times.

3 A field is the smallest piece of information defined in the application
file. A field is the application map component that is mapped (linked)
to a corresponding EDI element to move data to and from your
application file.

When a field has a mapping operation performed against it, a red
checkmark is displayed over the field icon.

Before you begin  Before you define your application, you should obtain a layout of the necessary records,
fields, and groups. Each map component is arranged sequentially in the order that it is
most logical for the system to process. Therefore, each level of your application must be
created sequentially.

Example

Your application file contains records and groups. The records contain fields and the
groups contain records and/or subgroups. This means that you must create records and
groups before you create the subordinate fields.

Reference
See Using a Fixed-Format File on page 2 - 51 for more information about defining your
application file format.

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
{ g pp g



Application Integration Basics EDI File Format

EDI File Format

Introduction

Before you begin

Map components

The EDI file must contain all the information that you expect to receive from your partner
(if the map is inbound) or need to send to your partner (if the map is outbound), so that
your system can accurately process the data.

For non-CII standards, the Gentran:Server Application Integration subsystem generates an
EDI file for you, based on the standard (agency), version, transaction set, and release (for
the TRADACOMS standard only) you selected. The system includes all the groups,
segments, composites, and elements that are defined by the standards agency for the
version of the document you selected. Please see How to Create a New Map on

page 2 - 20 for more information about generating an EDI file when you create a new
map.

If you are creating an import or export map, you typically need to customize the system-
generated EDI file by modifying the properties of the map components, and using
specialized Gentran:Server functions to manipulate the EDI file structure.

However, if you want to use a specialized version of an EDI standard that is not available
in the Gentran:Server standards database (including the CII standard), you must define the
EDI file yourself.

Regardless of whether the system generates the EDI file or you define it, the specific EDI
map components that you use depend on the type of map you are creating. This includes
the standard, version, and transaction set (document) selected, and which groups,
segments, TFDs (for the CII standard), composites, and elements your company requires.

We recommend that you determine which map components you are using before
generating or defining an EDI file.

This table lists the map components that Gentran:Server uses to visually represent the EDI
file format.

Icon Description

= A group is a looping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted.

Groups are defined by the EDI standards. A group that is subordinate
to another group is a subgroup (this corresponds to a nested looping
structure — a loop within a loop).
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(Contd)
Icon Description

O A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times.

T:] A TFD (Transfer Form Data) is used only in the CII standard. A TFD
consists of a data tag (data identifier), data element length, and the
variable-length data element TFD.

& A composite is a data element that contains two or more component

data elements or subelements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

A repeating composite is a related group of EDI subelements that
have the ability to loop as a whole (occur more than once) within a
particular EDI segment. To allow a composite to repeat multiple times
within a segment, each occurrence of the composite must be separated
by a special delimiter, known as the repeating element delimiter.

Example

Your delimiters are set as follows:
Segment ~

Element *

Tag *

Sub Element

Repeating Ele *

Then, if a BGM segment contains a repeating composite that occurs 3
times within the data followed by 1 regular element, and the composite
contains 2 subelements, the segment is in the following form:

BGM*SubA-1:SubB-1"SubA-2:SubB-2"SubA-3:SubB-
3*Field2~
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Icon

Description

An element is the smallest piece of information defined by the EDI
standards. An individual element can have different meanings
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments.

An element is the EDI map component that is mapped (linked) to a
corresponding application field to move data to and from the EDI file.

A repeating element is an EDI elements with the ability to loop (occur
more than once) within a particular EDI segment. To allow a single
element to repeat multiple times within a segment, each element must
be separated by a special delimiter, known as the repeating element
delimiter. The use of this delimiter prevents the system from mistaking
the repeating elements for normal elements.

Example
Your delimiters are set as follows:

Segment ~
Element *
Tag *

Sub Element
Repeating Ele
Then, if a BGM segment contains 3 elements and the second element is

arepeating element that occurs 4 times, the segment is in the following
form:

BGM*Fieldl*Field2.1"Field2.2"Field2.3"Field2.4*Field
3~

Reference

See Using an EDI File on page 2 - 68 and Using a CII File on page 2 - 89 for more
information about customizing the properties of the map components and using
specialized Gentran:Server functions to manipulate the EDI file structure.

Application Integration User’s Guide
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Introducing the Application Integration Subsystem

Overview

Introduction The Gentran:Server Application Integration subsystem enables you to translate your
application files to EDI standard formats for documents you send to your partners
(outbound mapping), and to translate EDI standard formats to your application format for
documents that you receive from your partners (inbound mapping).
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How to Navigate in Application Integration

How to Navigate in Application Integration

Introduction The Gentran:Server Application Integration Window allows you to access its functionality
in four different ways:

Click the menu option from the Main Menu Bar.

Click the appropriate button on the Main Toolbar.

Click the appropriate part of the map.

Click a map component with the right mouse button to access a shortcut menu that
contains all the functions that are currently available for that map component. The
shortcut menus enable you to quickly and easily access available functionality. The
content of the shortcut menus varies, depending on the type and level of the selected

)
>
)
)
map component.
Note

When you start Gentran:Server Application Integration, the Main Menu Bar contains a
subset of menu items. The full set of menu items is displayed after you create a new map
or open (load) an existing map.

Application This table lists the parts of the Gentran:Server - Application Integration Window.

Integration

Window

Part

Function

Main menu bar

Contains drop-down menus. Unavailable items are dimmed.

Reference
Detailed descriptions of each of the commands on these menus are
found in the online Help.

Main Toolbar

Enables you to access some of the most common functions in the
Application Integration subsystem. Unavailable items are dimmed.

Note
The Main Toolbar is a dockable toolbar, so you can affix it to any
edge of the client window.

Status bar

Displays status information about a selection, command, or process,
defines menu items as you highlight each item in the menu, and
indicates any current keyboard-initiated modes for typing.

Application Integration User’s

Guide
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How to Build a Map with Application Integration

Map Building This table defines how to proceed with building a map using the Gentran:Server
Process Application Integration subsystem.

Stage

Description

1

Prepare and analyze

» Obtain a layout of your application file and determine how it
corresponds with the EDI standard you are using.

» Determine how you move data to or from each application field.

Set global defaults (one time only)

The first time you use the Gentran:Server Application Integration
subsystem, you should establish the default date format that the system
uses.

Reference
See How to Set the Default Date Format on page 2 - 18 for more
information.

Create a new map

Reference
See How to Create a New Map on page 2 - 20 for more information.

Activate the appropriate EDI groups, segments, and elements or auto
trim based on a sample EDI file

or

Define your CII EDI file

References

» See How to Activate EDI Map Components on page 2 - 37 for more
information.

» See How to Use Auto Trim on page 2 - 39 for more information.

» See Using a CII File on page 2 - 89 for more information.

Define your application

Reference
See Using a Fixed-Format File on page 2 - 51 for more information.
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(Contd)
Stage

Description

6

Map the appropriate data for each application field

References

» See How to Create Simple Links on page 2 - 114 for more
information.

» See Using Standard Rules, chapter 3, for more information.

» See Using Extended Rules, chapter 6, for more information.

Compile the translation object

Reference

See How to Compile a Map on page 2 - 120 for more information about
compiling the translation object and translation object naming
conventions.

Print the mapping report

Validate and review the map, and make modifications as needed.

Reference
See How to Print a Mapping Report on page 2 - 124 for more
information.

Register the translation object with Gentran:Server

Reference
See How to Register a New Translation Object in the Gentran:Server
User s Guide for more information.

10

Create the appropriate trading relationship

Establish the appropriate trading relationship in Gentran:Server for your
trading partners.

Reference
See Using Partners in the Gentran:Server User s Guide for more
information about creating trading relationships.

11

Testing the translation object

Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.

Application Integration User’s Guide
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Designing your Map Introduction

Overview

Introduction

What’s in this This chapter explains some of the basic mapping functions. Some of the mapping
chapter functions are performed initially (creating a map), some are performed as you define the
map, and some are performed after the map is completed (compiling and printing a
mapping report).
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Preparation and Analysis

Introduction

Analyzing your
application file
format

Analyzing the EDI
file

The first step in creating a map is the analysis of the mapping requirements. This is the
most important step in creating a successful map. If the analysis you perform is complete,
you have all the information you need to create the map in an efficient and logical manner.
If you omit this critical step and proceed directly to creating the map, it is likely that
creating the map is a much longer and arduous task, and the map may be invalid due to
oversights and omissions.

Regardless of whether you are translating data inbound or outbound, this table lists the
stages of mapping analysis.

Stage Description
1 Analyzing your application file format
2 Analyzing your partners EDI file format
3 Correlating your application and the EDI file formats

After you complete these steps, you can begin creating the map.

The first step of mapping analysis is analyzing your application file format, because this is
probably the component that is the most familiar to you. Your application file format
contains all the information that you need to extract from the purchase order your partner
sends you, so that your system can correctly process the purchase order, and your
company can fill the order correctly.

You must define your application file format to Gentran:Server. If your company has an
existing application file format, you should obtain the record layout from the appropriate
person. If you did not have an existing application file format, you need to create one by
determining which fields are necessary to process the data correctly, and then grouping the
fields logically under records.

To analyze the EDI file, you must first determine what your trading partners are sending
you. You and your partners need to agree on which standard, version, and transaction set
you are using. It is important to know the information that your partners are sending you
within the purchase order, and what data is contained in each element used.

It is very helpful to review the EDI standards that you are using before analyzing the EDI
file. Obtain an EDI standards manual for each standard and version that you are using.
Standards manuals are available from EDI standard agencies.

After discussing with your partners what they are sending, determining which segments
and elements your company requires, and reviewing the EDI standard, you can list the
map components that you need to make available for use (activate).
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Reconciling your
application file and
the EDI file

After your analysis
is complete

Preparation and Analysis

To reconcile your application file format with the EDI file, you must identify each
application file with its corresponding element in the EDI file and select a method for
mapping it. To map information to a field, you use linking, standard rules, extended rules,
or a combination of all three.

Linking

Linking (simple mapping) enables you to map a field or element from the input side of the
map to a field or element on the output side of the map. The link between two map
components (fields) is visually represented with a line connecting the two fields.

Standard rules
Standard rules give you access to mapping operation functions that are more complex than
simple linking, but less involved than extended rules.

Extended rules
Extended rules enable you to use a Gentran:Server proprietary programming language to
perform virtually any mapping operation you require.

Additionally, you may determine that you need to establish temporary storage (work)
areas for the map to handle items such as Ship To and Bill To name and address
information, which is extracted using extended rules from a group in the EDI data.

Recommendation
Determine which mapping operations are required on a field-by-field basis for your
application file.

After you finish correlating your application file format and EDI file on paper, you can
begin creating the map.
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Setting Global Defaults

Customizing Your Display

Introduction The Gentran:Server Application Integration subsystem allows you to customize the
display of maps in several different ways:

Customizing global display options
Customizing colours (global option)
Customizing fonts (global option)
Displaying links (global option)
Customizing the auto-increment map version

Making the two sides of a map equal

The Preferences dialog box enables you to set global defaults for Gentran:Server. The map
display options can be set or changed at any time.

6
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How to Customize Global Display Options

How to Customize Global Display Options

Procedure  Use this procedure to customize global (for all maps) display options.

Step

Action

1

From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Preferences

Tree |Links I Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl Versionl

These seftings customize the look of the file format tree.

W Show group descriptions Colours... |
¥ Show record descriptions Font... |

¥ Show field descriptions

Cancel Help

Application Integration User’s Guide
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(Contd)
Step Action
2 Do you want to turn on the default display of group, record (segment),
and field (element) descriptions?
» Ifyes, click the check box in front of each in the List section of the
dialog box (so the system displays a checkmark in the check box).
To turn off the default display of group, record (segment), and field
(element) descriptions, click the appropriate check box again to
remove the checkmark.
» If no, continue with the next step.
Notes
Typically, you want to have all the descriptions displayed for reference.
However, for a variety of reasons, you may not want the descriptions
displayed. Depending on the size of your monitor, it may be easier to
view the entire map if the descriptions are not displayed.
You may want to experiment with shrinking the size of the font for the
map. See How to Customize Global Fonts on page 2 - 11 before you
turn off the display of descriptions.
3 Do you want to change the default display colors?
» Ifyes, see How to Customize Global Colours on page 2 - 9 for more
information.
» Ifno, continue with the next step.
4 Do you want to change the default display font?
» Ifyes, see How to Customize Global Fonts on page 2 - 11 for more
information.
» If no, continue with the next step.
5 Click OK to save changes and exit the Preferences dialog box.
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How to Customize Global Colours

Introduction  The Colours feature enables you to select foreground and background colours to visually
define the various map components. The use of colour is optional.

Procedure  Use this procedure to customize colours for all maps.

Step Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Preferences

Tres |Links I Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl Versionl

These settings customize the look of the file format tree.

W Show group descriptions Colours... |
¥ Show record descriptions Font... |

¥ Show field descriptions

Cancel Help
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(Contd)
Step

Action

2

Click Colours.

System response
The system displays the Colours dialog box.

It
i 1 ¥[u]
cord/ S egmer

[
Re

Aftributes

Active, Conditional
Active, Mandataony
Inactive, Conditional
Inactive, Mandatany

- Sample Text -

Fareqround calaur

Backimund colour

Carmposgite :I Cancel |

From the Item list, select the type of map component (Group, Record/

Segment, Composite, Field/Element).

Further define the type of map component by selecting whether it is
active or inactive and conditional or mandatory from the Attributes list.

The valid selections are:
» Active, Conditional
» Active, Mandatory
» Inactive, Conditional

» Inactive, Mandatory

Select the foreground and background colors.

Click OK to globally define the selected colours for all maps.
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How to Customize Global Fonts

Introduction The Font feature enables you to globally change the font that is used in the display of all
maps. The default font that Gentran:Server uses is MS Sans Serif 9 point.

The Font feature enables you to change the font type, style, and point size. This gives you

the flexibility to shrink the font if you need to view more of the map on your monitor,
enlarge the font, or change the type and style to be more easily readable by you.

Procedure  Use this procedure to customize the display font for all maps.

Step Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Preferences

Tree |Links I Standard Folmatsl PositionalDefauItsI Files I Confirmationsl Versionl

These zettings customize the look of the file format tree.

¥ Show record descriptions Fant...

¥ Shaw group descriptions Calours. .. |

V¥ Show field descriptions

Cancel Help
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Step

Action

2

Click Font.

System response
The system displays the Font dialog box.

Font HE

Fant style: Size:

IFieguIar 9 0K
Fcgia B -
Italic 10 Lt |
Biold 12

Bold [talic 14

Hy o

Small Fonts
B Syribol
Syztem

B

— Sample

| AaBbYylz

Script:

IWestern LI

From the Font box, select the type of font.

Note
The default is MS Sans Serif.

From the Font Style box, select the style.

Note
The default is Regular.

From the Size box, select the point size.

Note
The default is 9.

Click OK to make the global font change to all maps and exit the Font
dialog box.
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How to Customize Global Display of Links

Introduction Mapping Links are the visual lines that connect each field/element/TFD on the Input side
of the map that is mapped to a field/element/TFD on the Output side of the map.

Procedure  Use this procedure to customize the global display of mapping links.

Step Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

2 Select the Links tab.

System response
The system displays the linking options.

Preferences

Tree  Links |Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl

These seftings control how links are shown between the input and output file farmats.

& Show no links
= Show links tooor from the curently selected element.

= Sheow links to or from all wisible elements

Cancel Help
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(Contd)
Step Action
3 Select the linking option that you want to set as the default for all maps.
» Show no links
Do not visually display mapping links.
» Show links to or from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).
» Show links to or from all visible elements
Display all the mapping links.
4 Click the OK button to save changes and exit the Preferences dialog
box.
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How to Customize the Auto-increment Map Version

Introduction Gentran:Server supports automatically incrementing the version number of a map based
on a global option you can set. Previously, the version number of a map could only be set
or incremented manually, on the Application Integration Translation Object Details dialog
box.

You can set a global option on the Application Integration Preferences dialog box to
specify when map version numbers are incremented. This list describes the available
options for automatically incrementing the map version number.

» Never auto-increment.

» Ask whether to increment when saving a map.

»  Ask whether to auto-increment when compiling a map.

» Always auto-increment when saving a map.

» Always auto-increment when compiling a map.

Note

The auto-increment function updates the minor version number of the map on the
Translation Object Details dialog box, up to 255. If the minor version number exceeds

255, the system updates the minor version number to zero and increases the major version
number.

Example
Version number 1.255 will be auto-incremented to 2.0.

Setting auto-  Use this procedure to set the auto-increment map version function.
increment
Step Action
1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).
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(Contd)
Step

Action

2

Select the Version tab.

System response
The system displays the auto-increment version options.

Preferences

Select the appropriate option and click OK.

System response
The system sets the global auto-increment option you selected.

|

Gentran:Server for Windows — August 2008 Application Integration User’s Guide



Designing your Map How to Make the Two Sides of a Map Equal

How to Make the Two Sides of a Map Equal

Introduction When you open a map, the Input and Output sides of a map are displayed in equal
dimensions. After manipulating a map and moving the center bar that divides the display
of the Input and Output sides, you may wish to again make the two sides equal.

The Equalize function enables you to reinstate the two sides of the map with focus in
equal dimensions. The use of the Equalize function is optional.

Procedure  Use this procedure to make the two sides of a map equal.

Step Action

1 From the View menu, select Equalize.

Note
This moves the center dividing bar between the two sides of the map
with focus, so that the two sides of the map are equally proportioned.
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How to Set the Default Date Format

Introduction You typically establish the default date format for all date fields one time only. This default
is used when EDI documents are initially loaded from the standard. This default can be
overridden on the Field Properties dialog box.

This global option changes the default date format for all maps. However, the format of
the existing date fields do not change; the default is only used for new maps.

Procedure  Use this procedure to establish the default date format.

Step Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

2 Select the Standard Formats tab.
System response
The system displays the date format options.

FPreferences

Tree I Links ~ Standard Formats | PositionaIDefauItsl Files I Eonfirmationsl

These settings contral the default data formats used when elements are read from the
shandards database.

Siw-character dates IWM MDD 7 I
Eight character dates IMM;’DDNY 'I

Cancel | Help |

3 From the Six-character dates and Eight character dates lists, select the
appropriate six-character and eight-character default date formats.
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(Contd)
Step

Action

4

Click OK to accept the default date formats for the six- and eight-
character date boxes and exit the Preferences dialog box.

Tip

To change the order in which the date formats appear in the Six-
character dates and Eight character dates lists or to add a new date
format to the lists, select Date Formats from the Options menu.
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Creating a Map and Defining Details

How to Create a New Map

Introduction You can create four different types of maps: System Import (containing the header
information for an Import map), Import (for Outbound Maps), Export (for Inbound Maps),
or Turnaround (for EDI to EDI maps). The initial procedures for creating a new map of
each of the four types is the same.

Procedure  Use this procedure to create a new map.

Step Action

1 From the File menu, select New.

System response
The system displays the New Map Wizard.

2 Answer the following questions and then click Next.

»  What kind of map are you creating?
The following table defines the selections:

Part Function

Import Used for outbound maps.

Export Used for inbound maps.

Interchange break Used in advanced mapping to separate
interchanges.

Functional Used in advanced mapping to reconcile

Acknowledgement functional acknowledgements.

Inbound

Functional Used in advanced mapping to generate

Acknowledgement functional acknowledgements.

Outbound

System Import Header | Used to determine which trading relationship
(established in Partner Editor) corresponds to
each document in the application file, so the
system knows which import translation object to
use to process the document.
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(Contd)
Step Action
2 Turnaround Used for EDI to EDI maps.
(contd)
Transaction build Used in advanced mapping to build transaction

envelopes.

Transaction break

Used in advanced mapping to separate
documents.

Functional group
build

Used in advanced mapping to build functional
group envelopes.

Functional group
break

Used in advanced mapping to separate functional
groups.

Interchange build Used in advanced mapping to build interchange
envelopes.
Direct Map Warning

This map function is not used by any
Gentran:Server for Windows component or by
any Sterling Commerce product that may
connect to Gentran:Server for Windows. This
function will be removed in a future release.

Recommendation

Any existing maps that are configured with the
Direct Map type should be switched to another
appropriate type.

» What is the name of the map?
Type the unique name of the map. The system adds the MAP

extension.

» Whatis your name?

Type your name if it differs from the user name prompted by the

system.

System response

The system displays the New Map Wizard - Input Format dialog box.

Note

You need to complete the format of the Input side of the map. This is the
format of the data that is translated by the Gentran:Server system.
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(Contd)
Step Action
3 For the input side of the map: do you want to create a new data format
using a syntax that you define?

» Ifyes, select one of the following input format options and continue
with step 4:

Delimited EDI (Electronic Data Interchange file)

Positional (VDA, GENCOD, application files, etc.)

CII (Japanese standard)

CII Positional (for CII Build/Break maps)

Note

For Inbound maps (Export), the Input Format Type is “CII”” or “EDI”.
For Outbound maps (System Import or Import), the Input Format
Type is “Positional.”

For Turnaround maps, the Input Format Type is “EDI” or “CII.”

» Ifno (you want to load the data format from a saved definition), select
the Load the data format from a saved definition option, and type the
path and file name of the saved definition (or click Browse to display
the Open File Definition dialog box). Continue with step 6.

4 Did you select “Delimited EDI” or “CII” and want to customize the

format?
» Ifyes, click Customize and continue with the next step.

System response
The system displays the New Delimited EDI Wizard or New CII
Wizard dialog box.

Note
The Delimited EDI and CII wizards enable you to create your format
from the standards database.

» Ifno, click Next and continue with step 7.

System response
The system displays the New Map Wizard - Output Format dialog box.
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(Contd)
Step

Action

5

Follow the steps for the appropriate dialog box and then continue with

step 7.
IF the dialog box
displayed is... THEN follow this procedure...
New Delimited EDI a. Click Next.
Wizard
b. Select the ODBC data source that contains
the standards database.
c. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.
d. Click Finish.
New CII Wizard a. Click Next.

b. Select the ODBC data source that contains
the standards database.

c. If you want to use Japanese descriptions,
select the check box (the default is English
descriptions).

d. Click Next.

e. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

f.  Select the appropriate Multi-detail header
and click Next.

g. Click Finish.

System response

The system displays the New Map Wizard - Output Format dialog box.
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Step

Action

6

Did you choose to load the data format from a saved definition and click
Browse to display the Open File Definition dialog box?

» Ifyes, type the file name and click Open to load the selected file
format definition, and then continue with step 7.

Note
You can now select either a .DDF or .IFD file.

» Ifno, continue with step 7.

Note
If the DDF is invalid, the system displays a message box explaining
the problem and terminates the import.

For the output side of the map: do you want to create a new data format
using a syntax that you define?

D Ifyes, select one of the following output format options and continue
with step 8:
Delimited EDI (Electronic Data Interchange file)
Positional (VDA, GENCOD, application files, etc.)
CII (Japanese standard)
CII Positional (for CII Build/Break maps)

Note
For Inbound maps (Export), the Output Format Type is “Positional.”
For Outbound maps (System Import or Import), the Output Format
Type is “CII” or “EDL.”
For Turnaround maps, the Output Format Type is “EDI” or “CIL.”

» Ifno (you want to load the data format from a saved definition), select
the Load the data format from a saved definition option and type the
path and file name of the saved definition (or click Browse to display
the Open File Definition dialog box). Continue with step 9.

6
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(Contd)
Step

Action

8

Did you select “Delimited EDI” or “CII” and want to customize the
format?

» Ifyes, click Customize and continue with the next step.

System response
The system displays the New Delimited EDI Wizard or New CII
Wizard dialog box.

Note
The Delimited EDI and CII wizards enable you to create your format
from the standards database.

» Ifno, click Finish to load the standards information you selected and
create the new map (this may take a few seconds).

System response
The system displays the new map in the Application Integration Window.

Follow the steps for the appropriate dialog box and then continue with
step 11.

IF the dialog box
displayed is... THEN follow this procedure...

New Delimited EDI a. Click Next.

Wizard
b. Select the ODBC data source that contains

the standards database.

c. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

d. Click Finish.
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Step

Action

9
(contd)

New CII Wizard a. Click Next.

b. Select the ODBC data source that contains
the standards database.

c. Ifyou want to use Japanese descriptions,
select the check box (the default is English
descriptions).

d. Click Next.

e. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

f.  Select the appropriate Multi-detail header
and click Next.

g. Click Finish.

System response
The system displays the New Map Wizard dialog box.

10

Did you choose to load the data format from a saved definition and click
Browse to display the Open File Definition dialog box?

» Ifyes, type the file name and click Open to load the selected file
format definition, and then continue with step 11.

Note
You can now select either a .DDF or .IFD file.

» If no, continue with step 11.

11

Click Finish to load the standards information you selected and create the
new map (this may take a few seconds).

System response
The system displays the new map in the Application Integration Window.

Note

After you finish creating and saving a new map, you need to define the
Input and Output sides of the map. The steps you take are different,
depending on whether the map is an Import, System Import, Export, or
Turnaround map.

6
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How to Define Translation Object Details

Introduction

Rule execution
prior to version 3.0

The Translation Object Details dialog box enables you to edit the details of the translation
object, including the description and version information. This dialog box enables you to
instruct the translator to use the pad character and alignment settings of each string field
when reading a positional or CII positional file, to determine how to trim pad characters
from the string data.

The Translation Object Details dialog box also enables you to specify whether you want
the translator to execute standard and extended rules as it did for Gentran:Server prior to
version 3.0. The standard behavior for Gentran:Server prior to version 3.0 is as follows: if
an output record/segment is linked to an input field in a record/segment that does not
contain data but is at the same hierarchical level as an input record/segment that does
contain data, the standard and extended rules on the output field will be executed even
though there is no data present.

Example

In the example diagram below, the extended rule on the DEMOS field on the output side
of the map is executed even though there is no data for the field to which it is linked
(DEMO1:2 on the input side of the map). The rule is executed because there is data
present for a field in the DEMO1 record on the input side of the map, and that record is at
the same level as DEMO2.

#*Gentran Application Integration - [RuleDemo3.map]

ﬁ' File Edit Functions “iew Optiohs Window Help _|5|£|
E Lo e s o e e e e e e Y
IMPUT -4 - 1 - OUTPUT - M - 1 -

DEMOT -C- 1 DEMO3-C- 1
DEMOZ-C- 1 DEMO4-C- 1
¥ (01 DEMOT:2-C - String 10— 01 DEMOS - C - String 10 #®
¥ 02 DEMOZ2-C - String 10— 02 DEMOE - C - String 10

| | v 1 |iv

For Help, press F1 LIk v

Note

For any map that was compiled with Gentran:Server prior to version 3.0, the system
emulates the previous behavior by automatically selecting the “Gentran:Server for
Windows 2.x Compatible Rule Execution” check box on the Translation Object Details
dialog box on page 2 - 29. You can modify this default if you wish, but you would then
need to re-map any instances where you want standard or extended rules to run on an
output record/segment that does not contain fields that will be populated with data.
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Rule execution in In version 3.0, the standard rule execution behavior is as follows: standard and extended
version 3.0 and rules for a record/segment on the output side of the map are only executed if any of its
above links populate the output map component with data.

Note

For any map created with Gentran:Server version 3.x or greater, the system default is to
clear the “Gentran:Server for Windows 2.x Compatible Rule Execution” check box on the
Translation Object Details dialog box.

Example

In the example diagram below, the extended rule on the DEMOS field on the output side
of the map is not executed because there is no data for the field to which it is linked
(DEMO1:2 on the input side of the map). The rule is not executed even though there is
data present for a field in the DEMO1 record on the input side of the map, and that record
is at the same level as DEMO2.

#*Gentran Application Integration - [RuleDemo3.map]

ﬁ' File Edit Functions “iew Optiohs Window Help _|5|£|
E Lo e s o e e e e e e Y
IMPUT - M - 1 - OUTPUT -M - 1 -

DEMOT-C- 1 DEMOZ-C- 1
DEMOZ-C- 1 DEMO4-C- 1
¥ 01 DEMOT:2 - C - Shring 10— 1 DEMOS - C - Sting 10 ¥®
¥ 02 DEMOZ2 - C - Shivg 10— 2 DEMOE - C - Stiing 10

| | v 1 |iv

For Help, press F1 LIk v

Recommendation

We recommend that you do not select this check box for version 3.x and greater, as this
differs from the prescribed behavior.
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Translation Object  This diagram illustrates the Translation Object Details dialog box.

Translation Object Details E3

Details dialog box

— Summarny
Author Degcription

Tranzlation Qbject Function

|5terling [FET % 3030 850 Export | |Export =l Carcel |

— Flags

[~ Swstem [ Use Configurable Trimming

r Gentran:Server for Windows 2.1
Compatible Rule Execution

—Werzion Contral

hd ajor version I'I tinor version IIJ Compiled on |D2-Mar-2DDD

— EDI Azzociations

InpLit Output

Agency F |><1 2

=

“Wersion |003030

IANSIX12VEHSIDN

Tranzaction IBEU

Release ID_

|F'UF|EHASE ORDE

F Group IF'D

2ARE

Parts and The following table lists the parts of the Translation Object Details dialog box and their

functions functions.

Part

Function

Author

Identifies the person or department that created the map.

Note
This box is mandatory.

Description

Contains a unique description of the map.

Note

This box is mandatory. This description is used by the system
to identify the map. We strongly recommend that you use the
following identifying characteristics of the map: the partner
that this map is used for, the standard, the version, the type of
transaction this map uses, and the direction of the map (i.e.,
Import, Export, etc.).

Example

“MWT X 3030 850 Export” is the description of a map used
with partner MWT, for an ANSI X.12 version 003030
Purchase Order (850), that is sent Inbound (Export).
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Part

Function

Function

Translation Object

Verify the type of map from the list. Valid values are:

» Import - choose this type for outbound maps (application
to EDI)

»  Export - choose this type for inbound maps (EDI to
application)

» Turnaround - choose this type for EDI to EDI maps

» Transaction build (this type used in advanced mapping to
build transaction envelopes)

» Transaction break (this type used in advanced mapping to
separate documents)

» Functional group build (this type used in advanced
mapping to build functional group envelopes)

» Functional group break (this type used in advanced
mapping to separate functional groups)

» Interchange build (this type used in advanced mapping to
build interchange envelopes)

» Interchange break (this type used in advanced mapping to
separate interchanges)

» F/A Inbound (this type used in advanced mapping to
reconcile functional acknowledgements)

» F/A Outbound (this type used in advanced mapping to
generate functional acknowledgements)

Note
This box is mandatory.

System

Designates this map as a system translation object (one that
will be used internally by the system).

Warning

You should only select this check box if you are certain that
you want to define this translation object as a system
translation object. Once a system translation object is
registered with Gentran:Server, it cannot be deleted.

() Gentran:Server for Windows — August 2008
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Part

Function

Use Configurable
Trimming

Instructs the translator to use the pad character and alignment
settings of each string field when reading a positional or CII
positional file, to determine how to trim pad characters from
the string data.

Example

If the alignment setting indicates that the data is aligned in the
left of the field, then pad characters are trimmed from the
right of the field. If the alignment setting indicates that the
data is aligned at the right of the field, then pad characters are
trimmed from the left of the field. Finally, if the alignment
setting indicates that the field data is aligned in the center of
the field, then pad characters are trimmed from both the left
and right of the field.

If this option is cleared (which is the default) pad characters
are always trimmed from both the left and right of each
positional string field, which is the current system behavior.

Example
Use configurable trimming to preserve either trailing or
leading spaces in your application data.

Gentran:Server for
Windows 2.x
Compatible Rule
Execution

Enables you to specify how the translator executes standard
and extended rules on the output side of a map.

Reference

See Rule execution prior to version 3.0 on page 2 - 27 and
Rule execution in version 3.0 and above on page 2 - 28 for
more information.

Major version/
Minor version

Enables you to designate different versions of a translation
object.

Note

The valid values for each box is “0” - “255”. These two boxes
are available for your use only. They are not used by the
system.

Example
If you type “5” in the Major box and “45” in the Minor box,
the Translation Object Version Number is “5.45”.

Compiled on

Displays the date when the translation object was compiled.

Note
It will be blank if the translation object has not been compiled
yet.
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Part Function

section

EDI Associations If you selected “Delimited EDI” for the input and/or output

sides of the map, this section contains the EDI information.

Warning

You should change these boxes only if you want to change the
EDI agency, version, transaction, release, or functional group
of an existing map. This enables you to copy and alter an
existing map.

OK

Saves changes and exits the dialog box.

Cancel

Exits the dialog box without saving changes.

Procedure  Use this procedure to specify translation object details.

Step

Action

1

From the Edit menu, select Details.

System response
The system displays the Translation Object Details dialog box on
page 2 - 29.

Do you want to change the map description?

» Ifyes, type the new description in the Description box and continue
with the next step.

» Ifno, continue with the next step.

Do you want to change the compatible rule execution specification?

» Ifyes, use the following table to determine your action and continue
with the next step.

Reference

See Rule execution prior to version 3.0 on page 2 - 27 and Rule
execution in version 3.0 and above on page 2 - 28 for more
information.

IF you want the system | THEN the Gentran:Server for Windows 2.x
to execute rules based | Compatible Rule Execution check box

on this behavior... should be...
prior to version 3.0, selected.
version 3.0 and above, cleared.

» Ifno, continue with the next step.

6
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(Contd)
Step

Action

4

Do you want to change the map version?

» Ifyes, type the appropriate version numbers in the Major and Minor
boxes and continue with the next step.

» Ifno, continue with the next step.

Click OK.

System response
The system saves your changes and exits the Translation Object Details
dialog box.
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How to Load a File Definition

Introduction Gentran:Server enables you to load an individual file format definition that you previously
saved. This feature provides you with a quick way to build either side of your map.

Reference

See How to Save a File Definition on page 2 - 36 for more information.

Note

Loading a file definition replaces the selected side of the map. Please be certain that is
your intent before performing this task.

Procedure  Use this procedure to load a file format definition.

Step

Action

1

Right-click the File Format icon (either the INPUT or OUTPUT side of
the map) and select Open File Definition from the shortcut menu.

Note

If you already used Gentran:Server to create that side of the map, you are
prompted with a message that warns you that the existing file format will
be replaced. Click Yes to continue.

System response
The system displays the Open File Definition dialog box.

Open File Definition
Laak in: I 3 Bin
Ea321_ard.ifd

File name:  [E921_ard.ifd

Files of tupe: IFiIe Drefimitions [*.1FD) j Cancel |

Does the Look in list reflect the drive\folder where Gentran:Server is
installed (the default is GENSRVNT)?

» Ifyes, continue with step 3.

» If no, select the appropriate folder and continue with step 3.

From the Files of type list, select the type of file that you want to display.

6
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Step

Action

4

From the list, select the file definition that you want to load into the
system or type the file name in the Filename box.

Click Open.

System response
The system loads the selected file format definition.
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How to Save a File Definition

Introduction Gentran:Server enables you to save an individual file format definition so that you can use
it as a guide in future maps. This provides you with a quick way to build either side of
your map.

Reference
See How to Load a File Definition on page 2 - 34 for more information.

Procedure  Use this procedure to save an individual file format definition.

Step Action

1 Right-click the File Format icon (either the INPUT or OUTPUT side of
the map) and select Save File Definition from the shortcut menu.

System response
The system displays the Save File Definition dialog box.

Save File Definition

Save in: Ia Bin

File narme: IEEI2‘I_DF|D.IFD

Save as lype: [File Definitions [*IFD) =l Baneal |

2 Does the Save in list reflect the drive\folder where Gentran:Server is
installed (the default is GENSRVNT)?

» Ifyes, continue with step 3.

» If no, select the appropriate folder and continue with step 3.

3 Type the file name in the Filename box (one to eight characters) or from
the list, select the file definition that you want to save.

4 Click Save.

System response
The system saves the file format definition.
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How to Activate EDI Map Components

Introduction

Procedure

When Gentran:Server generates the EDI sides of the map, the system includes all the
groups, segments, composites, and elements that are defined by the standard agency for
the version of the document you selected. The system activates all the groups, segments,
composites, and elements that are defined as “mandatory” (must be present) by the
standard. The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

When translating data, the system does not process groups, segments, composites, and
elements (or records and fields) that are not activated. Therefore, you must activate the
groups, segments, composites, and elements that are not defined as mandatory by the
standard, but that you have determined that you need to use in mapping.

Tip
As an alternative to activation, you can use the Auto Trim feature if you have a sample
EDI file defined.

Reference
See How to Use Auto Trim on page 2 - 39 for more information.

Use this procedure to activate groups, segments, composites, and elements.

Step Action
1 From the Functions menu, select Activate.
2 Open (double-click) each group that contains segments or groups that

need to be activated.

Note

As an alternative to opening each map component (steps 2, 5, and 7), you
can select Expand All from the View menu to open every map
component. You can also select a map component and select Expand
Branch from the View menu to open that map component.

3 Select each inactive group that you need to use. This activates the
groups.

Note

If you accidentally click a group, segment, composite, or element that
you did not mean to activate, right-click the map component and select
Deactivate from the shortcut menu.

4 Select each inactive segment that you need to use.

Note
This activates the segments.
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(Contd)
Step Action

5 Open (double-click) each segment that contains composites or elements
that need to be activated.

6 Select each inactive composite that you need to use.
Note
This activates the composites.

7 Open (double-click) each composite that contains elements that need to
be activated.

8 Select each inactive element that you need to use.
Note
This activates the elements.

9 Once you have activated all the necessary groups, segments, and
elements, select Activate from the Functions menu to turn activation
mode off.
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How to Use Auto Trim

Introduction Instead of activating map components manually, you can use the Auto Trim feature to
modify the EDI side of the map according to a sample EDI file that you select (you must
have previously created this EDI file).

The Auto Trim feature examines the EDI file that you specify and then activates and
deactivates map components on the EDI side of the map, so that the two files match. The
sample EDI file must be the same standard, version, and transaction set (message) as the
map for Auto Trim to match map components.

Caveats To use Auto Trim, you must define the Segment and Element Delimiters. If you do not
supply the Tag Delimiter, the system substitutes the Segment Delimiter. If you want to use
composite elements, you must specify the Sub Element Delimiter. If you want to use
release characters, you must specify the Release Character.

Reference
See How to Verify EDI Delimiters on page 2 - 69 for more information.

Warning
The sample EDI file must be compliant and must not contain envelope segments.

Procedure  Use the following procedure to use Auto Trim:

Step Action

1 » Right-click the EDI File icon on the EDI side of the map and

» select Auto Trim from the shortcut menu.

System response
The system displays the Auto-trim Sample EDI File dialog box.

Laak i Ia Bin j il E

Archive, exe q Dirgen.exe Genmsg.dil @ Mapper.ex
cercindl  FllEdmgrexe Genzec.dl MEEwnt10
a Commpost. exe B Forms.exe @ Gentran.hip Mbfile10.d

Canfig exe FSEvnt10.dl &P Glom hip MEMAPITI

CTT 288 tmp GenCamPL. di Gmapper.gid A MClient. ex
CTT241.tmp GerComlUldl @ Gmapperhip Mercuil e

|« | i

File hane: I".“

Files of type: I.-’-‘n.IIFiles["."] j Caticel |
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Step

Action

2

From the Look in list, select the drive\folder where the EDI file is stored.

Note
The default is GENSRVNT\BIN.

If necessary, select the type of file that you want to display from the Files
of type list.

From the list, select the sample EDI file that you want to load into the
system.

Click Open to begin the auto trim process.

Note

When auto trim is complete, the system displays a message stating
whether or not auto trim was successful. Click OK to acknowledge the
message.

6
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How to Promote Groups and Repeating Segments

Introduction

Procedure

The Promote function extracts one iteration (instance) of a group or repeating segment.
This enables you to map unique data from your application file, and/or enter a specialized
definition. Gentran:Server specifies that only one-to-one (no loops) or many-to-many
(loop) mapping relationships are valid.

Note
The Promote function is only available if a group or repeating segment is selected.

Promote vs. copy vs. split

You can use the Copy and Paste functions (and change the number in the maximum usage
box) to accomplish the same task. However, Promote is a specialized function that
guarantees the integrity of your EDI structure. Depending on the circumstances, you may
use the Split or Copy/Cut and Paste functions instead.

References
» See How to Split Groups and Repeating Segments on page 2 - 44 for more
information.

» See How to Use Copy, Cut, and Paste on page 2 - 48 for more information.

Use this procedure to promote a group or repeating segment.

Step Action

1 Select the group or repeating segment from which you want to extract
one iteration

2 Click Promote on the Main Toolbar.

System response
This extracts one iteration (instance) of the looping structure.
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Designing your Map

Outbound In this example, your application file contains a Ship To record that groups all the shipping
Example information and a Bill To record that groups all the billing information. Your Ship To and
Bill To records both occur only once in the application. The EDI file contains a N1 group
(for ANSI) or a NAD group (for EDIFACT) that repeats 200 times. If the Entity Identifier
Code of the N1/NAD is “BT,” that means the N1/NAD group contains billing information.

If the Entity Identifier Code is “ST,” the N1/NAD group contains shipping information.

Example Procedure
This procedure is an example of how to map unique data to your application file.

Step

Action

1

Activate the N1/NAD loop and the appropriate segments and elements,
if you have not already done so. If you already activated the N1/NAD
group, just highlight it.

Reference
See How to Activate EDI Map Components on page 2 - 37 for more
information.

Click Promote on the Main Toolbar to extract a single instance of the
N1/NAD group.

From the Edit menu, select Properties.

System response
The system displays the Group Properties dialog box (the Name tab is
displayed by default).
Group Properties
Name I Loopingl Loop Extended Rules I

Please enter the name :
|01 00_N1:2

Flease enter a short description :

Cancel | Appli | Help |

In the description box, type a specialized definition to identify this group
as containing billing information.

6
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(Contd)
Step

Action

5

Click OK.

System response
The system saves the change and exits the Group Properties dialog box.

» Right-click the original N1/NAD group (that now repeats 199
times) again and

» from the Edit menu, select Properties.
System response

The system displays the Group Properties dialog box (the Name tab is
displayed by default)

In the description box, type a specialized definition to identify this group
as containing billing information.

Click OK.

System response
The system saves the change and exits the Group Properties dialog box.

» Click the Deactivate button on the Main Toolbar and then

» click the original N1/NAD group (that now repeats 198 times), so
the system does not process it.

10

Now you can link the elements in the single occurrence of the N1/NAD
that contains billing information to the fields in your Bill To application
record.

And, you can link the elements in the single occurrence of the N1/NAD
that contains shipping information to the fields in your Ship To
application record.
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How to Split Groups and Repeating Segments

Introduction The Split function enables you to split (break) a group or repeating segment into two
loops. You typically use this function when you need more than one instance of the same
map component that still occurs multiple times.

Split vs. copy and paste

You can use the Copy and Paste functions (and change the number in the maximum usage
box) to accomplish the same task. However, Split is a specialized function that guarantees
the integrity of your EDI structure.

Note

The Split function is only available if a group or repeating segment is selected.

Procedure Use this procedure to split a group or repeating segment.

Step

Action

1

Highlight the group or repeating segment from which you want to extract
one iteration.

Click Split on the Main Toolbar.

System response
The system displays the Split dialog box.

5 plit <]

First Loop Entries IU

Cancel |

In the First Loop Entries box, type the number that indicates the
sequential number of iterations where you want the group or repeating
segment split.

Example

If the X loop repeats a maximum number of 5 times, and you type “2” in
the First Loop Entries box, the resulting split generates one X loop that
repeats a maximum of 2 times and a second X loop that repeats a
maximum of 3 times.

Note
The number you enter in the First Loop Entries box must be greater than
zero and less than the maximum number of iterations of the loop.

Click OK.

System response
Exits the Split dialog box.
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How to Split Groups and Repeating Segments

Outbound In this example, your application file contains an Allowance record that groups all the
Example allowance information and a Charge record that groups all the charge information. Your
Allowance and Charge records can repeat up to five times in the application file. The EDI
file contains a ALC repeating segment that repeats 10 times. If you split the ALC segment
in two, you can map allowance information directly to your Allowance application record
and map charge information directly to your Charge application record.

Example procedure
This procedure is an example of how to split the ALC segment.

Step

Action

1

Activate the ALC segment and the appropriate elements, if you have not
already done so. If you already activated the ALC segment, just highlight
it.

Reference
See How to Activate EDI Map Components on page 2 - 37 for more
information.

Click Split on the Main Toolbar.

System response
The system displays the Split dialog box.

Split

Cancel |

First Loop Entries ID

In the First Loop Entries box, type “5.”

Note
This is the number of sequential iterations where you want the repeating
segment split.

Click OK.

System response
Exits the Split dialog box.
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(Contd)
Step Action

5 From the Edit menu, select Properties.

System response
The system displays the EDI Segment Properties dialog box (Name tab).

EDI Segment Properties E
Name ITag I Fey FieIdI Speciall Loopingl

Please enter the name :
IALE

Please enter a short description ;
ALLOWwAMCE OR CHARGE

Cancel | Lppl | Help |

6 In the description box, type a specialized definition to identify this
segment as containing allowance information.

7 Click OK.

System response
The system saves the change and exits the EDI Segment Properties
dialog box.

8 Highlight the original ALC segment (that now repeats 5 times).

9 From the Edit menu, select Properties.

System response
The system displays the EDI Segment Properties dialog box (Name tab).

10 In the description box, type a specialized definition to identify this
segment as containing allowance information.

11 Click OK.

System response
The system saves the change and exits the EDI Segment Properties
dialog box.
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How to Split Groups and Repeating Segments

(Contd)
Step

Action

12

Now you can link the elements in the ALC segment that contains
allowance information to the fields in your Allowance application
record.

And, you can link the elements in the ALC segment that contains charge
information to the fields in your Charge application record.
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How to Use Copy, Cut, and Paste

Introduction The Copy, Cut, and Paste functions are typically used to move EDI information in the
map. You may need to use these functions if you are using an EDI standard differently, or
if you need to create nested looping structures.

You can cut or copy a single map component (loop, segment, composite, element, record,
or field) and paste it in another location in the map. Copied map components retain all the
information of the original map component. If the copied map component contains
subordinate map components (like a segment contains subordinate elements), the
subordinate map components are also copied.

You can also cut, copy, and paste a map component from one map to another.

Procedure  Use this procedure to cut, copy, and paste a map component.

Step

Action

1

Select the map component that you want to cut or copy.

2

From the Edit menu, select Copy.

Note
If you are pasting the map component in another map, open that map, if
it is not already open.

Select the map component that you want the cut or copied selection
pasted after.

Note

If you cut or copied an EDI component, you can only paste that
component into the EDI side of a map. Conversely, if you cut or copied a
positional component, you can only paste that component into the
positional side of a map.

Click Paste on the Main Toolbar to paste the contents of the Clipboard.

System response

If the map component that you selected is a group, Gentran:Server
prompts you to specify whether you want the contents of the Clipboard
pasted as a child (subordinate) of the group or pasted at the same level as
the group. Select the appropriate option and click OK.
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Example In this example, you are defining an ANSI X12 Ship Notice/Manifest (856). When the
system generates the 856 document, it contains one HL group. The HL group identifies
dependencies between and the content of hierarchically-related groups of segments.

However, for your EDI file, you need to define additional levels of detail information. The
details that you need to define include shipment, order, and line item information. In order
to modify the structure of your EDI file to accommodate these requirements, you need to
use the Copy and Paste functions to create a nested looping structure for the HL group.

How to Use Copy, Cut, and Paste

Example procedure
This procedure is an example of how to create a nested looping structure.

Step

Action

1

» Highlight the HL group and
» click Copy on the Main Toolbar.

From the Edit menu, select Properties.

System response
The system displays the Group Properties dialog box.
Group Properties

Harne | Loopingl Loop Extended Hulesl

Pleass enter the name :
|u1 00_HL

Flease enter a shart description :

Cancel | Al | Help |

In the second box on the Name tab, type a specialized definition to

identify this group as containing shipment information.

Click OK.

System response
Saves the change and exits the Group Properties dialog box.

Application Integration User’s Guide

Gentran:Server for Windows — August 2008



How to Use Copy, Cut, and Paste Designing your Map

(Contd)
Step Action
5 » Select the map component in the HL that you want the nested HL
group (order information) pasted after and

» click Paste.
System response
The second HL group is added as a nested loop to the original HL loop.

6 From the Edit menu, select Properties.
System response
Displays the Group Properties dialog box for the second HL group.

7 In the second box on the Name tab, type a specialized definition to
identify this group as containing shipment information.

8 Click OK.
System response
Saves the change and exits the Group Properties dialog box.

9 Double-click the second HL group (order information) to open it.

10 » Select the map component in the HL that you want the nested HL

group (item information) pasted after, and

» click Paste.
System response
The third HL group (item information) is added as a nested loop of the
second HL group.

11 From the Edit menu, select Properties.
System response
Displays the Group Properties dialog box for the third HL group.

12 In the second box on the Name tab, type a specialized definition to
identify this group as containing shipment information.

13 Click OK.
System response
Saves the change and exits the Group Properties dialog box.

14 Now you can activate the appropriate groups, segments, and elements in
the new HL nested looping structure.
Reference
See How to Activate EDI Map Components on page 2 - 37 for more
information.
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Overview

Using a Fixed-Format File

Overview

Introduction

Before you begin

Create Sub and
Insert functions

If a side of your map is positional (fixed-format), you must either define your application
to Gentran:Server or load a previously-saved file definition. Your application file must
contain all the information that you need to extract from your partner’s document (if the
map is inbound) or send to your partner (if the map is outbound).

Before you define your application, you should obtain a layout of the necessary records,
fields, and groups. The records contain related fields and the groups contain related
records. For example, your application contains records and groups. The records contain
fields and the groups contain records, subgroups, or both. This means that you must create
records and groups before you create the subordinate fields.

Each map component is arranged sequentially in the order that it is most logical for the

system to process. Therefore, each level of your application must be created sequentially.

You will use two different Gentran:Server functions to create the necessary group and
records—Create Sub and Insert. This table explains when you use each of these functions.

IF you want to create a group THEN right-click the map component above
or record... and select...
at the same level (equal), » Insert from the shortcut menu, and

» select Group or Record from the submenu.

that is subordinate to the selected » Create Sub from the shortcut menu, and

map component, » select Group or Record from the submenu.
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How to Adjust File Format Properties

Changing record  To set the record delimiters:

delimiters
Step Action
1 In Application Integration, open the positional file.
2 Right-click the file format icon and select Properties from the shortcut
menu.

System response
The Positional File Properties dialog box is displayed.

3 In the Record tab, change the Record Delimiters 1 and 2 as needed.

4 Click OK. You must click OK, even if the delimiter fields are empty, to
reset the delimiters.

5 Save the map.

6 Compile the map.

System response
The end-of-line delimiters are changed

Changing decimal If you need to specify that each decimal point in your data is defined and generated as a
points something other than the default period (.), you can do so on the Decimal Point tab.

To change the default decimal point setting:

Step Action
1 In Application Integration, open the positional file.
2 Right-click the file format icon and select Properties from the shortcut
menu.

System response
The Positional File Properties dialog box is displayed.

3 In the Decimal Point tab, select the Define Decimal Point check box.

4 In the Decimal Point Character box, type the value you want Sterling
Integrator to use as a decimal point—for example, a comma (,). This
resets the decimal point default to use what you specified instead of a
period.
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(Contd)
Step Action

5 Click OK. You must click OK, even if the delimiter fields are empty, to
reset the delimiters.

6 Save the map.

7 Compile the map.
System response
The decimal point setting is now correctly set to use your specification.
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How to Create the First Record

Introduction  The first record in your application is generally the header record. The first record is
subordinate to the icon in the application side of the map. This shows how the records (and
groups) are contained within it.

Tip
We recommend that you include a header record in each application file. The header
record is mandatory and repeats only once (not a looping structure).

Procedure  Use this procedure to create the first application record.

Step Action

1 »  Click the Positional File icon to highlight it (OUTPUT for an
inbound map and INPUT for an outbound map).

» From the Edit menu select Create Sub.
» Select Record from the submenu.

System Response
The system displays the Positional Record Properties dialog box.

Poszitional Record Properties

MHame |Tag I Key FieIdI Speciall Loopingl

Please enter the name :

Pleaze enter a short description :

Cancel | Aol | Help
2 In the first box on the Name tab, type the record name.
3 In the second box on the Name tab, type a description of the record.

Note
This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.
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(Contd)
Step

Action

4

Select the Tag tab to access tag information.

5

In the Tag box, type the record identification code <TAG>. The record
tag for each record enables the system to recognize that record and then
determine the mapping requirements.

Example
A record is recognized by the system as:

<TAG>[Field_1][Field 2]

Recommendation

Define the record tag on the Positional Record Properties dialog box,
instead of defining fields with the purpose of explicitly containing the
record tag.

In the Position box, type the starting column position of the tag in the
data record.

Select the Special tab only if you want to specify floating (the record
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options. Otherwise, accept the defaults.

Select the Looping tab only if the record is a looping structure.
Otherwise, accept the defaults and continue with step 11.

Is the record a looping structure?

» Ifyes, on the Looping tab in the Min Usage box, type the minimum
amount of times the record must repeat.

Recommendation
Type “1” to make the header record mandatory.

Note

If the Min Usage box contains a “0” (zero), the record is
“conditional.” If the Min Usage box contains a “1” or greater, the
record is “mandatory.”

» Ifno, continue with step 11.

10

Is the record a looping structure?

» Ifyes, on the Looping tab in the Max Usage box, type the maximum
amount of times it can repeat.

Recommendation

For the header record, we recommend that you accept the default of
“1” so it remains a record that only occurs once (not a looping
structure).

» If no, continue with step 11.

11

Click OK to create the record.
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How to Create Subsequent Records

Introduction  After you create the first record, you can define subsequent records at the same level. You
can also define groups, if your application includes looping structures. You may need to
define a loop if your application requires a group of related records (and/or subgroups)
that repeat in sequence.

Reference
See How to Create a Group on page 2 - 62 for more information.

Procedure  Use this procedure to create additional application records.

Step Action

1 » Highlight the map component which precedes the record you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Record from the submenu.

System Response
The system displays the Positional Record Properties dialog box.

2 In the first box on the Name tab, type the record name.
3 In the second box on the Name tab, type a description of the record.
Note

This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

4 Select the Tag tab to access tag information.

5 In the Tag box, type the record identification code <TAG>. The record
tag for each record enables the system to recognize that record and then
determine the mapping requirements.

Example
A record is recognized by the system as:

<TAG>[Field 1][Field 2]

Recommendation

Define the record tag on the Positional Record Properties dialog box,
instead of defining fields with the purpose of explicitly containing the
record tag.

6 In the Position box, type the starting column position of the tag in the
data record.

6
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(Contd)
Step Action

7 Select the Special tab only if you want to specify floating (the record
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options. Otherwise, accept the defaults.

8 Select the Looping tab only if the record is a looping structure.
Otherwise, accept the defaults and continue with step 11.

9 Is the record a looping structure?

» Ifyes, on the Looping tab in the Min Usage box, type the minimum
amount of times the record must repeat.

Recommendation
Type “1” to make the header record mandatory.

Note

If the Min Usage box contains a “0” (zero), the record is
“conditional.” If the Min Usage box contains a “1” or greater, the
record is “mandatory.”

» If no, continue with step 11.

10 Click OK to create the record.

Note
Use this procedure to create any additional records.
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How to Create a Temporary Record

Introduction

When to use
temporary records
and fields

Where to use
temporary records
and fields

You may need to use temporary records and fields when you cannot use a simple link or if
you need to extract only specific occurrences of a record from your data file. A simple link
allows you to join data from the Input and Output sides of the map in either a one-to-one
relationship (map components that both do not repeat) or a many-to-many relationship
(map components that repeat the same number of times).

Reference
See How to Create Simple Links on page 2 - 114 for more information.

If link a single iteration of a map component on the Input side of a map to a map
component on the Output side that repeats multiple times, it causes an infinite loop when
the map is translated. And, if you link a map component on the Input side that repeats
multiple times to a map component on the Output side that does not repeat, the data from
the Input side never populates the Output side of the map. In either of these instances, you
should use temporary records and fields.

These are other common reasons why you would want to incorporate temporary records
and field into your map:

»  The Input hierarchical level in a map does not match the Output hierarchical level.

» You only want to populate an Output field with data if a specified qualifier is used or
if specific criteria is met.

You may need to use extended rules in addition to creating temporary records and fields.

Reference
See Using Extended Rules, chapter 6, for more information.

You can add temporary records and fields at any hierarchical level in a map. However,
when you use temporary records and fields, you must locate them immediately after the
map component that contains the necessary data.

The following caveats apply to temporary records:

» You must use a record tag that you would never receive in your Input file, and the
recommended default is $$8.

» Ifyou are creating a temporary record for an XML file, use the tag XXX, because $$$
is not permitted as a tag in XML.

» The system does not run standard or extended rules on temporary records.
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Example To map the shipping information from the Input side of your map (from the N1 Group that
repeats a maximum of 200 times) to the ShipTo record in your application file format (that
does not repeat), you need to create a temporary storage record and fields on the EDI side
of the map that do not repeat. Then, you use an extended rule to extract the shipping and
billing information from the N1 group and move it to the appropriate temporary storage
elements. Finally, you map the shipping and billing information directly from the
temporary storage elements to your application fields.

Step 1 First, you need to create a temporary storage record and fields on the EDI side of the map
that do not repeat. The temporary record is located outside the N1 Group at the same
hierarchical level as it, and has a maximum repeat number of “1” (i.e., it does not repeat).
Then you will create the appropriate temporary fields.

Reference
See How to Create Fields on page 2 - 64 for more information.

This table lists the temporary storage record that you are creating.

Min
Name Description Tag Usage Max Usage

ShipToDet Ship To Details $88 0 1

Example procedure
Use this procedure to create the ShipToDet temporary storage record.

Step Action

1 Highlight the N1 group. The two temporary storage segments are located
after the N1 group, at the same level.

2 From the Edit menu, select Insert. From the submenu, select Segment
(you select Segment instead of Record because you are creating the
temporary record on the EDI side of the map).

System response
The EDI Segment Properties dialog box is displayed.

3 In the Name box, type ShipToDet.
4 In the Description box, type Ship To Details.
5 Select the Tag tab.
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(Contd)
Step

Action

6

In the Tag box, type $$$.

Note

The system does not read a segment with a value of “$$$” in the Tag box.
Therefore, it does not flag this temporary storage segment as an error
during compliance checking.

Click OK to create the ShipToDet temporary storage segment.

Create the appropriate temporary fields.

Example
» SHIPTONAME

» SHIPTOADDRI
» SHIPTOADDR2
» SHIPTOCITY

» SHIPTOSTATE
» SHIPTOPCODE

Note
See How to Create Fields on page 2 - 64 for more information.

Step 2 Create an ON_END extended rule for the N1 Group that assigns the necessary
information to the temporary fields.

Example procedure
Use this procedure to create the extended rule.

Step

Action

1

Right-click the N1 group to access the shortcut menu.

2

From the shortcut menu, select Extended Rules to display the Group
Properties dialog box.

Select the On End option. This specifies that the rule is executed when
the loop terminates. The system loads an occurrence of the N1 group
(containing the billing or shipping information), and then executes this
rule.
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Action

In the Editor list, type the following:

IF #0098 = “BT” THEN

BEGIN
$850.#BILLTONAME = #0093;
$850.#BILLTOADDRL = #0166;
$850.#BILLTOADDR2 = #0166:2;
$850.#BILLTOCITY = #0019;

$850.#BILLTOSTATE = #0156;
$850.#BILLTOPCODE = #0116;
END
IF #0098 = “ST” THEN
BEGIN

$850.#SHIPTONAME = #0093;

$850.#SHIPTOADDRL = #0166;

$850.#SHIPTOADDR2 = #0166:2;

$850.#SHIPTOCITY = #0019;

$850.#SHIPTOSTATE = #0156;

$850.#SHIPTOPCODE = #0116;
END

Note

If a segment/record or element/field occurs more than once in a
map, it is identified by its name <ID>. The second and subsequent
occurrences are identified by <ID>:n, where ‘n’ is the number of
occurrences in the map.

Click Compile to validate the syntax of the extended rule. Every rule in
the map is compiled when you compile the translation object, after you
complete the map. However, the system allows you to compile each rule
individually, so that you can verify the accuracy of the rule after you
create it.

Note

This compiles the rule interactively, and allows you to correct any
errors that are generated. Any errors or warnings generated in the
compilation process are displayed in the Errors list.

Click OK to add the extended rule to the N1 group.

Designing your Map
(Contd)
Step
4
5
6
Step 3

fields.

Application Integration User’s Guide
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How to Create a Group

Introduction A group contains related records, groups, or both that repeat in sequence until either the
data ends or the maximum number of times that the loop is allowed to repeat is exhausted.
If you create a group that is subordinate to another group, this corresponds to a nested
looping structure (a loop within a loop).

Procedure  Use this procedure to create a group.

Step Action

1 » Highlight the map component which precedes the group you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Group from the submenu.

System Response
The system displays the Group Properties dialog box (Name tab

displayed by default).

Name | Looping | Loop Extended Rules |

Please enter the name :

Fleaze enter a short description ;

Cancel | Lapp i | Help

2 In the first box on the Name tab, type the group name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore (_) to separate words.
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How to Create a Group

(Contd)
Step

Action

3

In the second box on the Name tab, type the loop description.

Note
This box is used to provide a brief explanation of the loop.

Select the Looping tab to access looping options.

In the Minimum Usage box, type the minimum number of times the loop
must be repeated.

Note
For a conditional loop, the minimum usage should always be “0” (zero).
For a mandatory loop, the minimum usage should be “1” or greater.

In the Maximum Usage box, type the maximum number of times the
loop can be repeated.

Is this a single iteration group?

» Ifyes, select Promote records to parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» Ifno, continue with the next step.

Do you want to specify an extended rule for this group?
» Ifyes, select the Loop Extended Rules tab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» Ifno, continue with the next step.

Click OK to create the group.
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How to Create Fields

Introduction

Procedure

Each record you create contains a group of logically-related application fields. These
fields define the structure and content of the data to the system.

The easiest way to add application fields to a record is to use the Positional Field Editor.
Generally, you create the fields for the first record in the application file, and then proceed
with each sequential record.

Recommendation

Do not define fields with the purpose of using the field to explicitly contain the record tag.
This is because the system takes the tag that you define in the record into account when
the automatic sequencing (Auto Position) feature is used. We recommend that you define
the record tag on the Positional Record Properties dialog box.

Reference
See How to Create Subsequent Records on page 2 - 56 for more information about the
Positional Record Properties dialog box.

Use this procedure to create the application fields for a record.

Step Action

1 Right-click the application record and select Edit Fields from the
shortcut menu.

System response
The system displays the Positional Field Editor dialog box.

Positional Field Editor
—Recaord
oK |
Mame HEADER Tag HDR TagPoz 1
Cancel I
= el et
f{Eme I I™ | i atom
[escristian I

DataT_l,lpeI 'l Farmat I Yl
StarbFos ID [ Lerath [0 & Leratt ID

— Field
Mame M/C Type Start  Length

Delete |
Auto Position |
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Action

2

Is the field you are creating the first field in the record?
» Ifyes, click New and continue with the next step.
» If no, highlight the field that precedes the field you are creating in

the record layout and click New.

System response
The system displays a highlight bar in the Fields section where the new
field is positioned.

Note
You need to fill in the field values in the Field Details section.

In the Name box, type the field name.

Notes

» Each application field must have a unique name. It is useful to tag
the end of the fields that occur in multiple records with a suffix that
identifies the record that contains it.

» Do not use spaces or dashes (-) in the field name. You can use the
underscore (_) to separate words.

Do you want to designate the field as “mandatory” (must be present)?
» Ifyes, select the Mandatory check box.

» Ifno, continue with the next step.

In the Description box, type a description of the field.

Note
The description is used to provide a brief explanation of the field that
allows you to differentiate it from similar fields.

From the Data Type list, select the type of the field.

Note

Valid values are:

» String = alpha element

» Number = numeric or real element

» Date/Time = date or time element
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Step

Action

7

From the Format list, select how the field is formatted.

Note

The choices for this field depend on the type of field you selected from
the Data Type list. If you choose Number or Date/Time in the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates
(the default syntax token is “X”).

When you installed Gentran:Server, you assigned a default format to the
string fields. This format serves as the basis for character validation.
Most U.S. users use a default format that corresponds to ASCII
characters (for example, the X syntax token). Most users of Asian or
European languages and encoded character sets should use the Free
Format (0x01-0xFF).

Reference
See How to Use Syntax Tokens on page 2 - 106 for more information.

Do you want to indicate the exact position of the field in the record?

» Ifyes, type the starting position of the field in the Start Pos box.

» Ifno, continue with the next step.

Note

You want to specify field start positions if, for example, you are only
using a few fields but you want them positioned exactly in the record.
The alternative to specifying the start position of each field, is to add the
fields sequentially in the record and then use the Auto Position function.

Reference
See step 13 below for more information about the Auto Position
function.

In the Min Length box, type the minimum number of characters that is
acceptable for this field.

10

In the Max Length box, type the maximum length of the field.

11

Click New.

System response
The system adds the field and creates a new field with blank values ready
for you to identify, which is positioned below the field.

12

Create the rest of the fields according to your record layout.

Note
Click Delete to stop adding fields.
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Action

13

After adding the last field, do you want the system to automatically
position the fields in the record?

» Ifyes, click Auto Position.

Note

This automatically calculates the start position in the record of each
field based on the criteria that each field is positioned directly after
the previous field and is of the length specified in the Max Length
box. Click Yes to acknowledge the warning message that fields are
sequenced in order.

Warning

It is only valid to use the Auto Position function if you define a
record tag, and if you define every field in the record in the sequence
that each field occurs.

Reference
See How to Create Subsequent Records on page 2 - 56 for more
information.

» Ifno, continue with the next step.

14

Are you completely finished adding fields to the record?
» Ifyes, click Close.
» Ifno, repeat steps 2 through 13.

Note
Use this procedure to add fields to the other records you defined.

For inbound maps, you may want to use a literal constant to move a
value into an application field that has no corresponding EDI data (you
cannot link the field directly to an EDI element).

Reference
See How to Map Literal Constants on page 3 - 32 for more information
about mapping a constant to a field.
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Using an EDI File

Overview

Introduction

Gentran:Server generates an EDI file for you, based on the standard (agency), version,
transaction set, and release you select. The system includes all the groups, segments,
composites, and elements that are defined by the standards agency for the version of the
document you select.

Reference
See How to Create a New Map on page 2 - 20 for more information about generating an
EDI file when you create a new map.

You can modify the system-generated EDI file by modifying the properties of the map
components, and using the promote, split, copy, cut, and paste functions.

However, if you want to use a specialized version of an EDI standard that is not available
in the Gentran:Server standards database, it may be appropriate for you to either load an
EDI file definition or define the EDI file yourself.

Reference
See Using a CII File on page 2 - 89 for more information about defining a CII file.

Regardless of whether the system generates the EDI file or you load or define it, the
specific EDI map components that you use depends on the type of map you are creating.
This includes the standard, version, and transaction set (document) selected, and which
groups, segments, composites, and elements your company requires. We recommend that
you determine which map components you are using before generating or defining an EDI
file.
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How to Verify EDI Delimiters

Introduction  If you are using an EDI standard that contains composite elements or subelements, you
must verify that Gentran:Server is specifying the correct delimiters. Delimiters are flags
that you define to the system as separating specific EDI components.

Delimiters are necessary for all variable field-length standards, because the data is
compressed (and the leading zeroes and trailing blanks are removed). Since the fields vary
in length, the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

Recommendation

Although verifying EDI delimiters in Gentran:Server is mandatory only if you are using a
standard with composite elements or subelements, we recommend that you perform this
task regardless of which standard you use.

Procedure  Use this procedure to verify EDI delimiters.

Step Action

1 Right-click the EDI file icon and select Properties from the shortcut
menu.

System response
The system displays the File Properties dialog box.

File Properties
MName | Drelimiters | Syntax Hecordl Loop Extended Flulesl

Please enter the name :
IDHDEHS

Flease enter & shart description :
FURCH&SE ORDER MESSAGE

DK‘ Fm— éIJIJL'r' HB||3
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Step

Action

2

Select the Delimiters tab to access delimiter options.

File Properties x|

Mame Delimiters I Syntax Record I Loop Extended Flulesl

™ Specify defaults

Tiag Delimiter

I— Segment Delimiter I—
I— Sub Element Delimiter I—
Fepeating Element Delimiter I—

I_ [recimal Separator

Elerment Delimiter

o

Felease Character

Option:
" Default suppression and padding of leading zero on Humeric valies

{7 Suppress lzading zem on Nurmers B format values [e.g), 0025 > 25

) Padiwith eading zenm o Humeric values e, 25 - OO002E]

o]

Cancel | Lpply I Help |

Verify that the Specify defaults check box is selected.

Verify the required delimiters for the EDI standard you are using.

Note
If the delimiters differ from the defaults specified, type either the
character or the hexadecimal value in the correct box.

Are you using an X12, EDIFACT, or TRADACOMS standard on the
output side of a map and you want to suppress leading zeros for the EDI
elements that use an R-format numeric (including decimal values less
than one)?

» If Yes, select the Suppress leading zero on Numeric R* format
values (e.g., 0.25---> .25) option.

» If No, continue with Step 6.

Are you using an X12, EDIFACT, or TRADACOMS standard on the
output side of a map and you want to pad numeric values (regardless of
format) for the EDI elements with leading zeros?

» If Yes, select the Pad with leading zero on Numeric values (e.g.,
25---> 000025) option.

Note
When you select this option, Numeric values (regardless of format)

are padded with leading zeros out to the maximum length of the
field.

» IfNo, continue with Step 7.

Click OK to exit the File Properties dialog box.
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How to Modify Group Properties

Introduction A group contains related segments and/or groups that repeat in sequence until either the
group data ends or the maximum number of times that the loop is allowed to repeat is
exhausted. If you create a group that is subordinate to another group, this corresponds to a
nested looping structure (a loop within a loop).

Procedure  Use this procedure to modify the properties of a group.

Step Action

1 Right-click the group you want to modify and select Properties from
the shortcut menu.

System Response
The system displays the Group Properties dialog box (Name tab

displayed by default).

Name | Loopingl Loop Extended Hulesl

Please enter the name :

Please enter a short description :

Cancel | Lopi I Help |

2 If you want to modify the group name, in the first box on the Name tab,
type the new name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore () to separate words.

3 If you want to modify the group description, n the second box on the
Name tab, type the new description.

4 Select the Looping tab to access looping options.
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Step Action
5 In the Minimum Usage box, type the minimum number of times the loop
must be repeated.

Note

For a conditional loop, the minimum usage should always be “0” (zero).

For a mandatory loop, the minimum usage should be “1” or greater.

6 In the Maximum Usage box, type the maximum number of times the
loop can be repeated.
7 Is this a single iteration group?

» Ifyes, select Promote records to parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» Ifno, continue with the next step.

8 Do you want to specify an extended rule for this group?

» Ifyes, select the Loop Extended Rules tab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» Ifno, continue with the next step.

9 Click OK to save changes to the group.
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How to Modify Segment Properties

Introduction You can modify the properties of any segment, including the minimum and maximum
number of times the segment can repeat, whether the segment is mandatory or conditional,
and whether it is a loop start or loop end segment.

Reference
See How to Use Loop Start and Loop End Segments on page 2 - 76 for more information.

Procedure  Use this procedure to modify the properties of a segment.

Step Action

1 Right-click the segment you want to modify and select Properties from
the shortcut menu

System Response
The system displays the EDI Segment Properties dialog box.

EDI Segment Properties 1]

Harme |Tag I Key Fieldl Speciall Loopingl
Please erter the name :
|N1
Fleaze enter a short dezcription :
HAME
Cancel I A | Help |
2 If you need to modify the name of the segment, type the segment name

in the first box on the Name tab.

Note
If a segment occurs more than once in a map it is identified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,

€699

where “n” is the number of the occurrence in the map.
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Step Action

3 If you want to modify the description of the segment, type a new
description in the second box on the Name tab.
Note
This box is used to provide a brief explanation of the segment that
allows you to differentiate it from similar segments.

4 Select the Tag tab only if you want to access tag information.

5 If you want to modify the segment tag, type the segment identification
code <TAG> in the Tag box.
Note
The segment tag for each segment enables the system to recognize that
segment.
Example
A record is recognized by the system as:
<TAG>[Delimeter|<DATA>[Delimeter]
<DATA>......<DATA>[Segment Terminator|

6 Select the Key Field tab only if you want to use a key field.
Note
The key field function enables you to specify a second qualification in
selecting a segment (the segment name is the first qualification). Data
must be provided in the order designated through the use of key fields.

7 Select the Special tab only if you want to specify floating (the segment
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options, or if you want to flag this
segment as containing binary data. Otherwise, accept the defaults.
Note
If you select “Binary,” you must define an element of data-type “Bin
Length” and another element of data-type “Bin Data.” The “Bin Length”
element must precede the “Bin Data” element.
Reference
See How to Modify Element Properties on page 2 - 84 for more
information about defining an element data-type.

8 Is the segment a looping structure?
» Ifyes, select the Looping tab.
» Ifno, accept the defaults and continue with step 12.
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Action

9

In the Min Usage box, type the minimum amount of times the segment
must repeat.

Note

If the Min Usage box contains a “0” (zero), the segment is “conditional.”
If the Min Usage box contains a “1” or greater, the segment is
“mandatory.”

10

Do you want the segment to repeat (loop)?

» Ifyes, type the maximum amount of times it can repeat in the Max
Usage box.

» Ifno, continue with the next step.

11

Do you want to indicate that the segment is the beginning of a loop
(Loop Start) or the end of a loop (Loop End)?

» Ifyes, select one of the following options.
Loop Start (this segment marks the beginning of the loop)
Loop End (this segment marks the end of the loop)

» Ifno, accept the default of Normal for the Normal/Loop Start/Loop
End options, which indicates that this segment is in the loop but is
not the beginning or ending segment

12

Click OK to save changes to the segment.
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How to Use Loop Start and Loop End Segments

Introduction Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and LE segments and depending on whether your map is inbound or
outbound, you need to define the LS and LE segments for the loops you are using in the

map in one of two different ways.

Tip

You need to communicate with your trading partner to determine which loop identification
code your partner sends you (for an inbound map), or expects to receive (for an outbound

map).

Procedure:  Use this procedure to define an LS segment for an inbound map.

Action

Right-click the LS segment and select Properties from the shortcut

menu.

System response
The system displays the EDI Segment Properties dialog box.

» Select the Looping tab to access the loop options and
» verify that the Loop Start option is selected.

defining a LS
segment inbound
Step
1
2
3

Select the Key Field tab.

System response
The system displays the key field options.

EDI Segment Froperties

Mame I Tag K.y Figld I Speciall Loopingl

Fietdl | =l

I &kt e

) sz corstart I ¥ l Edif... |
= secodelist I ¥ l Edit... |

Ittt record when key does nobmateh

Cancel Sl Help
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Action

4

From the Field list, select the “Loop Identifier Code.”

Note

This list contains all the elements that are contained in the segment and
gives you the ability to define the Loop Start segment definition, by
specifying that the loop identifier code must have the value you specify
in the Matching rules section.

Select the Use constant option.

Note
The Matching rules section enables you to access all the literal constants
and code lists currently defined for this map.

Click Edit (at the right of the Use constant list).

System response
The system displays the Map Constants dialog box.

Translation Object Constants [ %]

D Type Walue
Sub Table 1 Sting PRODCODE

Mew...

Change...

Delete

di

Click New.

System response
The system displays the Edit Constant dialog box.

Edit Constant

D Type

Walue Cancel |

In the ID box, type the literal constant identifier.
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Step Action

9 From the Type list, select “String.” This is the category of this literal
constant.

10 In the Value box, type the value of the literal constant.
Note
For an inbound map, this is the loop identifier code that you expect to
receive from your trading partner.

11 Click OK to add the constant to the system.

12 Select the constant you created from the list.
Note
The system matches the selected constant against the loop identifier
code.

13 Click OK to exit the EDI Segment Properties dialog box.

Procedure: Use this procedure to define an LE segment for an inbound map.
defining a LE
segment inbound

Step Action

1 Right-click the LE segment and select Properties from the shortcut
menu.

System response
The system displays the EDI Segment Properties dialog box.

2 » Select the Looping tab to access the loop options and
» verify that the Loop End option is selected.

3 Select the Key Field tab.

System response
The system displays the key field options.

4 From the Field list, select the “Loop Identifier Code.”

Note

This list contains all the elements that are contained in the segment and
gives you the ability to define the Loop End segment definition, by
specifying that the loop identifier code must have the value you specify
in the Matching rules section.
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5

Select the constant you created for the LS segment from the list.

Notes
» The system matches the selected constant against the loop identifier
code.

» The Matching rules section enables you to access all the literal
constants and code lists currently defined for this map.

Click OK to exit the EDI Segment Properties dialog box.

Procedure:  Use this procedure to define an LS segment for an outbound map.

Action

Double-click the Loop Identifier Code element in the LS segment.

System response
The system displays the Element Properties dialog box.

Select the Standard Rule tab to access the standard rule options.

defining a LS
segment outbound
Step
1
2
3

From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.

Element Froperties

Mame I Validationl Extended Fule  Standard Rule IEonditionsl

Please select the standard rule to use : IUse Constant j

Please select a constant to stare in this figld :
f =l Ed. |

IF this constant is a qualifier for anather field, GEMTRAM can automatically use the
existence of data in that field to determine whether to execute this standard wile. To
take advantage of this featurs, simply select the field to be qualified :

Cancel Sl Help
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Action

4

Click Edit.

System response
The system displays the Map Constants dialog box.

Click New.

System response
The system displays the Edit Constant dialog box.

In the ID box, type the literal constant identifier.

From the Type list, select “String.” This the category of this literal
constant.

In the Value box, type the value of the literal constant. For an outbound
map, this is the loop identifier code that your partner is expecting to
receive from you.

Click OK to add the constant to the system.

10

Click Close to exit the Map Constants dialog box.

11

From the constant list, select the constant that you created.

Note
The system matches the selected constant against the loop identifier
code.

12

Click OK to exit the Element Properties dialog box.

Procedure: Use this procedure to define an LE segment for an outbound map.

Action

Double-click the Loop Identifier Code element in the LE segment.

System response
The system displays the Element Properties dialog box.

Select the Standard Rule tab to access the standard rule options.

defining a LE
segment outbound
Step
1
2
3

From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.
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4

From the constant list, select the constant that you created.

Note
The system matches the selected constant against the loop identifier
code.

Click OK to exit the Element Properties dialog box.
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How to Modify Composite Properties

Introduction A composite is a data element that contains two or more component data elements or
subelements. You can modify the composite name and description, and whether or not it is

mandatory.

Note

Composite elements are only used for EDI maps.

Procedure  Use this procedure to modify the properties of a composite.

Step

Action

1

Right-click the composite you want to modify and select Properties
from the shortcut menu.

System response
The system displays the Composite Properties dialog box.

Composite Properties

Name | Validation |

Please enter the name :
|cnnz

Fleasze enter a short description :

Cancel | Appli | Help |

If you want to change the composite name, type the data element
identification number in the first box on the Name tab.

Note

If a composite occurs more than once in a map it is identified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where “n” is the number of the occurrence in the map.

If you want to change the composite description, type the new
description in the second box on the Name tab.
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Action

4

Select the Validation tab if you want to specify that the composite is
mandatory.

Select the check box on the Validation tab to indicate whether this
composite must be present.

Click OK to save the changes to the composite.
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How to Modify Element Properties

Introduction Each segment or composite contains a group of logically-related elements. These elements
define the structure of the EDI data that your system needs to process the document.

Procedure: Use this procedure to modify the properties of an element.
modifying element
properties

Step Action

1 Double-click the element you want to modify.

System response
The system displays the Element Properties dialog box.
Element Froperties

Hame |Validati0n| Extended Fiulel Standard Hulel Eonditionsl

Please enter the name :
|03?3:5

Fleasze enter a short description :
DATE

Cancel I e[ | Help I

2 To change the name of the element, type the new name in the first box on
the Name tab. The name is typically the element sequence number.

Note

If an element occurs more than once in a map it is identified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where “n” is the number of the occurrence in the map.

3 To change the description of the element, type the new description in the
second box on the Name tab.

Note
The description is used to provide a brief explanation of the element that
allows you to differentiate it from similar elements.

4 Select the Validation tab to access validation options.
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Action

5

If you want to designate the element as “mandatory” (must be present),
select the first check box on the Validation tab.

To change the minimum length of the element, type the minimum length
in the Minimum box.

Note
If the data is less than the minimum length, a compliance error is
generated when translation occurs.

To change the maximum length of the element, type the maximum length
in the Maximum box.

From the Data Type list, select the type of the element.

Note

Valid values are:

» String = alpha element

» Number = numeric or real element

date or time element

» Date/Time

» BinData = binary data (only available if you select “Binary” on
the Special tab of the EDI Segment Properties
dialog box)

» BinLength = length of binary data (only available if you select
“Binary” on the Special tab of the EDI Segment

Properties dialog box)

Reference
See How to Modify Segment Properties on page 2 - 73 for more
information about selecting “Binary” on the Special tab.
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Step Action

9 From the Format list, select how the data element is formatted.

Note

The choices for this field depend on the type of field you selected from
the Data Type list. If you choose Number or Date/Time in the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates.

When you installed Gentran:Server, you assigned a default format to the
string fields. This format serves as the basis for character validation.
Most U.S. users use a default format that corresponds to ASCII
characters (for example, the X syntax token). Most users of Asian or
European languages and encoded character sets should use the Free
Format (0x01-0xFF).

Reference
See How to Use Syntax Tokens on page 2 - 106 for more information.

10 Click OK to save the changes to the element.

Procedure: You can use relational conditions to connect fields together for syntax or compliance
defining and  reasons. For example, Field A is invalid unless Field B is present. Therefore, if you set up
modifying a condition that pairs Fields A and B, the system generates a compliance error if one of

relational  those fields is not present.

conditions
You can also view the conditional relationships between elements, as provided by the
standard.

Warning
The system enables you to edit EDI conditional relationships, but if you do, you generates
a compliance error. We recommend that you view EDI conditions only.

Procedure  Use this procedure to define, modify, and view field and element relational conditions.

Step Action

1 Double-click the field or element you want to modify.

System response
The system displays the Field (or Element) Properties dialog box.
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Action

2

Select the Conditions tab.

System response

The system displays the relational condition options.

Element Properties

Mame I ‘v"alidationl E stended Hulel Standard Rule  Conditions |

Flease chooze the type of relationzhip to use :

I Conditional A l

Please select the condition fisld :
|D235 FRODUCT/SERVICE ID QUALIFIER j

Available fields :

0350 ASSIGNED IDENTIFIC o
0230 QUANTITY ORDERE
0355 UNIT OR BASIS FOR
0212 UNIT PRICE

0639 BASIS OF UMIT PRICE

02352 PRODUCT /SERWICE - < Remove |
0224-2 PEOM T SERY T

R ;I" Y I— ol

Fields uzed in relationzhip :
0234 PRODUCT /SERVICE 1D

ak. | Cancel | Aply | Help |

Select the field connection condition from the type of relationship list.

Note
Valid values are:

Paired/Multiple — if any of the specified fields are present then all
fields must be present

Required — at least one of the specified fields must be present
Exclusion — no more than one of the specified fields may be present

Conditional — if the first Condition field is present, the rest of the
fields must also be present

List Conditional — if the first Condition field is present, at least one
of the specified fields must also be present

Select the first field from the condition field list.

Notes

This is the field on which the conditional relationship hinges if you
chose “Conditional” or “List Conditional” from the type of
relationship list.

The condition field list is only active if you chose either
“Conditional” or “List Conditional” from the type of relationship
list.

Application Integration User’s Guide

Gentran:Server for Windows — August 2008 ()



How to Modify Element Properties Designing your Map

(Contd)
Step Action

5 From the Available fields list, select a field or fields and click Add.

System response
The system moves the fields to the Fields used in relationship list, to
include the fields as a part of the conditional relationship.

Notes

» The Available fields list contains all the fields in the translation
object that are valid to be used in a condition at this point.

» The Fields used in relationship list contains the fields that you
selected to be a part of the conditional relationship.

» Toremove the fields from the conditional relationship, select a field
or fields from the Fields used in relationship list and click Remove
to move the fields back to the Available fields list.

6 Click OK to add the conditional relationship to the field.
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Using a CII File

Overview

Introduction If a side of your map is CII, you must either define it to Gentran:Server or load a
previously-saved file definition. A CII message consists of one message header, one TFD
area, and one message trailer

Before you define the CII file, you should determine which groups and TFDs you will
need to use. The groups contain related groups and TFDs. This means that you must create
groups before you create the subordinate subgroups and TFDs.

Each map component is arranged sequentially in the order that it is most logical for the
system to process. Therefore, each level of your application must be created sequentially.
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How to Modify CII File Properties

Introduction The CII File Properties dialog box enables you to modify setting for the CII or CII-
Positional sides of a map. This dialog box enables you toggle the use of dividing mode (a
method of formatting CII data into fixed-length 251-byte records), non-transparent mode
(encodes characters in the CII data so that they do not cause problems with some
communications file-transfer protocols). This dialog box also enables you to specify
single- or double-byte character sets to use in data translation.

Procedure  Use this procedure to modify CII File Properties.

Step

Action

1

Right-click the CII file icon and select Properties from the shortcut
menu.

System response
The system displays the CII File Properties dialog box.
Cll File Properties
Name |M0de I EharacterSetsI Loop Estended Hulesl

Please enter the name :
pNPUT

Please enter a short description :

Cancel | Al | Help |

Note
The system displays the Name tab by default. On this tab, you can
modify the name and description of the CII file.

Select the Mode tab to access mode options.

Will you be communicating with a transmission system that is unable to
process variable length records?

» Ifyes, select the dividing mode (a method of formatting CII data into
the plural number of 251-byte fixed records) On option.

» Ifno, continue with the next step.

6
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How to Modify CII File Properties

(Contd)
Step

Action

4

Do you want to use non-transparent mode to encode characters in the CII
data so they do not cause problems with some communications file-
transfer protocol communications control characters?

» Ifyes, select the Non-Transparent Mode check box.

» Ifno, the default is cleared, which means you are using transparent
mode.

Select the Character Sets tab to access character set options.

Do you want to use single- or double-byte character translation?

» Ifyes, select the appropriate option from the 8 bit Character Set and
16 Bit Character Set lists.

» Ifno, continue with the next step

Do want to specify an extended rule for this group?
» Ifyes, click the Loop Extended Rules tab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» Ifno, continue with the next step.

Click OK.

System response
The system saves your modifications and exits the CII File Properties
dialog box.
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How to Create a Group

Introduction A group contains related TFDs, groups, or both that repeat in sequence until either the data
ends or the maximum number of times that the loop is allowed to repeat is exhausted. If
you create a group that is subordinate to another group, this corresponds to a nested
looping structure (a loop within a loop).

Procedure  Use this procedure to create a group.

Step Action

1 » Highlight the map component which precedes the group you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Group from the submenu.

System Response
The system displays the Group Properties dialog box (Name tab
displayed by default).
Group Properties
Harne | Loopingl Loop Extended Hulesl

Pleass enter the name :

Flease enter a shart description :

Cancel | Al | Help

2 In the first box on the Name tab, type the group name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore (_) to separate words.
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How to Create a Group

(Contd)
Step

Action

3

In the second box on the Name tab, type the loop description.

Note
This box is used to provide a brief explanation of the loop.

Select the Looping tab to access looping options.

In the Minimum Usage box, type the minimum number of times the loop
must be repeated.

Note
For a conditional loop, the minimum usage should always be “0” (zero).
For a mandatory loop, the minimum usage should be “1” or greater.

In the Maximum Usage box, type the maximum number of times the
loop can be repeated.

Is this a single iteration group?

» Ifyes, select Promote records to parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» Ifno, continue with the next step.

Do you want to specify an extended rule for this group?

» Ifyes, select the Loop Extended Rules tab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» Ifno, continue with the next step.

Click OK to create the group.
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How to Create a TFD

Introduction The first TFD in your CII file is subordinate to the icon on the CII of the map. This
graphic representation shows how the TFDs (and groups) are contained within the CII file.

After you create the first TFD, you can define subsequent TFDs at the same level. You can
also define groups, if your application includes looping structures. You may need to define
a group if your application requires a group of related TFDs (and/or subgroups) that repeat
in sequence. Please see How fo Create a Group on page 2 - 62 for more information.

Note

When you create a TFD, the default data type is “String,” so the system displays the
Character Set tab. If you change the TFD data type to “Number” or “Date/Type,” the
system removes the Character Set tab.

Procedure  Use this procedure to create a TFD.

Step Action

1 Are you creating the first TFD in your file?

» [Ifyes, select the CII File icon (INPUT for an inbound map and
OUTPUT for an outbound map), and select Create Sub from the
Edit menu. Then, select TFD from the submenu.

» Ifno (you are creating a subsequent TFD), select the TFD which
precedes the TFD you are creating in the file layout. Then, select
Insert from the Edit menu and select TFD from the submenu.

System response
The system displays the CII TFD Properties dialog box.
Cll TFD Properties
Mame | Tag | Looping | Walidstion | Standard Fiule | Extended Rule | Character et |

Please enter the name :

Pleaze enter a shat description :

=0 Cancel ool Help
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How to Create a TFD

(Contd)
Step

Action

2

In the first box on the Name tab, type the TFD name.

Warning
Do not use spaces or dashes (-) for the TFD name. You can use the
underscore (_) to separate words.

In the second box on the Name tab, type a description of the TFD.

Note
This box is used to provide a brief explanation of the TFD that allows
you to differentiate it from similar TFDs.

Select the Tag tab to access tag information.

Note
The data tag is an identifier that expresses attributes of a data element.

Select either the Hex or Decimal option, depending on how you want to
enter the data tag.

Note
The default is Hex.

If you want to use an extended range of values for the tag, select the
Extended Mode check box.

Notes

» Ifyou select the Extended Mode check box, you can enter up to hex
7FFF (decimal 524287) in the Tag box. In compressed mode, you
can only use up to hex EF (decimal 239).

»  The default is cleared, which means that the data tag will be
expressed in compressed mode.

» In Extended Mode, the range that you can use for the TFD tag is
restricted to decimal 61440 - 65535 and hex FO00 - FFFF.

In the Tag box, type the identification tag. You must enter a tag in this
box.

Select the Looping tab to access the loop options.

Accept the default of Normal, unless you want to indicate that the
segment is the beginning of a loop (Loop Start), the end of a loop (Loop
End), or that the loop repeats (Loop Repeat).

Note
If you select Loop Start, the system displays the Key Field tab.

10

Select the Validation tab to access validation options.
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(Contd)
Step

Action

11

If you want to designate the TFD as “mandatory” (must be present),
select the first check box on the Validation tab.

12

To change the minimum length of the TFD, type the minimum length in
the Minimum box.

Note
If the data is less than the minimum length, a compliance error is
generated when translation occurs.

13

To change the maximum length of the TFD, type the maximum length in
the Maximum box.

14

From the Data Type list, select the type of the TFD.

Note

Valid values are:

» String = alphabetic

» Number = numeric or real
» Date/Time = date or time

15

From the Format list, select how the TFD is formatted.

Note

The choices for this field depend on the type of field you selected from
the Data Type list. If you choose Number or Date/Time in the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates
(the default syntax token is “X”).

When you installed Gentran:Server, you assigned a default format to the
string fields. This format serves as the basis for character validation.
Most U.S. users use a default format that corresponds to ASCII
characters (for example, the X syntax token). Most users of Asian or
European languages and encoded character sets should use the Free
Format (0x01-0xFF).

Reference
See How to Use Syntax Tokens on page 2 - 106 for more information.

16

If the TFD data-type is Number or String and you want the data read/
written in binary format:

» Seclect the raw bytes check box,

» From the Width list (Number format only), select how many bytes
should be used to represent the number,

» Select either the little-endian or big-endian option to specify in
which order the bytes should be read.

6
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How to Create a TFD

(Contd)
Step

Action

17

If the Character Set tab is available, it enables you to set the single-
double-byte character translation for this string. The default character set
is 8-bit. Select the appropriate option from the 8 bit Character Set and 16
Bit Character Set lists.

18

Click OK to create the TFD.
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Formatting Your Data

Overview

Introduction When you define or modify a field, element, or TFD, you must specify the type and
format. The options that are available for the format of the field, element, or TFD depend
on which type you select (string, number, or Date/Time).
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How to Use the String Type

Introduction A string-type field or element contains one or more printable characters. If you specify

How to Use the String Type

that a field or element is a string type, you must designate the format by specifying a

syntax token.

Syntax tokens enable you to designate a “token” that defines ranges of characters and
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog box. This enables you
to define the type of characters to be used while compliance checking each element/field

(e.g., alphanumeric within a certain range or numeric within a certain range).

Note

When you set up a token, it applies only to that map. You may need to set one up for each

map that you create.

Character ranges Gentran:Server uses the ANSI Character Set when determining the start-end range.

For Western European languages, consult the ANSI character chart (1252 Windows Latin

1). This chart also displays ranges so that you can enter appropriate ranges for the
characters in your language. If no chart is available, use the following guidelines:

» To include all the accented characters in the major languages of Western Europe, add

the following ranges:

Start End
0xCO0 0xD6
0xD8 0xF6
0xF8 0xFC

» Scandinavian users should also add the following in order to include (E and ce.

Start End
0x8C 0x8C
0x9C 0x9C
» To include the euro symbol (€), use the following.
Start End

0x80

0x80
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Procedure: Use this procedure to create a syntax token.
creating or editing
a syntax token

(Western Step Action
European 1 From the Edit menu, select Syntax Tokens.
languages)

System response
The system displays the Syntax Tokens dialog box.

Syntax Tokens E
Token  Allowed character ranges
& &Zaz
N 09,.-—++ -
* BZaz09. e ([ AN
Mew... |
Change... |
Delete |
P I I _.I [HBEE: |
Notes

» The Token column contains the value designated as the syntax token
for each existing syntax token. The Token contains a range of
characters that, when applied to an element, dictate the way that
element must be formatted. If the element is not formatted as
specified, the system generates a compliance error.

» The Allowed character ranges column contains the ranges of
characters that are permitted for each existing syntax token. Each
range consists of a pair of characters that define the start and end
characters.

» DBCS is only available if you are executing a double-byte version
of Windows 2000.

2 Are you creating a new syntax token?
» Ifyes, click New.
» Ifno, select the token you want to edit and click Edit.

System response
The system displays the Edit Syntax Token dialog box.

Edit Syntax Token

Token I_

Character Fanges

Cancel

[(Ed |

Start End

Mew...
Change...

Delete

i
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(Contd)
Step

Action

3

In the Token box, type the unique one-character alphanumeric value that
the system recognizes as containing the allowed range of characters you
designate.

Notes

» The Token can only be one unique character, upper- or lower-case
alphabetic or numeric “1” - “9”.

» The Character Ranges list contains the character range or ranges
that you define for this token. You can define more than one
character range for each token. For example, you can define the
token “A” as allowing the character range “A” through “Z” and the
character range “a” through “z”. This indicates that token “A” only
allows upper-case and lower-case alphabetics.

Do you want to create a new character range?

» Ifyes, click New.

System response
The system displays the Edit Character Range dialog box.

Edit Character Range
Start character I
End character I Cancel |

» Ifno, continue with step 8.

In the Start character box, type the character that begins the allowed
token range.

Example
For example, if the character range you want to define is “B” through
“D,” type “B” in the Start character box.

Notes

» Ifyou type a character, such as é, that is not accepted, you need to
enter it in hex code. To enter hex characters, “0(zero)x” or “0X,”
followed by the hex code. For example, the hex equivalent of ¢ is
0xE9.

»  The Start character and End character can only be one (1) character,
upper- or lower-case alphabetic or numeric “1” - ©9.”

In the End Character box, type the character that terminates the allowed
token range. Use the guidelines from step 5.

Click OK to return to the Edit Syntax Tokens dialog box.

To add additional character ranges to the syntax token, repeat steps 4 - 7
as many times as necessary.
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(Contd)
Step

Action

9

Click OK to save the syntax token and return to the Syntax Tokens

dialog box.

10

Click Close to exit the Syntax Tokens dialog box.

Procedure.
creating or editing
a syntax token
(Far Eastern
languages)

the Syntax Tokens dialog box.

Note

The DBCS syntax token function enables you to create a map that accepts double-byte
characters. If you are running Gentran:Server on a Chinese, Japanese, or Korean version
of Windows/Windows 2000 or Windows 98/Me, the DBCS button on the Syntax Tokens

dialog box is available.

DBCS tokens are displayed only in the DBCS Syntax Tokens dialog box, not in the list in

When you set up a DBCS token, it applies only to that map. You may need to set one up
for each map that you create.

Use this procedure to create a DBCS syntax token.

Step

Action

1

System response

From the Edit menu, select Syntax Tokens.

The system displays the Syntax Tokens dialog box.

Syntax Tokens
Token  Allowed character ranges
& &Zaz
§ 09.-++
% AZaz00, -+ [N S
Mew... |
Change... |
Delete |
Pl I I _,I [WEIEE: |
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(Contd)
Step

Action

2

Click DCBS.

System response
The system displays the DCBS Syntax Token dialog box.

Click New.

System response
The system displays the Edit DCBS Syntax Token dialog box.

L
Lead-EByte oo * Cancel|

Trail-Bytes

oopo1az
i
10 W[N]
Z
g
R
b

—
. +-UJ

B

Bl = RV
=

e
=
lig=] =)
— | e [

o (= mlenfz2
=2 Mo e
[z oo | — -]
——
—
B =] | |

= ] SN
==

0 | | e ——

o [ I —

L~ | (e - -

= | (—— 2o
[y

-

—
A=) 1

-

=t |H

e[ (el
) ENE TSN
= |-o7[= |
s ped|=20 e |

o[- [ [ |
—— T
|
L1 1| 1 | e (o
o | 1 [ |F =+

Note
Double-byte characters are composed of a lead byte and a trail byte. In
the above example, the character A is code point 0041.

In the Token box, type the unique one-character alphanumeric value that
the system recognizes as containing the allowed range of characters you
designate.

Do you want to include all characters in the Trail-Bytes section of the
dialog box?

» Ifyes, continue with step 7.

» Ifno, continue with step 6.
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Action

6

» Use the Lead-Byte list to view other characters in the code page on
your system.

» To exclude individual characters or groups of characters from the
token, select them (grey them out).

Click Close to save the syntax token and return to the Syntax Tokens
dialog box.

Click Close to exit the Syntax Tokens dialog box.

6
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How to Delete a Syntax Token

Introduction You can delete a syntax token from the system. You can also delete a specific character
range from a syntax token.

Procedure:  Use this procedure to delete a syntax token.

deleting a syntax

token Step Action

1 From the Edit menu, select Syntax Tokens.

System response
The system displays the Syntax Tokens dialog box.

Syntax Tokens
Token  Allowed character ranges
A AFaz
M 09, ++ =
% AZaz08. - ++ ([ A%NNEE™ de — |
Change... |
Delete |
P I I _,I DEES.. |
2 Select the token that you want to delete and click Delete.

System response
The selected entry is deleted without warning.

Procedure: Use this procedure to delete a character range from a syntax token.

deleting a

character range Step Action

1 From the Edit menu, select Syntax Tokens.

System response
The system displays the Syntax Tokens dialog box.

2 Select a syntax token and click Change.

System response
The system displays the Edit Syntax Tokens dialog box.

3 Select the character range that you want to delete and click Delete.
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How to Use Syntax Tokens

Introduction You can use syntax tokens in the Format box of the Field (or Element or CII Record)
Properties dialog box. This enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type field, element, or
TFD. The use of a syntax token enables you to define what characters should be used
while compliance checking this field, element, or TFD (i.e., alphanumeric within a certain
range, numeric within a certain range, etc.).

Procedure  Use this procedure to use syntax tokens.

Step Action

1 Double-click an existing field, element, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, or Using a CII File on page 2 - 89 for more information
about creating fields, elements, or TFDs.

System response
The system displays the Element (or Field or CII Record) Properties
dialog box.

2 Select the Validation tab.

System response
The system displays the validation options.
Element Froperties
Mame “alidation IEHtended Hulel Standard Hulel Eonditionsl

Check here if thiz field iz mandatoy: T

Flease zet the allowed lengths of this field :

Miniruirn : |1— I airnuim : IBD—
Fleasze chooze the data-type of this field : lm
Please choose the format of the data in this field : m
" Datais read/written as raw bytes L el Iﬁ

) e (itHEenam byte ardenng

) Uise Bimreniar byte ardenhg

Cancel Al Help
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Action

3

From the data-type list, select String.

Note
This indicates that the field, element, or TFD contains characters.

From the data format list, select free format or a predefined syntax token
to denote that this field, element, or TFD must be formatted as the
specified syntax token dictates.

Notes

»  When you installed Gentran:Server, you assigned a default format
to the string fields. This format serves as the basis for character
validation. Most U.S. users use a default format that corresponds to
ASCII characters (for example, the X syntax token). Most users of
Asian or European languages and encoded character sets should use
the Free Format (0x01-0xFF).

» Free Format indicates that any characters are acceptable in the field.
The translator does not check the characters for compliance.

Reference
See Procedure: creating or editing a syntax token (Western European
languages) on page 2 - 100 for more information.

Click OK to exit the Element (or Field or CII Record) Properties dialog
box.
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How to Use the Number Type

Introduction

Real or numeric

A number type field, element, or TFD contains either an implied decimal or real number
that can be mathematically manipulated. If you specify that a field, element, or TFD is a
number type, you must designate the format by specifying a format of either “N” (implied
decimal) or “R” (real) and the number of decimal places.

An N-formatted number has an implied decimal point (for example, 2.01 formatted as N2
is 201). An R-formatted number has an explicit decimal point and truncates trailing zeros
(for example, 2.123 formatted as R2 is 2.12 and 3.10 formatted as R2 is 3.1). Whether you
use the N or R format depends on the requirements of the document. Regardless of
whether you use the N or R format, you must also indicate the number of decimal places in
the field.

This lists the available real and numeric options.
» RO (this field/element/TFD has an explicit decimal point and no decimal places)
» RI (this field/element/TFD has an explicit decimal point and up to one decimal place)

» R2 (this field/element/TFD has an explicit decimal point and up to two decimal
places)

» R3 (this field/element/TFD has an explicit decimal point and up to three decimal
places)

» R4 (this field/element/TFD has an explicit decimal point and up to four decimal
places)

» RS (this field/element/TFD has an explicit decimal point and up to five decimal
places)

» RO (this field/element/TFD has an explicit decimal point and up to six decimal places)

» R7 (this field/element/TFD has an explicit decimal point and up to seven decimal
places)

» RS (this field/element/TFD has an explicit decimal point and up to eight decimal
places)

» RO (this field/element/TFD has an explicit decimal point and up to nine decimal
places)

» NO (this field/element/TFD has an implied decimal point and no decimal places)
» NI (this field/element/TFD has an implied decimal point and up to one decimal place)

» N2 (this field/element/TFD has an implied decimal point and up to two decimal
places)

» N3 (this field/element/TFD has an implied decimal point and up to three decimal
places)

» N4 (this field/element/TFD has an implied decimal point and up to four decimal
places)
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Real or numeric )

(contd) places)
)
places)
]
places)
]
places)
)
places)
Note

How to Use the Number Type

NS5 (this field/element/TFD has an implied decimal point and up to five decimal

N6 (this field/element/TFD has an implied decimal point and up to six decimal

N7 (this field/element/TFD has an implied decimal point and up to seven decimal

N8 (this field/element/TFD has an implied decimal point and up to eight decimal

NO (this field/element/TFD has an implied decimal point and up to nine decimal

If you select an implicit decimal (“N” format) for a field and the data in that field has less
than the specified number of decimal places, the translator pads the data with zeroes to the
left so that it still interprets the data within the specified format. For example, if you
specify a format of “N3” for a field, and the data in that field is “1”, the translator
interprets the data as “.001”.

Procedure  Use this procedure to use the number type.

Step Action

1 Double-click an existing field, element, or TFD, or create a new one.
Reference
See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, or Using a CII File on page 2 - 89 for more information
about creating fields, elements, or TFDs.
System response
The system displays the Element (or Field or CII Record) Properties
dialog box.

2 Select the Validation tab.
System response
The system displays the validation options.

3 From the data-type list, select Number.
Note
This indicates that the field, element, or TFD is a numeric or real
number that can be mathematically manipulated.

4 From the data format list, select the appropriate real or numeric option.

5 Click OK to exit the Element (or Field or CII Record) Properties dialog

box.
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Introduction

Date/time formats

Designing your Map

How to Use the Date/Time Type

A Date/Time type field, element, or TFD contains a date or time. If you specify that a
field, element, or TFD is a Date/Time type, you must specify exactly how the date or time

must be formatted.

Note

Additional date and time formats can be created and added to the Map Editor.

This table lists the valid date and time formats.

Format Description

YYMMDD Two-digit year, two-digit month, two-digit day

MMDDYY Two-digit month, two-digit day, last two digits of year (example:
121599)

YYYYMMDD Four-digit year, two-digit month, two-digit day (example:
19991215)

DDMMYYYY Two-digit day, two-digit month, four-digit year (example:
15121999)

MMDDYYYY Two-digit month, two-digit day, four-digit year (example:
12151999)

DDMMYY Two-digit day, two-digit month, last two digits of year (example:
151299)

YYMMMDD Last two digits of year, three-letter abbreviation of the month,
two-digit day (example: 99JANO02)

DDMMMYY Two-digit day, three-letter abbreviation of the month, last two
digits of year (example: 02JAN99)

MMMDDYY Three-letter abbreviation of the month, two-digit day, last two
digits of year (example: JAN0299)

YYYYMMMDD | Four-digit year, three-letter abbreviation of the month, two-digit
day (example: 2003JUL04)

DDMMMYYYY | Two-digit day, three-letter abbreviation of the month, four-digit
year (example: 04JUL2003)

MMMDDYYYY | Three-letter abbreviation of the month, two-digit day, four-digit

year (example: JUL042003)
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Format Description

YYDDD Last two digits of year, three-digit Julian day (example: 99349 for
the 349th day of 1999)

DDDYY Three-digit Julian day, last two digits of year (example: 34999)

YYYYDDD Four-digit year, three-digit Julian day (example: 1999349)

DDDYYYY Three-digit Julian day, four-digit year (example: 3491999)

YY/MM/DD Last two digits of year, separator, two-digit month, separator, two-
digit day (example: 99/12/05)

DD/MM/YY Two-digit day, separator, two-digit month, separator, last two
digits of year (example: 05/12/99)

MM/DD/YY Two-digit month, separator, two-digit day, separator, last two
digits of year (example: 12/15/99)

YYYY/MM/DD Four-digit year, separator, two-digit month, separator, two-digit
day (example: 1999/12/15)

DD/MM/YYYY Two-digit day, separator, two-digit month, separator, four-digit
year (example: 15/12/1999)

MM/DD/YYYY Two-digit month, separator, two-digit day, separator, four-digit
year (example: 12/15/1999)

YY/MMM/DD Two-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 99/JUL/20)

DD/MMM/YY Two-digit day, separator, three-letter abbreviation of the month,
separator, two-digit year (example: 20/JUL/99)

MMM/DD/YY Three-letter abbreviation of the month, separator, two-digit day,
separator, two-digit year (example: JUL/20/99)

YYYY/MMM/DD | Four-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 2003/JUL/25)

DD/MMM/YYYY | Two-digit day, separator, three-letter abbreviation of the month,
separator, four-digit year (example: 25/JUL/2003)

MMM/DD/YYYY | Three-letter abbreviation of the month, separator, two-digit day,
separator, four-digit year (example: JUL/25/2003)

YY/DDD Last two digits of year, separator, three-digit Julian day (example:
99/349)

DDD/YY Three-digit Julian day, separator, last two digits of year (example:

349/99)
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Format

Description

YYYY/DDD

Four-digit year, separator, three-digit Julian day (example: 1999/
349)

DDD/YYYY

Three-digit Julian day, separator, four-digit year (example: 349/
1999)

MONTH

Month (example: December)

DAY

Day of the week (example: Friday)

HHMM

Two-digit hour, two-digit minutes (example: 0330 for 30 minutes
past 3 o'clock)

HHMMSS

Two-digit hour, two-digit minutes, two-digit seconds (example:
033045 for 30 minutes and 45 seconds past 3 o’clock)

HH:MM

Two-digit hour, separator, two-digit minutes (example: 03:30)

HH:MM:SS

Two-digit hour, separator, two-digit minutes, separator, two-digit
seconds (example: 03:30:45)

ISO-8601

YYYYMMDDTHHMMSS. mmmZ format: Four-digit year, two-
digit month, two-digit day, T (time) indicator, two-digit hour,
two-digit minutes, two-digit seconds in Universal Time (also
called Zulu Time or Greenwich Mean Time), Z (Zulu time)
indicator (example: 20031209T123000.000Z)

YYYYMMDDZ

ISO-8601 date format: Four-digit year, two-digit month, two-digit
day, Z (Zulu time) indicator (example: 20031209Z7)

MM/DD/YY
HH:MM:SS

Two-digit month, separator, two-digit day, separator, last two
digits of year, two-digit hour, separator, two-digit minutes,
separator, two-digit seconds (example: 12/15/99 03:30:45)

YYMMDD
HHMMSS

Last two digits of year, two-digit month, two-digit day, two-digit
hour, two-digit minutes, two-digit seconds (example: 991025
033045)

YYYY-MM-
DDTHH:MM:SS

Four-digit year, separator, two-digit month, separator, two-digit
day, T represents a blank separator, two-digit hour, separator, two-
digit minutes, separator, two-digit seconds (example: 2002-02-02
03:30:45)

YYYY-MM-DD

Four-digit year, separator, two-digit month, separator, two-digit
day (example: 2002-02-02)

YYYY-MM

Four-digit year, separator, two-digit month (example: 2002-02)

YYYY

Four-digit year (example: 2002)
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Format

Description

--MM-DD

Two dashes, two-digit month, separator, two-digit day (example: -
-12-02)

---DD

Three dashes, two-digit day (example: ---02)

Procedure  Use this procedure to use the Date/Time type.

Step

Action

1

Double-click an existing field, element, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, or Using a CII File on page 2 - 89 for more information
about creating fields, elements, or TFDs.

System response
The system displays the Element (or Field or CII Record) Properties
dialog box.

Select the Validation tab.

System response
The system displays the validation options.

From the data-type list, select Date/Time.

Note
This indicates that the field, element, or TFD is a date or time.

From the data format list, select the appropriate date or time option.

Click OK to exit the Element (or Field or CII Record) Properties dialog
box.
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Completing a Map

How to Create Simple Links

Introduction The Link function enables you to map a field, element, or TFD from the Input side of the
map to a field, element, or TFD on the Output side of the map. The link between two map
components (hereafter referred to as fields) is visually represented with a line connecting
the two fields.

If you need to link two input fields to the same output field because of conditions
established in your map, you must use an extended rule.

Note
You must have at least one direct link (using the Link function) to every record or segment
on the Output side of the map, so the translator can create the record/segment.

Procedure  Use this procedure to link two fields.

Step Action
1 From the Functions menu, select Link.
2 Select a field on the Input side of the map (or TFD if the Input side is
CI).
System response
The cursor changes to a “Link Arrow™: | |1
3 Select the field on the Output side of the map (or TFD if the Output side

is CII) that the data from the field selected on the Input side of the map
is mapped to.

System response
A line connects the two fields to visually represent the link.

Note
If a line does not appear when the two fields are linked, check the
Preferences dialog box.

Reference

See How to Customize Global Display of Links on page 2 - 13 for more
information. On the Links tab of the Preferences dialog box, you should
specify “Show all links possible.”
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How to Map Binary Segments

Introduction  Certain EDI standards use binary segments and Gentran:Server enables you to create and
configure map components to process binary data.

When you load a EDI standard that contains binary segments from the Standards CD
supplied with Gentran:Server, your system automatically creates the required elements.
However, if you need to manually create binary segments, use the procedures in this topic.

Example

When you load the ANSI X12 275 transaction set into the Output side of a map, you will
notice that it contains a binary data segment with two elements—one for the length of the
binary data and one for binary data. The default data type for the length element is
“Number” and the maximum length is set to “15.” The default data type for the binary data
element is “String” and the default length is “760.”

Required segments To handle binary data received for an inbound EDI segment, you must create or configure
and elements regular segments and elements on the Input side of your map.

To generate an EDI segment containing binary data, you must create a binary data
segment on the Output side of your map. Then, you must create two elements in the binary
segment for these data types:

» Bin Len, which is for the length (in characters) of the binary segment
» Bin_ Data, which is for the binary data

This table summarizes the input and output elements of your map for binary data

Input Data Type Link Status Output Data Type
Number Not Linked Bin Len
String Linked Bin Data

Setting up the Use this procedure to create the components on the Input side of the map.

Input side
Step Action
1 On the Input side of the map, create or select a segment for the data.
2 Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box for the component.
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(Contd)
Step

Action

3

Set the component properties using the dialog box tabs.

Note
You must complete the Name tab and Looping tab.

Add a new element or field to the component you just created.

Right-click the element or field and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box for the component.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify Number as the data type.

Add a second new element or field to the segment or record.

Right-click the component and select Properties from the shortcut
menu.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify String as the data type.

Setting up the Use this procedure to create the components on the Output side of the map.

Output side

Step

Action

1

On the Output side of the map, create or select a segment or record for
the binary data.

Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box for the component.

Set the component properties using the dialog box tabs.

Note
On the Special tab, click the Binary check box.

Add a new element or field to the binary component or select the
existing element or field.
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How to Map Binary Segments

Step

Action

Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify Bin_Len as the data type.

Add a second new element or field to the segment or select the existing
element or field.

Right-click the component and select Properties from the shortcut
menu.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify Bin_data as the data type.

10

Link the components on the input side of the map to the components on
the output side of the map.

Important

You must link the string field on the input side of the map (the field
created to contain the file name of the binary data file) to the bin_data
field on the output side of the map.

11

Complete the map and compile it to create the translation object.
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How to Set the Auto-register Option

Use this procedure to set the auto-register option.

Designing your Map

The auto-register option allows you to automatically register a translation object when you

Action

From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box.

Select the Files tab.

System response
The system displays the Files preferences.

Tree I Links I Standard Formatsl Positional Default:  Files

Confimations I Wersion I

Thesze settings allow vou to zpecify the default locations for maps.

| Back up maps ta BAK files befare saving.

I Automaticall register templates after compilation.

“When browsing for maps, start in this falder :
|CAGENSRVNT \Maps

“when compiling a map. save to this folder :
IC:\GENSHVNT\TransDbi

Browse. .. |

Browse. . |

o]

Cancel | Help

Introduction
compile it.
Procedure
Step
1
2
3

Select the Automatically register template after compilation box.
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(Contd)
Step Action

4 Enter (or Browser and select) the path name for the location of the maps.
Warning
If you are on a client in a distributed environment, the path name for the
map location must be a network path on the primary server. If not, you
will receive an error when you compile.

5 Click OK to exit the dialog box.
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How to Compile a Map

Designing your Map

Introduction The Compile function compiles the map and creates a translation object. The map that you
create using Gentran:Server is a source map. When that source map is compiled, the result
is a compiled translation object.

This translation object needs to be registered with the Gentran:Server system before you
can use it. You use the Compile function after the map is completed and saved.

Procedure  Use this procedure to compile a map and generate a translation object.

Step

Action

1

From the File menu, select Compile.

System response

The system displays the Run-Time Translation Object Name dialog box.

Run-Time Translation Object Mame

Save in: Ia Tranz0hj

File name: IPET_EDFID.TF‘L

Save as hype: ITransIation Objects [*.TPL)

j Cancel |
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(Contd)
Step

Action

2

In the File name box, type the name of the translation object.

Note
The name of the translation object is 1-8 characters. Use the default
.TPL file extension.

Recommendation

Name the translation object (.TPL file) the same file name (one to eight
characters long) as you named the map (.MAP file). Preserving the same
file name (with different file extensions) means that the relationship
between the source map and the compiled translation object remains
evident.

Example
If the source map name is MWT_850.MAP, the compiled translation
object name is MWT_850.TPL.

Warning

Be very careful not to overlay the source map with the compiled
translation object. Use the .TPL file extension to distinguish the
translation object.

From the Save in list, change the drive\folder where the compiled
translation object is stored, if necessary.

Warning

Do not store the compiled translation object in the
GENSRVNT\RegTransObj folder. This folder is reserved for storing a
copy of each translation object you register with Gentran:Server.

Click Save.

System response
The system compiles the map and generate a translation object. The
system displays the Compile Error dialog box.

Verify that no errors occurred and click OK to exit the dialog box.

Note

The date that the translation object was compiled on is automatically
loaded into the “Compiled on” box on the Translation Object Details
dialog box.

From the File menu, select Save to save the source map with the
Compiled on date.

System response

If you are using the auto-register option, the map will automatically be
registered after it compiles and a confirmation dialog box will display. If
you are not using the auto-register option, continue with Step 7.
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(Contd)
Step Action
7 The translation object needs to be registered with the Gentran:Server

system before you can use it.

Reference

See How to Register a New Translation Object in the Gentran:Server
Users Guide for more information.
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How to Compile Maps Using the Command Line

Introduction

Syntax

Example 1

Example 2

The Gentran:Server Application Integration subsystem (MAPPER.EXE) enables you to
automatically compile a single map (or maps located in a specified directory) from the
command line.

Note
The compiled translation objects are written to same directory as the map source files.

The command line syntax (from the GENSRVNT\Bin subdirectory) is as follows:
mapper.exe -c [mapSourceFile]

Note

The [mapSourceFile] is either a single map or a map file name that contains a wildcard
character (*). Using the wildcard character causes MAPPER.EXE to compile all maps in

the designated directory with that file name pattern. MAPPER.EXE does not recurse
through subdirectories.

mapper.exe —c c:\GENSRVNT\tutorial\*.map

Note
In this example, all maps in the tutorial directory are compiled.

mapper.exe -c c:\GENSRVNT\tutoriall\pet*.map

Note
In this example, all maps with names beginning with “pet” in the tutorial directory are
compiled.
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How to Print a Mapping Report

Introduction The Print function enables you to print a mapping report for the current map.

Note

You can print a mapping report to a file by selecting Print to File from the File menu.
Change the defaults on the Print Options dialog box and click OK to display the Print to
File dialog box. Type the name of the file to which you want the report printed and click

OK.

Use this procedure to print a mapping report.

Step

Action

1

From the File menu, select Print.

System response
The system displays the Print Options dialog box.

Print Options

Repart sections

W Frint branching diagram
¥ Print record details ﬂl
W Frint mapping detailz
V¥ Print extended rules

¥ Print code lists

¥ Include arly active objects

» Seclect the reports that you want by clicking the appropriate check
boxes in the Report section, and

» click OK

System response
The system displays the Print dialog box.

Set the appropriate options and click OK if you do nof need to change
Setup options.

System response
The system prints the mapping report.
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Using Standard Rules Introduction

Introduction

What is a standard  The Gentran:Server Application Integration subsystem provides you with standard rules
rule? that you can apply to fields and elements. Standard rules give you access to functions that
are necessary for mapping operations that are more complex than simple linking, but less
involved than extended rules.

Each of the standard rules are mutually exclusive (you can use only one on a particular
field, element, or TFD).

Note
When an element contains a standard rule a black asterisk appears to the right of the
element icon.

Related topic Extended rules enable you to use a Gentran:Server proprietary programming language to
perform virtually any mapping operation you require.

References
See How to Create Simple Links on page 2 - 114 and Introducing Extended Rules on
page 6 - 4 for more information.
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Using the Select Standard Rule

Overview

Introduction The Select function enables you to select entries from a location table, cross-reference
table, partner table, or lookup table (all tables created in the Gentran:Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the value of the current field, element, or TFD to perform the
selection.

The Select function allows you to use information from the Gentran:Server Partner Editor
in your maps. You can map information from your partner’s profile or Internal System
Partner in the Partner Editor to a selected element or field in the map. The definition
information and location tables that you define for the internal system partner can be used
for all partners. The information that you can use includes:

» Partner or Internal System Partner Definition (Name, EDI Code, Application Code)
» Partner or Internal System Partner Location Table Fields

» Lookup Table Fields

» Cross-Reference Table Fields

» Interchange, Group, or Document Record

Standard Rule tab  This diagram illustrates the Standard Rule tab with the Select function selected.

(Select)

Mame I Validationl Positionl Estended Fule  Standard Rule I Conditionsl

Please select the standard rule to use : ISeIect j

Fleaze chooze the table and key [or group] to uze when selecting data :

| =

Elease erten the name of the suttable touse (i apprapniate] |

[~ Raize a compliance ermor if matching data iz not found

‘r'ou can map the data that was selected. Click on data in the left list then click the
fields in the right list that you would like it ko be mapped to. Repeat to map mare data.

Cancel A Help
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Overview

Parts and This table describes the parts of the Select standard rule and their functions.

functions

Part

Function

group)

table and key (or

Specifies the table and key the system uses to select data. This table
lists the valid values.

name of sub-table

Contains the sub-table name if appropriate.

Note

The sub table box is only active if you select Partner Lookup, Partner
cross-reference by my item, Partner xref by partner item, Division
lookup, Division cross-reference by my item, or Division cross-
reference by partner item from the table and key list.

Part Function

Partner by EDI code | Indicates that the key is the partner's EDI Code
and enables you to map from one of three
fields for this partner (Name, EDI Code,
Alternate Code) from the partner table.

Partner by alternate | Indicates that the key is the partner's

code Application Code and enables you to map from
one of three fields for this partner (Name, EDI
Code, Alternate Code) from the partner table.

Partner by partner Indicates that the key is the partner's Profile ID
key enables you to map from one of three fields for
this partner (Name, EDI Code, Alternate Code)
from the partner table.

Partner location by | Indicates that the name on the Locations dialog
name box (for the current partner) of the Partner
Editor is the key and enables you to map from
any field in that table.

Partner lookup Indicates that the key is the partner lookup
table name for this partner and enables you to
map from any field in that table.

Partner cross- Indicates that the key is the your item (value)

reference by my on the partner cross-reference table for this

item partner and enables you to map from any field
in that table.
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(Contd)
Part

Function

name of sub-table
(contd)

Partner cross-
reference by partner
item

Indicates that the key is the your partner's item
(value) on the partner cross-reference table for
this partner and enables you to map from any
field in that table.

Division

Enables you to map from one of three fields
(Name, EDI Code, Alternate Code) for the
<Internal System User> (system partner) in
that table.

Division location by
name

Indicates that the key is the name on the
Locations dialog box of the Partner Editor for
the <Internal System User> and enables you to
map from any field in that table.

Division lookup

Indicates that the key is the partner lookup
table name for the <Internal System User>
partner and enables you to map from any field
in that table.

Division cross-
reference by my
item

Indicates that the key is the your item (value)
on the partner cross-reference table for the
<Internal System User> partner and enables
you to map from any field in that table.

Division cross-
reference by partner
item

Indicates that the key is the your partner's item
(value) on the partner cross-reference table for
the <Internal System User> partner and

enables you to map from any field in that table.

Document record

Enables you to map from any of the fields
within the current document record.

Note

This sub-table can only be accessed from the
following map types; Transaction Break/Build,
Import, Export, Print, Screen, Group Build,
and Interchange Build.

The information that is accessed will be the
information of the last document that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.

6

Gentran:Server for Windows — August 2008

Application Integration User’s Guide




Using Standard Rules

Overview

(Contd)
Part

Function

name of sub-table
(contd)

Generic envelope
segment

Enables you to map from any of the fields
within the current envelope information,
regardless of the EDI standard used.

Note

This function is normally not used unless you
are familiar with the generic envelope table
structure for a given standard.

Interchange

Enables you to map from any of the fields
within the current interchange record.

Note

This sub-table can only be accessed from the
following map types: Interchange Break or
Build, Group Break, Transaction Break, and
Export.

The information that is accessed will be the
information of the last interchange that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.

Group

Enables you to map from any of the fields
within the current group record.

Note

Can only be accessed from the following map
types: Group Break or Build, Transaction
Break, Export, and Interchange Build.

The information that is accessed will be the
information of the last group that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.

crror

Raise compliance

Specifies whether you want the system to generate an error if the
Select does not find a valid table entry.

Note

The default is cleared (do not generate an error if the Select is not

successful).
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(Contd)
Part Function

Map from Specifies the element/field/TFD from the specified table entry from
which you want to map the contents.
Note
Entries are displayed in the map from list only after you select a table
and key.

Map to Specifies the element/field/TFD to which you want to map the

contents of the map from box.

Notes

» The system displays each element/field/TFD from the side of the
map with which you are currently working (input or output) in
this list.

» A total of eight fields can be mapped using one Select rule.

» Entries are displayed in the map to list on/y after you select a table

and key, and these entries are activated only after you highlight an
entry in the map from box.

Table access  Example 1
examples When accessing the Document table from the Interchange build map, the information
retrieved will be from the last document processed through the Transaction Build map. If
an import map updates a unique value to appfield6 for each document and the interchange
build map tries to retrieve this information, and if all documents are sent in the same
interchange, the only information retrieved in the Interchange Build map will be the
information from appfield6 for the last document sent.

To retrieve the value in appfield6 for each document, the documents must be sent in their
own interchange. This is set in the outbound partner relationship in the Interchange
Definition under advanced settings (Set Max number of documents per interchange
must be set to 1).

Example 2

When accessing the Group table from an Export map, the information retrieved will be
from the last group processed through the Group Break map. If an inbound interchange
file contained two groups: the first group contains 850 information and the second group
contains 810 information, the rule in the 850 Export map will retrieve 810 information
because the last group processed through the Group Break map was the 810 group.
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How to Use Information from the Partner Definition

Introduction The Gentran:Server Application Integration subsystem allows you to use selected
information from the Gentran:Server Partner Editor in your maps via a Select standard
rule. You can map information from your trading partner's profile in the Partner Editor to a
selected element, field, or TFD in the map. The information that you can use in the map
includes any field in a table (location, lookup, or cross-reference) or data from the partner
table.

For this example, you need to pull information from the partner definition in order to
populate the Customer Number field (CUSTNUMHDR) on the application side of the
map. Your partner’s customer number identifies which trading partner sent the purchase
order. This customer number is already part of the partner definition for this partner, so
you can map it from the partner definition to the customer number field.

Procedure  Use this procedure to use the Select function to map the customer number from the partner

definition.
Step Action

1 Double-click an existing element or field, or create a new element or
field.
Reference
See Using a Fixed-Format File on page 2 - 51 and Using an EDI File on
page 2 - 68 for more information on creating fields and elements.
System response
The system displays the Field (or Element or CII TFD) Properties dialog
box.

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose “Select.”

4 From the table and key list, select “Document record.”
Note
This indicates that the system updates this field with selected
information from the document record.

5 Select the compliance error check box to indicate that a compliance
error should be generated if the select does not find a valid entry.

6 From the map from list, choose “Partner Key.”
Note
This is the field that contains the customer number for this partner.
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(Contd)
Step

Action

7

From the map to list, choose “CUSTNUMHDR.”

Note

This is the field to which the information from the partner key of the
document record is mapped.

System response
This diagram illustrates how the Standard Rules tab should look.

Field Properties

Name I Validationl Positionl Extended Fule  Standard Rule IConditionsl

Please select the standard rule to use : ISeIect ﬂ

Fleaze choose the table and key [or group] to uze when selecting data :
I Dacument record j
Elease erten the mame of the sut-table to uee (i apprapniate] |

V¥ Raise a compliance emor if matching data is not found

‘r'ou can map the data that was zelected. Click on data in the left list then click the
fieldz in the right list that pou would like it to be mapped to. Repeat to map more data.

CUSTHUMHDR Customer Mumber
PODATEHDR Purchase Order D ate
FOMUMHDR Purchase Order Mumb
FOTYPCODE Puchase Order Type F
SHIPTOMAME Ship To Mame
SHIPTOADD Ship ToAddress Line
SHIPTDADDZ Ship Todddress Line
Control Mumber bl SHIPTOCITY Ship Ta City LI

Cancel | Al | Help |

Click OK to add the standard rule.
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How to Use Information from a Cross-reference Table

Introduction

Procedure

For this example, you need to map information from a cross-reference table to translate
your partner’s code for a purchased item into your code for the item. Your partner uses a
customer product code (CUSTPROCODE) for each item that is meaningful to him.
However, your company uses a UPC code (UPCCODE) for each item. After you and your
partner determine what the equivalent customer product code is for each UPC code, you
can create a cross-reference table in Partner Editor and use that information in your map.

A cross-reference table is used when you and your partner each reference an item by a
different name (or number). For example, if your unique name for a “widget” is “wid” and
your partner’s unique name for the same “widget” is “1234.” The system uses the cross-
reference table to translate the two names for the “widget” item.

In this example, you have one code (UPC code) for each item ordered. Your partner refers
to the same item by a different code (customer product code). You need to map the
customer product code from the Product/Service ID element to the customer product code
field (CUSTPROCODE) on the application side of the map. Also, you must create a cross-
reference table to translate the customer product code to your UPC code.

Tip

Before you create the cross-reference table, you and your partner must determine what the
equivalent customer product code is for each UPC code. Then you can create the cross-
reference table in Partner Editor and use that information in your map.

Finally, you need to use a standard rule to map the translated value from the

CUSTPROCODE field to the UPCCODE field.

Use this procedure to translate your partner’s customer product code to your UPC Code
for each item your partner ordered.

Step Action
1 Map the customer product code from the Product/Service ID element to
your CUSTPROCODE field.
Reference

See How to Create Simple Links on page 2 - 114 for more information.
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(Contd)
Step Action

2 In the Partner Editor, create a cross-reference table named
“PRODCODE.”

Reference
See How to Create a Table in the Gentran.Server User s Guide for more
information on creating a cross-reference table.

Notes

» The cross-reference table you create only contains six entries. This
is an example — an actual table would contain all of the items
manufactured by your company that your partner purchases.

» Inthe cross-reference table, the “My Value” box contains your UPC
code for the item. The “Partner Value” box contains your partner’s
customer product code for the item. The “Description” box contains
a description (and size, if applicable) of the item, and the Reference
Data box contains additional quantity or color information.

3 Double-click the CUSTPROCODE field.

System response
The system displays the Field Properties dialog box.

4 Select the Standard Rule tab to access standard rule options.

5 From the standard rule list, choose “Select.”

6 From the table and key, select “Partner cross-reference by partner item.”

Note
This indicates that you are using a cross-reference table and translating
by your partner’s item.

7 In the sub table box, type “PRODCODE.”

Note
This is the name of the cross-reference table you created.

8 Select the compliance error check box to signal the system that if this
translation fails, you want the system to generate an error.

9 From the map from list, choose “My Item.”

Note
This is the field from which the contents is mapped.
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How to Use Information from a Cross-reference Table

(Contd)
Step

Action

10

From the map to list, choose “UPCCODE.”

Note
This is the field to which the information from the lookup table is

mapped.

System response
This diagram illustrates how the Standard Rule tab should look.

Field Properties

M ame I Validationl F'ositionl Extended Rule  Standard Rule | Eonditionsl

Please select the standard rule to use : ISeIect j

Please chooze the table and key [or group] to uze when selecting data :

IF'artner crosseference by partner item j
Pleaze enter the name of the sub-table ta uze [if appropriate] :

IPHDDEDDE

V¥ Raise a compliance emor if matching data iz not found

*f'ou can map the data that waz selected. Click on data in the left list then click the
fields in the right lizt that wou would like it to be mapped to. Repeat to map more data.

CUSTHUMDET Customer Nurnber

Partrier Item PODATEDET Purchase Order Date
Description POMUMDET Purchase Order Mumber
Teut1 CUSTPROCODE Customer Product Coc
Teut 2 |JPCCODE LJPC Code

Text 3 U0M Unit of Measure

Text 4 UMITPR Unit Price

ATYORD Quantity Ordered

Cancel Annly Help
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How to Use Information from Location Tables

Introduction Each Partner Profile and the Internal System Partner Profile can have many associated
location tables. The location table can be used to contain address-related information
about the partner. You can store your partner’s store addresses, warchouse addresses, or
“invoice to” addresses.

To use information from a location table, you must have created that table already in the

Partner Editor. See How to Create a Table in the Gentran:Server User s Guide for more
information on creating a partner location table.

Procedure  Use this procedure to map information from a location table.

Step Action
1 Double-click an existing element or field, or create a new element or
field.
Reference

See Using a Fixed-Format File on page 2 - 51 and Using an EDI File on
page 2 - 68 for more information on creating fields and elements.

System response
The system displays the Field (or Element or CII TFD) Properties dialog

box.
2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose “Select.”
4 From the table list, select the key that is used to look up the Partner

Location entry.

Note
You are allowed to map from any field on the Locations dialog box.
Valid selections are:

» Partner location by name

» Division location by name

5 If you want the system to generate an error if the lookup fails, select the
compliance error check box.
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(Contd)
Step Action

6 From the map from list, select the field from which the contents are
mapped.
Note
You can select from the following fields: Name, Address 1, Address 2,
Address 3, City, State, Zip, Country, Telephone Number, Fax Number,
Contact Name, Primary Reference, Secondary Reference.

7 From the map to list, select the element, field, or TFD to which the
information from the Partner Editor is mapped.

8 Click OK to add the standard rule.
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How to Use Information from Lookup Tables

Introduction A lookup table is used to select information related to a value in inbound or outbound data.
Each partner profile and the internal system partner profile can have many lookup tables
associated with it.

To use information from a lookup table, you must have created that table already in the
Partner Editor. See How to Create a Table in the Gentran:Server Users Guide for more
information on creating Partner lookup tables.

Procedure  Use this procedure to map information from a Lookup Table.

Step

Action

1

Double-click an existing element or field, or create a new element or
field.

Reference
See Using a Fixed-Format File on page 2 - 51 and Using an EDI File on
page 2 - 68 for more information on creating fields and elements.

System response
The system displays the Field (or Element or CII TFD) Properties dialog
box.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, choose “Select.”

From the table list, select the key from which the system looks up the
trading partner.

Note
Valid selections are:

» Partner lookup

» Division lookup

In the sub table box, type the name of the lookup table.

If you want the system to generate an error if the lookup fails, select the
compliance error check box.

From the map from list, select the field (Item, Description, Text 1, Text
2, Text 3, Text 4) from which the contents are mapped.

From the map to list, select the element, field, or TFD to which the
information from the Partner Editor is mapped.

Click OK to add the standard rule.
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Using the Update Standard Rule

Overview

Introduction The Update function enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format type is
EDI), with the contents of the element, field, or TFD.

Warning

This function updates the internal Gentran:Server database tables. We recommend that
you use this function only if you want to update the internal database tables. Typically, you
use this function only if you want to update the document name and reference in the
document table.

Standard Rule tab  This diagram illustrates the Standard Rule tab with the Update function selected.

(Update) ! !
Field Properties
Mame I ‘v"alidationl Positionl Estended Fule ~ Standard Rule | Conditionsl

Fleaze zelect the standard rule to uze : IUpdate ﬂ

Fleaze select the table [or group] to update

| =]
Pleaze select the colurmn [or field] to update :

Cancel Help
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Parts and This table describes the parts of the Update standard rule and their functions.

functions

Part

Function

table

Contains the table that the system updates with the contents of the
current field/element/TFD. Valid values are:

See Table access examples on page 3 - 8 for examples.

Document record (use to update the document name and
reference.

Note

This stable can only be accessed from the following map
types; Transaction Break/Build, Import, Export, Print,
Screen, Group Build, and Interchange Build.

The information that is accessed will be the information of
the last document that was processed at the table level
accessed by the rules. This must be taken into consideration
when using rules that access these tables.

Generic envelope segment (advanced use only)

Interchange

Note

This sub-table can only be accessed from the following map
types: Interchange Break or Build, Group Break, Transaction
Break, and Export.

The information that is accessed will be the information of
the last interchange that was processed at the table level
accessed by the rules. This must be taken into consideration
when using rules that access these tables.

Group

Note
Can only be accessed from the following map types: Group
Break or Build, Transaction Break, Export, and Interchange
Build.

The information that is accessed will be the information of
the last group that was processed at the table level accessed
by the rules. This must be taken into consideration when
using rules that access these tables.

Partner (advanced use only)

Document (advanced use only - if the format type of this side
of the map is EDI)

column

Contains the database field from the column (or field) list that the
system updates with the contents of the current field/element.

Note
The fields that are available in this list depend on the table
selected.
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How to Set Up the Document Name and Reference

Introduction

Procedure: setting
up the document
name

The Document Name and Reference are two recommended fields that you can specify in
the Application Integration subsystem. For an Invoice this field is typically the Invoice
Number, and for a Purchase Order this field is typically the Purchase Order Number. If
you specify either the Document Name or Reference, the corresponding field in
Gentran:Server document browsers (In Documents, ?In Documents, Out Documents, ?Out
Documents, Workspace, In Drawer, Out Drawer, Send Queue, Interchanges) is populated.
The Document Name and Reference makes the identification of a document created by the
map easier in Gentran:Server.

Setting up the Document Name is strongly recommended if you want to be able to
differentiate between documents in the document browsers in Gentran:Server. If you set
up the Document Name in the Application Integration subsystem, the Name box of the
document browsers that contain this document in Gentran:Server contains the data from
that mapped field. If you set up the Reference in the Application Integration subsystem,
the RefData box of the document browsers that contain this document in Gentran:Server
contains the data from that mapped field.

You can select any element as the Document Name, but we strongly recommend that you
choose an element that only occurs once in the map. The element that you select should
have a data type of “string” (data type is specified on the Element Properties dialog box).
If you need to use an element with a data type of Date/Time or Number for the Document
Name or Reference, you can either:

» Change the data type to “String” on the Element Properties dialog box.

» Setup an extended rule to update the document record.

Warning
If you change a Date/Time or Number element’s data type to “String,” you lose the data
type compliance checking for the original type.

Use this procedure to set up the Document Name.

Step Action

1 Select a non-recurring element from the header or trailer segment of the
EDI side of the document.

Note

The element that you select varies for each type of document. The
selected element should be something that identifies this document
meaningfully in Gentran:Server.

Example
» For an Invoice this is typically the Invoice Number.

» For a Purchase Order this is typically the Purchase Order Number.
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(Contd)
Step Action

2 Right-click the appropriate element and select Properties from the
shortcut menu.
System response
The system displays the Element Properties dialog box (Name tab).

3 Select the Standard Rule tab to access the standard rule options.

4 From the standard rule list, select “Update.”

5 From the table to update list, select “Document record.”

6 From the column to update list, select “Document Name.”

7 Click OK to set up the Document Name.

Procedure: setting  Use this procedure to set up the Reference.
up the reference

Step Action
1 Select an element from the first segment of the EDI side of the
document.
Note

The element that you select varies for each type of document. The
selected element should be something that identifies this document
meaningfully in Gentran:Server

Example
» Foran Invoice this is typically the Purchase Order Number.
» For a Purchase Order this is typically the Purchase Order Date.

However, to use Purchase Order Date, you must use an extended
rule on that element, instead of following the steps below.

2 Right-click the appropriate element and select Properties from the
shortcut menu.

System response
The system displays the Element Properties dialog box (Name tab).

3 Select the Standard Rule tab to access the standard rule options.
4 From the standard rule list, select “Update.”

5 From the table to update list, select “Document record.”

6 From the column to update list, select “Reference Data.”

7 Click OK to set up the Reference.
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Using the System Variable Standard Rule

Overview

Introduction

Standard Rule tab
(System Variable)

Standard rule tab
(System Variable)
parts and
functions

The Use System Variable function enables you to set a variable that maps the current date
and time to the selected element, field, or TFD. The selected map component must have a

data type of “Date/Time.”

This diagram illustrates the Standard Rule tab with the System Variable function selected.

Field Properties

Mame I Validationl F'ositionl Extended Fule  Standard Rule | Eonditionsl
Fleaze select the standard rule to use : IUse System Variable j

Flease select a spstem variable to store in this field

Cancel Sl Help

This table describes the parts of the System Variable standard rule and their functions.

Part

Function

System variable

Allows you to map “Current date and time” variables to
the element, field, or TFD.
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How to Use the System Date and Time

Procedure  Use this procedure to use the system date and time.

Step

Action

1

Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a CII File on page 2 - 89 for more information on
creating fields, elements, and TFDs.

System response
The system displays the Field (or Element or CII TFD) Properties dialog
box.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use System Variable.”

Select “Current date and time” from the system variable list to map
those variables to the element, field, or TFD.

Click OK to set up the system variable.
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Using the Use Constant Standard Rule

Overview

Introduction

Why constants are
used

The Use Constant function enables you to move a literal constant value to the specified
element, field, or TFD and indicate a qualifying relationship with another element, field,
or TFD.

Constants are used in maps to hold information that is needed later in the map, either to be
moved to an output field or used in a conditional statement. Typically, constants are used
to move a literal constant value to the specified element, field, or TFD on an inbound map.
Outbound EDI qualifiers are typically generated from constants (to indicate a qualifying
relationship with another element or field).

Literal constants are used by the system as a repository to store information that is used
later in the map. Typically, constants are used to load common data into each application
record on a map. You create the literal constant and name it. You can “hard code” (enter) a
value that is loaded into the element, field, or TFD that uses the constant. However, to use
a constant (the information that is stored in it), you need to use an standard rule, as
explained below.

For an inbound map, constants are typically used to define the record types. For an
outbound map, constants are typically used to define qualifying relationships.

A qualifying relationship establishes a relationship between an element and its qualifier. A
qualifier contains a code that further defines the element. Qualifying relationships are
typically defined in outbound maps.
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Standard Rule tab  This diagram illustrates the Standard Rule tab with Use Constant selected.
(Use Constant)

Element Properties x|

Mame | Validationl Hepeatl Extended Rule  Standard Rule | Conditionsl

Please select the standard rule to use: Usze Constant j

Please select a constant o stare in this fisld :
| x| Edi. |

If thiz constant iz a qualifier for another field, the translator can automatically use the
exiztence of data in that field to determine whether to execute this standard nule. To
take advantage of thiz feature, simply select the field to be qualified ;

=l

(1]4 I Cancel | Help |

Standard rule tab  This table lists the parts of the Standard Rule tab (with the Use Constant standard rule
(Use Constant)  selected) and their functions.

parts and
functions Part Function

constant Lists the available constants. The selected constant is mapped to
the current element, field, or TFD.

Note

If the necessary constant is not present in the constant list, you
need to create it by using the Map Constants dialog box, which
you can access by clicking Edit.

Edit Access the Map Constants dialog box, which allows you to
create, edit, and delete literal constants.

qualifier Lists the elements, fields, or TFDs that you can use to qualify the
selected map component to establish a qualifying relationship
between the two map components.

Note
If the qualified element is not generated because of a lack of data,
the constant is not moved to the current element, field, or TFD.
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Map Constants
dialog box

Map Constants
dialog box parts
and functions

Edit Constant
dialog box

Map Constants

D

Type “alue

Overview

This diagram illustrates the Map Constants dialog box.

Sub Table 1

String PRODCODE

Change... |
Delste |

This table lists the parts of the Map Constants dialog box and their functions.

Part

Function

Constants list

Contains a list of all literal constants currently defined in the
system.

Close Exits the Map Constants dialog box.

New Access the Edit Constant dialog box, which allow you to create a
new constant.

Edit Access the Edit Constant dialog box, which allows you to edit the
selected constant.

Delete Removes the selected constant from the system.

This diagram illustrates the Edit Constant dialog box.

Edit Constant

1D

Walue

Application Integration User’s Guide

Gentran:Server for Windows — August 2008 (



Overview Using Standard Rules

Edit Constant  This table lists the parts of the Edit Constant dialog box and their functions.
dialog box parts
and functions Part Function

1D Contains the literal constant identifier.

Note

This is typically a description of the field or element in which the
constant is used. If you need to refer to the constant in an
extended rule, you should use the data from this field.

Type Specifies the category of this literal constant. Valid selections
are:

» Integer (sclect for numeric constants that are a positive or
negative natural (non-fraction) number or “0” (zero)

» Real (select for numeric constants that are a positive or
negative integer with an explicit decimal point)

» String (select for alphanumeric constants)

Value Specifies the actual constant expression.

Note
This is the value of the literal constant.
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How to Use a Constant in a Map

Procedure  Use this procedure to use a constant in your map..

Step

Action

1

Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a CII File on page 2 - 89 for more information on
creating fields, elements, and TFDs.

System response
The system displays the Field (or Element or CII TFD) Properties dialog
box (Name tab).

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.

Do you need to create or edit a constant to use for the current element,
field, or TFD?

» Ifyes, click Edit to access the Map Constants dialog box.

Reference
See How to Define and Edit Literal Constants on page 3 - 30 for
more information on creating and editing constants.

» Ifno, continue with the next step.

From the constants list, select the constant that you want to map to the
current element, field, or TFD.

Do you want to establish a qualifying relationship between the current
map component and another component?

» Ifyes, from the qualifies list, select the element, field, or TFD that
the system uses to determine whether to execute this standard rule
(if the qualifying component contains data).

» Ifno, continue with the next step.

Click OK to save the standard rule and exit the Properties dialog box.
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How to Define a Qualifying Relationship

Introduction Literal constants are used by the system as a repository to store information that is used at
a later point in the map. Typically, constants are used in an outbound map to generate a
qualifier. A qualifier is an element that has a value expressed as a code that gives a specific
meaning to the function of another element. A qualifying relationship is the interaction
between an element and its qualifier. The function of the element changes depending on
which code the qualifier contains.

In this example, you use a constant to define a qualifier for a Product/Service ID.

Procedure  Use this procedure to define a qualifying relationship.

Step

Action

1

Double-click the Product/Service ID Qualifier that you want to use to
further define (qualify) the Product/Service ID.

System response
The system displays the Element Properties dialog box (Name tab).

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

Click Edit.

System response
The system displays the Map Constants dialog box.

Click New.

System response
The system displays the Edit Constant dialog box.

In the ID box, type the literal constant identifier.

Note

This is typically a description of the field or element in which the
constant is used. If you need to refer to the constant in an extended rule,
you should use the data from this box.

From the Type list, select String.

Note
The Product/Service ID Qualifier is formatted as a string data type. This
indicates the category of the literal constant.
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Using Standard Rules How to Define a Qualifying Relationship

(Contd)
Step Action

8 In the Value box, type “UI”.
Note
This indicates that the Product/Service ID field must contain the UPC
Code. This is the value of the literal constant.

9 Click OK to add the constant to the system.

10 Click Close to exit the Map Constants dialog box.

11 From the qualifies list, select Product/Service ID. This is the element
that the Product/Service ID Qualifier qualifies.
Note
This list contains only the other active fields or elements in the same
record or segment as the qualifying field.

12 Click OK on the Element Properties dialog box and the qualifying
relationship between the two elements is established.
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How to Define and Edit Literal Constants

Procedure  Use this procedure to create or edit a literal constant so you can use it to store information.

Step Action

1 From the Edit menu, select Constants.

System response
The system displays the Map Constants dialog box.

2 Do you want to create a new constant?

» Ifyes, click New.

» Ifno (you want to edit an existing constant), select the constant and
click Edit.

System response
The system displays the Edit Constant dialog box.

3 In the ID field, type the literal constant identifier.

4 From the Type list, select the category of this literal constant.
5 In the Value field, type the actual constant expression.

6 Click OK to add the constant to the system.

7 Click Close to exit the Map Constants dialog box.
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How to Delete Literal Constants

Procedure  Use this procedure to delete a literal constant.

Step Action

1 From the Edit menu, select Constants.

System response
The system displays the Map Constants dialog box.

2 Select the constant you want to delete.

3 Click Delete.

System response
The system removes the constant without warning.
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How to Map Literal Constants

Procedure  Use this procedure to map a constant in which you previously stored information using an

extended rule.
Step Action

1 Double-click the element, field, or TFD in which you want to use the
constant.
System response
The system displays the Field (or Element or CII TFD) Properties dialog
box.

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, select “Use Constant.”

4 From the constant list, select the constant that you want to use.

5 Click OK.
System response
The data that was stored in the selected constant is loaded in the
element, field, or TFD.
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How to Generate Qualifiers

How to Generate Qualifiers

Introduction A qualifier is an typically an element that has a value expressed as a code that gives a
specific meaning to the function of another element. A qualifying relationship is the
interaction between an element and its qualifier. The function of the element changes
depending on which code the qualifier contains.

Procedure  Use this procedure to define qualifying relationships.

Step

Action

1

Double-click the element you want to use to further define (qualify)
another element.

System response
The system displays the Element Properties dialog box.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

From the qualifies list, select the element that this element qualifies.

Note
This list contains only the other active elements in the same record or
segment as the qualifying element.

Click OK.

System response
The system establishes the qualifying relationship between the two
elements.
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Using Standard Rules

Using the Loop Count Standard Rule

Overview

Introduction

Standard Rule tab
(Loop Count)

Standard rule tab
(Loop Count)
parts and
functions

The Loop Count function enables you to count the number of times a loop is repeated, if
the element, field, or TFD is part of a loop. If the loop is a nested loop, you can track the
current loop or the outer loop. For example, if the Y loop is nested within the X loop, and
the Y loop has cycled through 15 iterations and the X loop has cycled through 3 iterations,
you can choose to count either the “15” (Y loop) or the “3” (X loop).

This diagram illustrates the Standard Rule tab with Loop Count selected.

Element Properties
Name | Walidation | Estended Rule ~ Standard Rule | Conditions |
Fleaze select the standard rule to uze : ILoop Count j
Pleaze select a group to count :
| =l
Cancel Al Help

This table lists the parts of the Standard Rule tab (with the Loop Count standard rule
selected) and their functions.

Part Function

group Contains the loop that you want to count.

Note
If the loop is a nested loop, you can track the current loop or the
outer loop.

Example

If the Y loop is nested within the X loop, and the Y loop has
cycled through 15 iterations and the X loop has cycled through 3
iterations, you can choose to count either the “15” (Y loop) or the
“3” (X loop).
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How to Use the Loop Count Function

How to Use the Loop Count Function

Procedure  Use this procedure to use the Loop Count function.

Step

Action

1

Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a CII File on page 2 - 89 for more information on
creating fields, elements, and TFDs).

System response
The system displays the Field (or Element or CII TFD) Properties dialog
box.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Loop Count.”

Select the loop that you want to count.

Click OK to add the standard rule.
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Using the Use Accumulator Standard Rule

Overview

Introduction

Standard Rule tab
(Use Accumulator)

The Use Accumulator function gives you access to a set of numeric variables that you can
manipulate via numeric operations, and then transfer to and from fields. This function
enables you to add, change, or delete calculations for the element, field, or TFD, including
hash totals (used to accumulate numeric field values, i.e., quantity, price, etc.). This
function also enables you to map the accumulated total into a control total field, and use
accumulators. Accumulators are used generally for counting the occurrences of a specific
element or generating increasing or sequential record or line item numbers.

Notes

Accumulators are global variables.
Accumulators are set to zero prior to being used in calculations.

The order in which accumulator operations are performed depends on the hierarchical
order of the map components.

This diagram illustrates the Standard Rule tab with Use Accumulator selected.

Element Froperties

Mame I Validationl Extended Fule  Standard Rule IEonditionsl

Please select the standard rule to use : IUse Accumulator j

Frimary &ccumulator Op1 Op2 0Op3d Opd

MNew...
Change...

Delete

i

Cancel Sl Help

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
{ g pp g



Using Standard Rules Overview

Standard rule tab  This table lists the parts of the Standard Rule tab (with the Use Accumulator standard rule
(Use Accumulator) selected) and their functions.

parts and

functions Part Function
Primary Contains all existing calculations that were created for this
accumulator element, field, or TFD.
New Accesses the Edit Accumulator Entry dialog box to create a new

calculation for this element, field, or TFD.

Change Highlight a calculation in the Primary Accumulator list and click
this to access the Edit Accumulator Entry dialog box to edit the
selected calculation.

Delete Highlight a calculation in the Primary Accumulator list and click
this to delete the selected calculation.

Warning
The selected calculation is deleted without warning.

Edit Accumulator  This diagram illustrates the Edit Accumulator Entry dialog box.

Entry dialog box oy
Primary Sccurlsto | H Hama |
e alicre
Frsl | [2] Htemate tozum | [=]
Sezand | [
Thd | 1]
Foulh | [
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Edit Accumulator
Entry dialog box
parts and
functions

Using Standard Rules

This table lists the parts of the Edit Accumulator Entry dialog box and their functions.

Part Function
Primary Specifies the primary accumulator.
accumulator

Notes

» Before any calculations are performed on an accumulator, its
content is “0” (zero). When you use an accumulator, the
system adds a new accumulator to the bottom of this list.

» There is only one set of accumulators for each map. This
means that accumulator “0,” whether it is used in the
Primary Accumulator or Alternate Accum box is the same
accumulator with the same contents. If you assign
calculations to accumulator “0” at the beginning of the map
and then use accumulator “0” again later in the map, the
content of that accumulator is the result of the earlier
calculation. Any additional calculations you assign to that
accumulator are performed on the contents resulting from an
earlier calculation.

Name Contains a descriptive alias that enables you to differentiate what
the accumulators you create are used for.
First Specifies the first operation that the system performs.

Notes

» The First box is active only after you select a Primary
Accumulator.

» Before any calculations are performed on an accumulator, its
content is “0” (zero). When you use an accumulator, the
system adds a new accumulator to the bottom of this list.

Reference

See Accumulator operations on page 3 - 39 for more

information.

Second Specifies the second operation that the system performs, after the

First operation is completed.

Note
The Second box is active only after you select a First operation
that does not involve the Alternate Accum.

Reference
See Accumulator operations on page 3 - 39 for more
information.
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Overview

(Contd)
Part

Function

Third

Specifies the third operation that the system performs, after the
Second operation is complete.

Note
The Third box is active only after you select a Second operation.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Fourth

Specifies the fourth operation that the system performs, after the
Third operation is complete

Note
The Fourth box is active only after you select a Third operation.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Alternate Accum

Specifies an alternate accumulator that participates in the
accumulator operation.

Note
The Alternate Accum box is only active if you select an operation
from the First field that involves an alternate operand.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Accumulator This table lists the available accumulator operations and their functions.

operations

Part

Function

Increment primary

Adds “1” (one) to the contents of the Primary Accumulator (i.e.,
Primary = Primary + 1).

Decrement primary

Subtracts “1” (one) from the contents of the Primary
Accumulator (i.e., Primary = Primary - 1).

Sum in primary

Adds the numeric value (takes the positive or negative sign of the
numbers into account) of the field to the contents of the Primary
Accumulator (i.e., Primary = (+/-)Primary + (+/-)Field).
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(Contd)
Part Function

Hash sum in Adds the absolute value (does not take the positive or negative

primary sign of the numbers into account) of the field to the contents of
the Primary Accumulator (i.e., Primary = Primary + Field).

Load primary Loads the contents of the field into the Primary Accumulator
(i.e., Primary = Field).

Use primary Loads the contents of the Primary Accumulator into the field

(i.e., Field = Primary).

Zero primary

Sets the value of the Primary Accumulator to zero (i.e., Primary
=0).

Multiply with Multiplies the field with the contents of the Primary

primary Accumulator, and stores the result in the Primary Accumulator
(i.e., Primary = Primary * Field).

Divide by primary | Divides the field with the contents of the Primary Accumulator,
and stores the result in the Primary Accumulator (i.e., Primary =
Field / Primary).

Divide primary by | Divides the contents of the Primary Accumulator with the field,

field and stores the result in the Primary Accumulator (i.e., Primary =
Primary / Field).

Modulo with Divides the contents of the Primary Accumulator with the

primary contents of the field, and stores the remainder of that operation in
the Primary Accumulator (i.e., Primary = Field % Primary).

Modulo with field | Divides the contents of the field with the contents of the Primary
Accumulator, and stores the remainder of that operation in the
Primary Accumulator (i.e., Primary = Primary % Field).

Negate primary Makes the contents of the Primary Accumulator negative (i.e.,

Primary = Primary * -1).

Note
The only way to subtract the Primary Accumulator from the field
is to “Negate” the Primary Accumulator and then use the “Sum in

primary” operation to add the negative Primary Accumulator to
the field.

Move primary to

Copies the contents of the Primary Accumulator to the Alternate

alternate Accum. This overwrites the current contents of the Alternate
Accum field (i.e., Alternate = Primary).

Add primary to Adds the contents of the Primary Accumulator to the contents of

alternate the Alternate Accum, and stores the result in the Primary

Accumulator (i.e., Primary = Primary + Alternate).
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Part

Function

Multiply primary
by alternate

Multiplies the contents of the Primary Accumulator with the
contents of the Alternate Accum, and stores the result in the
Primary Accumulator (i.e., Primary = Primary * Alternate).

Divide primary by
alternate

Divides the contents of the Primary Accumulator with the
contents of the Alternate Accum, and stores the result in the
Primary Accumulator (i.e., Primary = Primary / Alternate).

Modulo primary
with alternate

Divides the contents of the Primary Accumulator with the
contents of the Alternate Accum, and stores the remainder of that
operation in the Primary Accumulator (i.e., Primary = Primary %
Alternate).
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How to Count Line Items

Introduction In this example, you want an incremental count of the number of line items, and you want
to use that total value in the Number of Line Items Total field.

Procedure  Use this procedure to count line items and generate a control total for an outbound ANSI

X12 purchase order.
Step Action
1 Double-click the PO101 element (in the PO1 segment in the PO1 group).
Note

This is the element that you typically use to count the line items.

System response
The system displays the Element Properties dialog box.

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “0.”

Note

There is only one set of accumulators for each map. This means that
accumulator “0,” whether it is used in the Primary Accumulator or
Alternate Accum box is the same accumulator with the same contents. If
you assign calculations to accumulator “0” at the beginning of the map
and then use accumulator “0” again later in the map, the content of that
accumulator is the result of the earlier calculation. Any additional
calculations you assign to that accumulator are performed on the
contents resulting from an earlier calculation.

6 In the Name box, type “Line Item Number.”

Note
This is a descriptive alias that enables you to differentiate what the
accumulators you create are used for.

7 From the First list, select Increment Primary. This is the first operation
that the system performs. This specifies that the system will increment
the PO101 element by one.
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How to Count Line Items

(Contd)
Step

Action

8

From the Second list, select “Use primary.”

Note

This is the second operation that the system performs, after the First
operation is completed. This specifies that the system loads the current
value of the accumulator into the PO101 (Assigned Identification)
element.

Click OK to add the accumulator.

10

Click OK on the Element Properties dialog box to add the standard rule
to the PO101 element.

11

Double-click the CTTO1 element (in the CTT segment).

Note
This is the element that typically contains the total number of line items.

System response
The system displays the Element Properties dialog box.

12

Select the Standard Rule tab to access standard rule options.

13

From the standard rule list, select “Use Accumulator.”

14

Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

15

From the Primary Accumulator list, select primary accumulator “0.”

Note
This accumulator currently contains the total number of line items.
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(Contd)
Step Action

16 From the First list, select “Use primary.”

Note
This specifies that the system loads the current value of the accumulator
into the CTTO1 (Number of Line Items Total) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Piiman: #ccuruisor [0 [2] hama ILireIha'nNu'nl:e( | i |

Firsl Uze prmaw Bllemabe Acoum

Sezond I :I
Thind | .
Fouh | |

17 Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Froperties

Mame I Validationl Extended Rule  Standard Rule IEonditionsl

Flease select the standard rule to use : IUse Acoumnulator j

Frimary Accumulator Op1 Op2 0Op3d Opd

O-Ling Item Mumbsr [ New...

Change...

Delete

i

0k I Cancel I ] | Help |

18 Click OK on the Element Properties dialog box to add the standard rule
to the CTTO1 element.

Note
The CTTO1 element now contains the total number of line items in the
purchase order.
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How to Calculate Hash Totals

Introduction In this example, you want to count the quantity ordered for each line item and load the
total quantity in the CTT02 (Hash Total) element.

Procedure  Use this procedure to count the quantity ordered and generate a hash total for an outbound

ANSI X12 purchase order.
Step Action
1 Double-click the PO102 element (in the PO1 segment in the PO1 group).
Note

This is the element that you typically use to count the line items.

System response
The system displays the Element Properties dialog box.

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “1.”

6 In the Name box, type “Total Quantity.”

7 From the First list, select Hash Sum in Primary.
Note

This is the first operation that the system performs. This specifies that
the system will add the numeric value of the PO102 element to the
contents of the Primary Accumulator.

8 Click OK to add the accumulator.

9 Click OK on the Element Properties dialog box to add the standard rule
to the PO102 element.
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(Contd)
Step Action

10 Double-click the CTT02 element (in the CTT segment).
Note
This is the element that typically contains the total quantity of the
purchase order.
System response
The system displays the Element Properties dialog box.

11 Select the Standard Rule tab to access standard rule options.

12 From the standard rule list, select “Use Accumulator.”

13 Click New.
System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14 From the Primary Accumulator list, select primary accumulator “1.”
Note
This accumulator currently contains the total quantity.

15 From the First list, select “Use primary.”

Note
This operation specifies that the system loads the current value of the
accumulator into the CTT02 (Hash Total) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should

look.

Edil Al Entis

Piinar frcunulsioe |1 [2]  Hame [Tornl Guarsiy ]
[ Cancel
Firt  [Uss prima [ )] Anemizte dcoum| [#]
Secend | B
Thed | B
Fouth | [E3)
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How to Calculate Hash Totals

(Contd)
Step

Action

16

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Froperties

M ame I Validationl Extended Rule  Standard Rule | Eonditionsl

Please select the standard rule to use : IUse Accumulator j
Frimary Accumulator Opl 0Op2 Op3 Opd
1-Tatal Quantity Use Mew. ..

Change...

Delete

i

Cancel I Sl | Help I

17

Click OK on the Element Properties dialog box to add the standard rule
to the CTTO2 element.

Note
The CTTO02 element now contains the total quantity of the purchase
order.
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How to Reset and Calculate a Value Total

Introduction In this example, you want to multiply the quantity invoiced for each line item by the unit
price to obtain the extended price. Then, you want to generate a running total of extended
price and load the final total into the TDSO01 (Total Invoice Amount) element.

Procedure: Use this procedure to multiply the quantity invoiced for each line item by the unit price to

multiplying obtain the extended price for an outbound ANSI X12 invoice.
quantity invoiced
by unit price

Step Action

1 Double-click the IT102 element (in the IT1 segment in the IT1 group).

Note
This is the element that you typically use to count the quantity invoiced.

System response
The system displays the Element Properties dialog box.

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “2.”

6 In the Name box, type “Extended Price.”
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How to Reset and Calculate a Value Total

(Contd)
Step

Action

7

From the First list, select “Load primary.”

Note
This operation specifies that the system loads the contents of the element
into the Primary Accumulator for each iteration of the IT1 group.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Fiman Acaurmlatee |2 [] Mama [Extanded Frize |
pecalicrs [ ot |
Firel ILoad primaly H Nlemabaﬁccl,ml M
Secand | [2]

Thrd | 2]

Foulh | B

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Properties E

Mame I \.-"alidationl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule to use IUse Accumulator j
PFrimary Accuniulator Op1 0Op2 0Op3 O0Opd
2-Eutended Price Load Mew...

Change... |
Delete |

Cancel | Lopni I Help |

Click OK on the Element Properties dialog box to add the standard rule
to the IT102 element.
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(Contd)
Step Action

10 Double-click the IT104 element (in the IT1 segment in the IT1 group).
Note
This is the element that contains the unit price for each line item.
System response
The system displays the Element Properties dialog box.

11 Select the Standard Rule tab to access standard rule options.

12 From the standard rule list, select “Use Accumulator.”

13 Click New.
System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14 From the Primary Accumulator list, select primary accumulator “2.”

15 From the First list, select “Multiply with primary.”

Note

This operation specifies that the system multiplies the value of the IT104
(Unit Price) element with the contents of the primary accumulator, and
store the result in the primary accumulator for each iteration of the IT1

group.

System response
This diagram illustrates how the Edit Accumulator dialog box should

look.
Piiman &caumulster |2 [2] Hawa IExhandedF'rice | il |
peralicer: [ Cancet |
Firel IMLiIipiywthprimaru MNIemamﬁccwl |ﬁ|
sesond | g
Thd | E|
Fouh | E|
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How to Reset and Calculate a Value Total

(Contd)
Step

Action

16

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Froperties %]

Warme I Validationl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule to use : IUse Accumnulator j
Frimary Accumulator Op1 DOp2 0Op3 Opd
2-Estended Price kLt Mew...

Change...

Delete

i

Cancel | Al I Help |

17

Click OK on the Element Properties dialog box to add the standard rule
to the IT104 element.

Tip

If there is an extended price element in your EDI file, you could load the
total from the extended price calculation into that element. To do this,

you need to use an accumulator on that extended price element that
specifies “Use primary” for accumulator 2.
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How to Reset and Calculate a Value Total

Procedure:
generating a
running total of
extended price

Using Standard Rules

Use this procedure to generate a running total of the extended price.

Step Action
1 Double-click the IT104 element (in the IT1 segment in the IT1 group).
Note
This is the element that contains the unit price for each line item.
System response
You already established one accumulator that the system displays in the
list on the Standard Rule tab.
Element Properties
Mame I Validationl Exterded Fule  Standard Rule I Eonditionsl
Please select the standard rule to use : IUse Accumulatar j
Primary Accumulatar Op1 0Op2 0Op3 0Opd
2-Extended Price Mt Mew...
Change... |
Delete |
Cancel Aol Help
2 Click New.
System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.
3 From the Primary Accumulator list, select “3”.
4 In the Name box, type “Running Total.”
5 From the First list, select “Add primary to alternate.”

Note

This operation specifies that the system adds the contents of the primary
accumulator to the contents of the alternate accumulator, and stores the
result in the primary accumulator for each iteration of the IT1 group.

6
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How to Reset and Calculate a Value Total

(Contd)
Step

Action

6

From the Alternate Accum list, select “2.”

Note

This operation specifies that the system add the value of accumulator
“2” (which contains the extended price for a line item) to the value of
accumulator “3.” The system stores the sum in accumulator “3,” which
therefore contains a running total of the extended price with each
iteration of the IT1 group.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Edit Accumulatar Entry

Priman Acaumulator IS H Harma IHwﬂingTutE‘ I i I
PEXalice e Canpsl I
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Foulh | B

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Properties

Mame I ‘v"alidationl Estended Fule ~ Standard Rule | Conditionsl

Please select the standard rule bo uge IUse Accurnulator ﬂ
Frimary Accumulatar Op1 Op2 0Op3 O0Op4

2-Extended Price b ult Mew...
3Running Taotal AddPa

Change...

Delete

i

Cancel | Lol | Help |

Click OK on the Element Properties dialog box to add the standard rule
to the IT104 element.
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Procedure: loading  Use this procedure to load the running total of the extended price into the TDS01 (Total
a running total of  Invoice Amount) element.

extended price

Step Action
1 Double-click the TDS01 element.
Note
This is the element that contains the total invoice amount for each line
item.

System response
The system displays the Element Properties dialog box.

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “3.”
6 From the First list, select “Use primary.”
Note

This operation specifies that the system loads the contents of the
primary accumulator into the TDSO01 (Total Invoice Amount) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should

look.

Bl tuvumulaly Enliy

Frimay Accumulslr |3 [2] hame |Rumig Taa | i |
pecatiars: Cancel
Firzl |u:.-_p.im.,- H.ﬁ]luﬂulzﬂ:nml H
S | o
Thd | 2]
Famn | E
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How to Reset and Calculate a Value Total

(Contd)
Step

Action

7

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Properties E

Mame I \.-"alidationl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule to use IUse Accumulator j
PFrimary Accuniulator Op1 0Op2 0Op3 O0Opd
3-Running Taotal Uze Mewr...

Change...

==
Delete |

Cancel | Lopni I Help |

Click OK on the Element Properties dialog box to add the standard rule
to the TDSO1 element.
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Using Standard Rules

Using the Use Code Standard Rule

Overview

Introduction

The Use Code function enables you to match an element, field, or TFD against a
predefined code table and specify whether or not a compliance error is generated if the
map component does not contain one of the values in the code table. This function also
allows you to store a code’s description in another element, field, or TFD. You can also
create a unique code table, use code values from a code table, and flag whether or not the
system generates an error if a validation against the code table fails. You can import and
export code lists and copy and paste code lists between maps.

The Gentran:Server Application subsystem enables you to create code tables to be used
with the current map. You can set up code tables in the Application Integration subsystem
to function like the partner cross-reference and lookup tables in Gentran:Server. However,
code tables that are set up in the Application subsystem can be used only for the current
map. Code tables that you create in Gentran:Server can be used globally for all maps.

Code List Tables are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined with a code.
Gentran:Server allows you to load code lists from the standard. You can either load all the
codes in the table, or you can select only one or more codes from the table. Once you load
a code table, you can use a “Use Code” standard rule to either look up a value from a code
table or validate the contents of an element, field, or TFD against the values in the code
table.

A element, field, or TFD with a Use Code rule enables values to either be checked against
or selected from the codes in a specified code table. Codes are typically used to further
qualify another element. For example, if the XX element contains address information,
you can further qualify that element by choosing the code “SU” from the 0222 table. In the
0222 table, the code “SU” is described as a “supplier's address.” Therefore, by using this
code with the XX element, you are indicating that the XX element is not just address
information, but address information for the supplier.

6

Gentran:Server for Windows — August 2008 Application Integration User’s Guide



Using Standard Rules

Standard Rule tab
(Use Code)

Standard rule tab
(Use Code) parts
and functions

Overview

This diagram illustrates the Standard Rule tab with Use Code selected.

Element Froperties

M ame I Validationl Exterded Fule  Standard Rule I Eonditionsl
Please select the standard rule to use : IUse Code j

Please select the code list to use

™ Raise a compliance eror if the eode is not found in the list

IF pou would like the degcription of the code to be stored in a field, pleasze

zelect that field below :

=l Edt.. |

Cancel Al Help

This table lists the parts of the Standard Rule tab (with the Use Code standard rule
selected) and their functions.

Part

Function

Code list

Contains all the code tables.

Note
If the necessary code table is not listed, click Edit to load or
create a code table.

Edit

Accesses the Edit Code List dialog box, which enables you to
create and edit code list tables.

Raise compliance
error

Indicates that, for compliance reasons, the element, field, or TFD
must contain one of the codes from the specified table (nothing
else is valid for that field).

Example

If a field is defined as containing only “YES” or “NO,” you can
set up an exclusive code table that contains only YES and NO.
Then if you receive a “MAYBE” in that field, the system flags it
as an error.
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Code List dialog
box

Edit Code List
dialog box parts
and functions

Using Standard Rules

(Contd)
Part

Function

Code description

Contains the element, field, or TFD where you want the
description of the code (that is used) to appear when the selection
is made.

Example

If the code is “SU,” it is much more useful to view the
description of the code (“Supplier's Address). If you selected
element “XX” from the store description list, the description for
the code used is mapped to element “XX.”

This diagram illustrates the Code List dialog box.

Table I iph

This table lists the parts of the Edit Code List dialog box and their functions.

Part Function

Table list Specifies the table identifier.

New Accesses the Edit Code List dialog box, which allows you to
create a new code list.

Change Accesses the Edit Code List dialog box, which allows you to edit
the selected code list.

Delete Deletes the selected code list

Import Accesses the Open dialog box, which allows you to import a
code list.

( Gentran:Server for Windows — August 2008
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Using Standard Rules

Edit Code List
dialog box

Edit Code List
dialog box parts
and functions

Overview

(Contd)
Part Function
Export Accesses the Save As dialog box, which allows you to export the
selected code list.
Copy Copies the selected code list.
Paste Pastes a previously-copied code list in a map.

This diagram illustrates the Edit Code List dialog box.

Falit Cwnle 1wt
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This table lists the parts of the Edit Code List dialog box and their functions.

Part Function

Table ID Contains the name of the field or element for which this code list
table is used.

Desc Contains the description of the field or element for which this
code list table is used.

Allowed Codes Specifies the codes that are allowed for this table.

New Accesses the Edit Code List Entry dialog box, which allows you
to create a new code.

Change Accesses the Edit Code List Entry dialog box, which allows you
to edit the selected code.

Delete Accesses the Edit Code List Entry dialog box, which allows you
to delete the selected code.

Load Accesses the Load Code List dialog box, which allows you to

select, from a standard code table, specific codes that you want to
load or select the entire list of codes.
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Edit Code List
Entry dialog box

Edit Code List
Entry dialog box
parts and
functions

Using Standard Rules

This diagram illustrates the Edit Code List Entry dialog box.

Edit Codc Lizt Entry

Wakie

D' e=cripbion | Cance I

This table lists the parts of the Edit Code List Entry dialog box and their functions.

Part Function
Value Specifies the actual value of the code.
Description Contains the code value description.
Note

The description is used if you specify an element or field (in the
Store Fields list on the Field Properties dialog box) to which you
want the code description mapped.

6
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How to Validate Data Against a Code List Table

Introduction  For this example you need to map the customer product code from the Product/Service ID
to the customer product code field (CUSTPROCODE) on the application side of the map.
To ensure that the data that is mapped from the Product/Service ID element really is your
partner’s customer product code, you need to establish and use a code table with the
Product Service ID Qualifier.

Procedure  Use this procedure to validate the data in the Product/Service ID field against a code list

table.
Step Action

1 Load the code list table from the standard for the Product/Service ID
Qualifier element.

Reference

See How to Load a Code List Table from the Standard on page 3 - 66 for
more information.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Special Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided
by the standard.

2 Define a code list table for the Product/Service ID Qualifier element that
only contains the code value “BP” (Buyer’s Part Number).

Reference
See How to Define and Modify a Code List on page 3 - 62 for more
information.

3 Double-click the element for which you need to validate data against a
code table (Product/Service ID Qualifier).

System response
The system displays the Element Properties dialog box.

4 Select the Standard Rule tab to access standard rule options.

5 From the standard rule list, select “Use Code.”

6 From the code list, select the code list table that the data in this field is
validated against (0235).

7 If you need to specify that, for compliance reasons, the element mus?
contain one of the codes from the specified table (nothing else is valid
for that field), select the compliance error check box.

8 Click OK to add this standard rule to the field.
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How to Define and Modify a Code List

Procedure Use this procedure steps to define or modify a code list table.

Step

Action

1

From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

Do you want to create a new code list?

» Ifyes, click New.

» Ifno (you want to edit a code list), select a code list and click
Change.

System response
The system displays the Edit Code List dialog box.

In the Table ID box, type the name of the field or element for which this
code list table is used.

In the Description box, type the description of the field or element for
which this code list table is used.

Do you want to create a new code?
» Ifyes, click New.

» Ifno (you want to edit a code), select a code and click Change.

System response
The system displays the Edit Code List Entry dialog box.

In the Value box, type the actual value of the code.

In the Description box, type a description of the code value.

Click OK to save the code list entry.

Repeat steps 5 through 8 to add more code list entries to the code list
table.

10

Click Close to save and exit the Edit Code List dialog box.

11

Click Close to exit the Code Lists dialog box.

6

Gentran:Server for Windows — August 2008 Application Integration User’s Guide



Using Standard Rules

How to Delete a Code List or Code List Entry

How to Delete a Code List or Code List Entry

Procedure:
deleting a code list

Procedure:
deleting a code list
entry

Use this procedure steps to delete a code list table.

Step

Action

1

From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

Select the code list you want to delete.

Click Delete to delete the code list table.

System response
The selected table is deleted without warning.

Use this procedure steps to delete a code list entry.

Step

Action

1

From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

» Select the code list from which you want to delete an entry and
» click Change.

System response
The system displays the Edit Code List Entry dialog box.

Select the entry and click Delete to remove the entry.

System response
The selected entry is deleted without warning.

Click OK to save the code list table.
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How to Import a Code List

Introduction The Code List Import function enables you to import code lists created for another map
and share code lists with other users of Gentran:Server.

Procedure  Use this procedure steps to import a code list table.

Step Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 Click Import.

System response
The system displays the Open dialog box.

DOpen (7] %]

Loak i |aBin ﬂ gl E

File name: I

Files of bype: ICode Tables [*.CDE] j Cancel |

3 Select the location of the code list file.

Note
The default location is Application Integration install folder (the default
is GENSRVNT). The default file extension for code lists is “.CDE.”

4 Select the code list file from the list and click Open.

System response
The system imports the code list and returns to the Code Lists dialog
box. The imported code list is available for your use.

5 Click OK to exit the Code Lists dialog box.
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How to Export a Code List

Introduction  The Code List Export function enables you to export code lists to file. This enables you to
define a code list for one map and use that code list in another map. This function also
allows you to share code lists with other users of Gentran:Server.

Procedure  Use this procedure steps to export a code list table.

Step Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 Select a code list and click Export.

System response
The system displays the Save As dialog box.

Save As HE

Save in: |@Bin j gl I.E_ =

File name:  [0235.CDE

Save astype: [Cade Tables (*CDE) =l o] |

3 Do you want to change the name?

» Ifyes, type the export file name in the “File name” box.

» Ifno, continue with the next step.

Note

The file name defaults to the table ID with a “.CDE” file extension. The
default location is Application Integration install folder (the default is
GENSRVNT).

4 Click Save.

System response
The system exports the code list and returns to the Code Lists dialog
box.

5 Click Close to exit the Code Lists dialog box.
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How to Load a Code List Table from the Standard

Procedure  Use this procedure steps to load a code list table from the standard.

Step

Action

1

Double-click the element for which you need to use a code table.

System response
The system displays the Element Properties dialog box.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Special Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided
by the standard.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use Code.”

Click Edit.

System response
The system displays the Edit Code List dialog box.

Click Load.

System response
The system prompts you to select a data source name (DSN) from which
to access the EDI standard.

Select the appropriate DSN and click OK.

System response
The system displays the Load Code List dialog box.

Select either specific codes that you want to load or select the entire list
of codes.

» To select specific codes only, from the Codes in Standard list,
highlight each code that you want to be loaded. Click Add to move
it to the Codes Selected list.

» To load the entire code list, click Add All to select all the codes and
move them to the Codes Selected list.

Recommendation

Only add the codes that you and your trading partners are able to create
or accept. Adding all codes in the code table (using the Add All) creates
a much larger translation object than if you only use selected codes.

Click OK to load the code list.

Click Close to exit the Code Lists dialog box.
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How to Copy and Paste Code Lists

Introduction The Code List Copy and Paste function enables you to copy code lists to from one map to
another.

Procedure  Use this procedure steps to copy and paste a code list table.

Step Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 Select a code list and click Copy.

System response
The system copies the code list to the clipboard.

3 Click Close to exit the Code Lists dialog box.

4 Open the map in which you want to use the code list, if the map is not
already open.

5 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

6 Click Paste.

System response
The system adds the copied code list to this map.

7 Click Close to exit the Code Lists dialog box.
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How to Validate Data Against Code List Tables

Procedure  Use this procedure steps to validate data against a code list table.

Step Action

1 Double-click the element for which you need to validate data against a
code table.

System response
The system displays the Element Properties dialog box.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Special Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided
by the standard.

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Code.”
4 From the code list, select the code list table that the data in this element

is validated against.

Note
If this list is empty, you need to load a code table.

Reference
See How to Load a Code List Table from the Standard on page 3 - 66 for
more information.

5 If you need to specify (for compliance reasons) that the element must
contain one of the codes from the specified table (nothing else is valid
for that field), select the compliance error check box.

6 Click OK to add this standard rule to the element.

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
{ g pp g



Using Standard Rules

How to Map Code Item Descriptions

How to Map Code Item Descriptions

Procedure  Use this procedure steps to map a code item description.

Step

Action

1

Double-click the element for which you need to map a code description.

System response
The system displays the Element Properties dialog box.

Select the Standard Rule tab to access standard rule options.

From the standard rule list, select “Use Code.”

From the code list, select the code list table that the data in this element
is validated against.

Note
If this list is empty, you need to load a code table.

Reference
See How to Load a Code List Table from the Standard on page 3 - 66 for
more information.

If you need to specify (for compliance reasons) that the element must
contain one of the codes from the specified table (nothing else is valid
for that field), select the compliance error check box.

From the store description list, the element to which you want the
description of the code item (that is used) to be mapped to when the
selection is made.

Click OK to add this standard rule to the element.
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Overview

Overview

Introduction

Import translation
object

System import
translation object

Setting Up the Import Process

The import process is part of the outbound translation process. In the outbound translation
process, the system translates your application file format to EDI standard formats, so you
can send documents to your partners.

To translate outbound data, you need to create an import translation object and a system
import translation object in the Gentran:Server Application Integration subsystem. The
import translation object defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-formatted
documents that your partners expect to receive from you.

You need to create a system import translation object to determine which trading
relationship (established in Partner Editor) corresponds to each document in the
application file, so the system knows which import translation object to use to process the
document.
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Setting Up the Import Process

Importing Data

Importing Data

Introduction

What you can
import

Restrictions

Determining
trading
relationships

Translating the
document

During the import process, Gentran:Server imports a specified application file into the
Workspace. An import file can contain multiple flat file definitions (documents) that need
to be sent to multiple trading partners.

You can import any type of flat file, including TDF (Transaction Data File). TDF is a flat
file representation of the EDI standard document. The flat file characteristics can include
multiple record types (more than one record definition) and records delimited by carriage
returns/line feeds.

You cannot import EDI or field-delimited files. The field and record lengths for import
files are defined in the Application Integration subsystem application file definition. For
example, the maximum length of a field in an import file must not exceed the maximum
length (Max) specified on the Field Properties dialog box for that field. And, the
maximum length of a record in an import file must not exceed the record length (if
specified) on the Positional File Format Properties dialog box for that record. The system
default is variable length records. If you specify record delimiters on the Positional File
Format Properties dialog box, the records in the import file must begin and end with those
delimiters. If you do not specify record delimiters, the default delimiters are carriage
return and line feed.

The system must determine which trading relationship (established in Partner Editor)
corresponds to each document in the application file, so the system knows which import
translation object to use to process the document. Each application file must have a
corresponding system import map. For each document in the application file, the system
import translation object identifies the partner and locates the trading relationship. The
trading relationship for that partner must have an import translation object associated with
it.

After the system import translation object determines which trading relationship
corresponds with a document, it ascertains which import translation object is specified in
that relationship. The translator uses the import translation object to translate the
document. If the document is compliant (valid), it is moved to the Workspace. If the
document is not compliant (invalid), it is moved to the ?Out Documents. Then, if there is
another document remaining in the application file, the translator repeats this process until
all the documents are processed.
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Importing Data Setting Up the Import Process

Import process This diagram illustrates the import process (translator not pictured).
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How to Modify System Configuration

Introduction When you import a file, the system checks the Imports tab of the System Configuration
program (shipped with Gentran:Server) to verify that the file is matched with a registered
system import translation object. Your system administrator may need to add the match to
the System Configuration program.

Reference
See How to Edit an Import Specification in the Administration Guide for more
information on defining or modifying import specifications.
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How to Create a System Import Map

Introduction

Building a key:
method 1

Building a key:
method 2

Procedure:
creating a system
import map

A system import map is used by the system to find the partner relationship for a document
(flat file definition), to determine which import map is used to translate the data. The
system import map builds the key that the translator uses to find the partner relationship.
The sole function of the system import map is to identify the appropriate partner
relationship; the system import map does not map any data.

There are two ways to build the key in a system import map. The method that we
recommend requires six EDI-specific fields in the header record: partner key, standard,
version, transaction set, release (for TRADACOMS only), and test/production status. The
combination of these six fields defines a unique key that identifies the appropriate partner
relationship. We recommend using this method because it is very flexible. You typically
use this method when you are defining your application from scratch and can easily add
the EDI-specific fields that are not already present in the header record.

The second method is easier to build because it only requires three fields in the header
record (partner key, application ID or application alias value, and test/production status).
The combination of these three fields defines a unique key that identifies the appropriate
partner relationship. However, because only three fields are combining to build the key,
this method is not as flexible as the preferred method. You typically use this method when
you are using a legacy (existing) application definition, and you do not want to add EDI-
specific information.

Use this procedure to create a system import map.

Step Action

1 From the File menu, select New.

System response
The system displays the New Map Wizard.

2 From the type of map list, select System Import.
3 In the name box, type the name of the map.
4 Verify that your name is already entered in the name box and click Next.

System response
The system displays the New Map Wizard - Input Format dialog box.

5 From the Create a new data format list, select Positional and click Next.

System response
The system displays the New Map Wizard - Output Format dialog box.
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How to Create a System Import Map

(Contd)
Step

Action

6

From the Create a new data format list, select Positional and click Next.

Note
The system actually ignores the Output side of the map and only
processes the Input side.

Click Finish to create the new system import map (this may take a few
seconds).

System response
The system displays the new map in the Gentran:Server - Application
Integration Window.

After creating the system import map, you need to define the header
record for the system import map. You can use either a six-field key (this
is the preferred method) or the alternate key method.

Reference
Continue with How fo Define the Six-Field Key on page 4 - 8.
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How to Define the Six-Field Key

Introduction

After defining the

key

Procedure:
defining the
partner key

To use the preferred method of building the system import key, you need to define at least
five fields for the header record (partner key, standard, version, transaction, and test/
production status). If it is a TRADACOMS map, you must also define a release field.
These fields do not have to be in any order or sequence, but they must be part of the header
record.

If you want to also define the other fields that the corresponding import map header record
contains, you can do so at this time.

Reference
» See How to Create the First Record on page 2 - 54 for more information.

» See How to Create Fields on page 2 - 64 for more information.

Once you define the header record and fields, you can set up the mapping operations that
defines the key that the translator uses to find the partner relationship.

Use this procedure to define the partner key.

Step Action

1 Double-click the partner key field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Select.

6
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How to Define the Six-Field Key

(Contd)
Step

Action

4

From the table and key list, select Partner by EDI Code, Partner by
Alternate code, or Partner by Partner Key.

Note
This indicates that the system updates this field with the indicated
partner key.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

Mame I Validationl F'ositionl Extended Fule  Standard Rule IEonditionsl

Please select the standard rule to use : ISeIect j

Please chooze the table and key [or group] to uze when selecting data :
IPartner by EDI code j

Elease enter the name af the: suts-tatile to wee (it approprate] ¢

™ Raise a compliance ermor if matching data i not found

‘f'ou cah map the data that was selected. Click on data in the left list then click the
fieldz in the right list that pou would like it to be mapped to. Repeat to map more data.

Mame FARTHER_ID Partrer [dentifier
Edi Code STaMDARD Standard
Alternate Code WERSIOM “ersion

TRAMSACTION_SET Transaction Set
TEST_PROD Test/Production Flag

Cancel I Sl | Help |

Click OK to add the standard rule to the partner key field.

Procedure: Use this procedure to define the EDI standard field.

Action

Double-click the standard field.

System response
The system displays the Field Properties dialog box (Name tab).

Select the Standard Rule tab to access standard rule options.

defining the
standard field
Step
1
2
3

From the standard rule list, choose Update.

Application Integration User’s Guide
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(Contd)
Step

Action

4

From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Agency.

Note
This indicates that you are updating the agency (standard) field in the
system buffer.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

M ame I Validationl F'ositionl Exterded Fule  Standard Rule I Eonditionsl

Fleaze select the standard rule to uge : IUpdate j

Flease zelect the table [or group) to update :
I Drocument record j

Flease zelect the column [or field] to update :

IAgency j

Cancel | Al | Help |

Click OK to add the standard rule to the standard field.

Procedure:  Use this procedure to define the version.

Action

Double-click the version field.

System response
The system displays the Field Properties dialog box (Name tab).

defining the
version field
Step
1
2

Select the Standard Rule tab to access standard rule options.
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How to Define the Six-Field Key

(Contd)
Step

Action

3

From the standard rule list, choose Update.

4

From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Version.

Note
This indicates that you are updating the version field in the system
buffer.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties 1]

MHame I W alidation I Position I Extended Fule  Standard Rule I Conditions I

Flease zelect the standard rule to uze IUpdate j

Fleaze zelect the table [ar group] to update :
I Docurment recond ﬂ

Fleaze zelect the column [or field] to update :

IVersion j

Cancel | Al | Help |

Click OK to add the standard rule to the version field.

Procedure: Use this procedure to define the transaction set (document).

defining the

transaction field
Step

Action

1

Double-click the transaction set field.

System response
The system displays the Field Properties dialog box (Name tab).

Application Integration User’s Guide
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(Contd)
Step Action
2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.
Note
This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).
5 From the column list, choose Transaction Set ID.
Note
This indicates that you are updating the transaction set field in the
system buffer.
System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.
Mame I \.-"alidationl F‘ositionl Extended Fule  Standard Rule | Eonditionsl
Flease select the standard rule to uze IUpdate j
Fleaze zelect the table [ar group) to update :
I Document record j
Fleaze zelect the colurnn [or field] to update :
I Tranzaction Set D j
Cancel | Lopni I Help |
6 Click OK to add the standard rule to the transaction set field.

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
{ g pp g



Setting Up the Import Process How to Define the Six-Field Key

Procedure: Use this procedure to define the release of the selected standard version (TRADACOMS
defining the  only).
release field

Step Action

1 Double-click the release field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Release.

Note
This indicates that you are updating the release field in the system
buffer.

System response
This is an example how the Standard Rule tab of the Field Properties

dialog box should look.

Marne I Validationl Positionl Extended Fule  Standard Fuls | Eonditionsl

Fleaze zelect the standard rule to uze : IUpdate j

Flease select the table [or group) to update :
I Drocument record j

Flease zelect the column [or field] to update :

I Relzase j

Cancel | Al I Help |

6 Click OK to add the standard rule to the release field.
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Procedure: Use this procedure to define the test or production status field.
defining the test/
production field Step Action

1 Double-click the test or production field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Test Mode.

Note
This indicates that you are updating the test field in the system buffer.

System response
This is an example how the Standard Rule tab of the Field Properties

dialog box should look.

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Fleaze zelect the standard rule to use IUpdate j

Flease zelect the table (or group) to update :
I Document record j

Fleaze zelect the column [or field] to update :
I Test Mode ﬂ

Cancel | Lopi I Help

6 Click OK to add the standard rule to the test field.
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How to Define the Alternate Key

Introduction To use the alternate key method of building the system import key (formerly referred to as
the three-key method), you need to define (create new or update existing) three or four
fields for the header record. You must define a field for partner key, a field for either one
or both application ID and application alias value (you only need to use one of these two
fields), and a field for test/production status. If you define all four fields, you are using the
alternate key method; if you use only one of the application ID or application alias value
fields, you are actually using a three-field key. These fields do not have to be in any order
or sequence, but they must be part of the header record.

Tip
You do not have to define new fields to use this key. You can add the necessary standard

rules to three fields that already exist in your application file.

If you want to also define the other fields that the corresponding import map header record
contains, you can do so at this time.

Tip
» See How to Create the First Record on page 2 - 54 for more information on how to
define the header record.

» See How to Create Fields on page 2 - 64 for more information on how to define the
fields in the record.

After defining the  Once you define the header record and fields, you can set up the mapping operations that
key defines the key that the translator uses to find the partner relationship.

Procedure: Use this procedure to define the partner key.

defining the

partner key
Step Action

1 Double-click the partner key field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Select.
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(Contd)
Step Action

4 From the table and key list, select Partner by EDI Code, Partner by
Alternate code, or Partner by Partner Key.

Note
This indicates that the system updates this field with the indicated
partner key.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties %]

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule to use : ISeIect j

Please chooze the table and key [or group) to uge when selecting data :
IPartner by EDI code j
Eleaze ententhe name of the sub-atle o use i appropnate]

™ Raise a compliance erar if matching data is nat found

*f'ou can map the data that was selected. Click on data in the left list then click the
fields i the right lizt that you would like it to be mapped ta. Repeat ta map mare data.

Mame FARTHER_ID Partrer |dentifier

EdiCode STANDARD Standard

Alternate Code YERSION Yersion
TRAMSACTION_SET Transaction Set
TEST_PROD Test/Production Flag

Cancel | Lopi I Help |

5 Click OK to add the standard rule to the partner key field.

Procedure: Use this procedure to define the application ID field.

defining the
application ID Note
PP field You must define either the application ID field or the Application Alias Value field (three-

field key). You may define both of these fields if you wish to use the alternate key method.

Step Action

1 Double-click the application ID field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Update.
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(Contd)
Step

Action

4

From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Application Field 1.

Note
This indicates that you are updating an optional key field in the system
buffer.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

MHame I \-"alidationl Positionl Exterded Fule  Standard Rule I Eonditionsl

Fleaze zelect the standard rule to uze IUpdate ﬂ

Fleaze select the table [or group] to update :
I Document recard j

Pleaze select the column [or field) to update :
| Application Field 1 =l

Cancel | Aol | Help |

Click OK to add the standard rule to the application ID field.
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Gentran:Server for Windows — August 2008



How to Define the Alternate Key Setting Up the Import Process

Procedure: Use this procedure to define the application alias value field.

defining the
application alias
value field

Note

You must define either the application ID field or the Application Alias Value field (three-
field key). You may define both of these fields if you wish to use the alternate key method.

Step

Action

1

Double-click the application alias value field.

System response
The system displays the Field Properties dialog box (Name tab).

Select the Standard Rule tab to access standard rule options.

From the standard rule list, choose Update.

From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Application Field 2.

Note
This indicates that you are updating an optional key field in the system
buffer.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties E

Mame I Validationl Positionl Exterded Fule  Standard Rule | Conditionsl

Flease zelect the gtandard rule to uze IUpdate j

Fleaze select the table [or group] to update
I Document recard j

Pleaze select the column [or field] to update :
| Application Field 2 =l

Cancel | Lpply | Help |

Click OK to add the standard rule to the application alias value field.

6
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Procedure: If you do not define the test/production status field, the document record is set to
defining the test/ production by default. In this situation, the system translation object can only locate the
production field correct relationship if the test mode of the partner relationship is actually set to production.

Recommendation
Define the test/production status field.

Use this procedure to define the test/production status field:

Step Action

1 Double-click the test or production field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.

Note

This indicates that you are updating the document record in the
Gentran:Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Test Mode.

Note
This indicates that you are updating the test field in the system buffer.

System response
This is an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

Name | Validation | Position | Estended Rule  Standard Rule | Canditions |

Fleaze select the standard rule to uze IUpdate j

Flease select the table [or group] to update :
IDocument record j

Fleaze select the column [or field) to update :

ITest Mode j

Cancel | Sl | Help |

6 Click OK to add the standard rule to the test field.
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How to Compile the System Import Translation Object

Introduction  After you create, define, and save the system import map, you need to compile the map
and create a system import translation object.

Procedure  Use this procedure to generate the system import translation object.

Step

Action

1

From the File menu, select Compile.

System response
The system displays the Run-time Translation Object Name dialog box.

In the File name box, type the name of the translation object, if
necessary.

Warning

Be very careful not to overlay the source map with the compiled
translation object. Use the .TPL file extension to distinguish the
translation object.

From the Save in list, change the Drive and Folder where the compiled
translation object is stored, if necessary

Click Save.

System response
The system compiles the map and creates the system import translation
object.

The translation object must registered with the Gentran:Server system
before you can use it.

Reference
See How to Register a New Translation Object in the Gentran:Server
User s Guide for information on registering a translation object.

If your system administrator has not already added this system import
translation object to the System Configuration program, do so now.

Reference
See How to Edit an Import Specification in the Administration Guide for
more information.

6
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Overview

Introduction To translate inbound data, you need to create an export map in Gentran:Server (because
the system is exporting to your application file).

Export map  The export map defines how to move data from the EDI standard-formatted documents
that your partners send you to your application file (flat file definition). This map also
enables you to populate your application file fields with supplementary information from
the interchange, group, and transaction set envelopes.

In this chapter This chapter explains how to set up the export process, including the following topics:
» Inbound process prior to exporting data

» Using supplementary envelope information
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Inbound Process Prior to Exporting Data

Introduction During the export process, the Communicator receives interchanges from your trading
partners via a network and passes the interchanges to the translator. The translator uses a
system interchange break translation object (shipped with Gentran:Server) to unwrap the
interchange envelopes and separate each group into temporary storage. The translator uses
a system group break translation object (shipped with Gentran:Server) to unwrap the
group envelopes and separate each transaction set into temporary storage. The translator
uses a system transaction break translation object (shipped with Gentran:Server) to
unwrap the transaction envelopes and separate each document into the ?In Documents in
Gentran:Server.

Locating trading  The translator attempts to locate the trading relationship for each document. If a trading
relationships relationship is located, the translator then attempts to identify the export, document

turnaround, or print translation object associated with that relationship. If the translator
does not locate the trading relationship or translation object, the document stays in the ?In
Documents. If the translator does locate a trading relationship and translation object, it
uses that translation object to compliance check the document. If the document is not
compliant with the EDI standard, it stays in the ?In Documents. If the document is
compliant with the EDI standard, the translator moves it to the In Documents. From the In
Documents, you can print (if there is an associated print translation object), or export valid
documents.

Generating acks If you specify (in the trading relationship) that the system needs to generate a functional
acknowledgement (ack) for a document, the translator uses the system acknowledgement
translation object (shipped with Gentran:Server) to generate the acknowledgement. If the
generated acknowledgement was compliant, the translator moves the acknowledgement to
the Out Documents to be sent to the trading partner. If the generated acknowledgement
was not compliant or if an error occurred with the acknowledgement translation object, the
translator moves the acknowledgement to the ?0ut Documents.

Automatic export  If you specified either automatic export or automatic turnaround in the trading
relationship, the translator uses the specified export or document turnaround translation
object to either export or generate the appropriate response document.
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Procedure  Use this procedure to set up the export process.

Step Action

1 Create an export map.

Reference
See How to Create a New Map on page 2 - 20 for more information on
how to create a new map.

2 Register the export map with Gentran:Server.

Reference
See How to Register a New Translation Object in the Gentran:Server
User s Guide for more information on registering a translation object.

3 Create the appropriate inbound trading relationship.

Reference
See How to Create a New Inbound Relationship in the Gentran:Server
User s Guide for more information on creating an inbound relationship.
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How to Use Supplementary Envelope Information

Introduction  The Gentran:Server Application Integration subsystem enables you to use a Select
standard rule to populate your application file fields (in an export map) with information
from the EDI envelopes associated with the documents your trading partner sends you.

This table lists the correspondence between the selections available for the Select standard
rule and the envelope information that you want to map to your application field.

IF you select this

value from the Map

from list... THEN the system maps this information...
Field 1 Transaction Set ID

Field 2 Document Name

Field 3 Group ID

Field 5 Partner Name

Field 6 Interchange Control Number
Field 7 Group Control Number
Field 8 Document Control Number
Field 9 Received Version

Field 15 Received Agency

Field 16 Used Agency

Field 17 Used Version

Field 22 ISA Test Mode

Field 23 Document Test Mode
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Procedure Use this procedure to use supplementary envelope information in your application file.

Step

Action

1

Double-click an existing application field or create a new field.

Reference
See Using a Fixed-Format File on page 2 - 51 for more information on
creating fields.

System response
The system displays the Field Properties dialog box (Name tab).

Select the Standard Rule tab to access standard rule options.

From the standard rule list, choose Select.

From the table and key list, select Generic envelope segment.

Note
This enables you to map from any of the fields within the current
envelope information, regardless of the EDI standard used.

Select the compliance error check box.

Note
This indicates that a compliance error should be generated if the select
does not find a valid entry.

From the map from list, choose the envelope information that you want
to map to your application field.

Note
See the table on the previous page for selection definitions.

Warning

Verify that you select the correct map from selection. Any selection that
is not listed in the above table is currently reserved and should not be
selected under any circumstances.

From the map to list, choose the field to which you want to map the
contents of the Map From field.

Note
The system displays each field from the output side of the map in this
list.

If you want to map additional envelope information, repeated steps 7
and 8 as many times as necessary.

Note
A total of eight fields can be mapped using one Select rule.

Click OK to add the standard rule to the application field.
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Using Extended Rules

Introducing Extended Rules

Overview

In this chapter

What are extended
rules?

Uses of extended
rules

What comprises an
extended rule?

This chapter explains how to use extended rules, including the following topics:
»  What rules are and when they are processed

» Defining extended rules

» Extended rule syntax

» Alphabetic language reference guide

Extended rules enable you to use a Gentran:Server proprietary programming language to
perform virtually any mapping operation you require.

You can use these rules to define more complex translations than are available through the
link function (simple mapping) and standard rules. You can use extended rules to define
operations that are not possible using standard rules.

You define extended rules with the Gentran:Server proprietary programming language.
This is a full programming language that gives you access to the entire Gentran:Server
internal storage area.

Any variables that are not already defined as part of the input or output specification of the
map, that you use in a rule must be declared before you use those variables.

Therefore, an extended rule consists of two sections, a declarations section followed by a
statements section.

The declarations section is only required if you use additional variables. This is where you
declare the names and types of any variables you use either in this rule or in any other rule

that is within the scope of this rule.

The statements section is where you define the actions that you want the rule to execute.
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Declarations and Initialization

Introduction  The variables that you define in the declarations section are used to store values. Variables
consist of a name and a data type. Variable names can include alphanumeric characters
and the colon (:) and underscore (). The first character in a variables name may not be a
numeric. All variable names are case-sensitive.

Note

» A declaration must be terminated with a semicolon (;). To improve readability, you
typically include a blank link in between the declaration and statement sections.

» The Translator does not initialize extended rule variables. You must initialize all
variables after declaring them. Variables that are not initialized can cause incorrect
results or translation failures.

Supported data This table describes data types that are supported by extended rules.

types
Data Type Description Example
Integer a whole number with no | Declare i as an integer and initialize.
decimal component.
integer i; //Declaration
i=0; //Initialization of ‘i’
Real a whole number that Declare r as a real number and initialize.
may have a decimal
component. real r; //Declaration
r=_0; //Mnitialization of ‘r’
String contains one or more Declare s as a 20-character string and initialize.

printable characters.
string[20] s; //Declaration
§ =75 //Mnitialization of ‘s’

Datetime | contains a date or time. | Declare d as a date or time and initialize.

datetime d; //Declaration
d = date(0,0,0); //Initialization of ‘d’

Application Integration User’s Guide Gentran:Server for Windows — August 2008 ()



Declarations and Initialization

Using Extended Rules

Data Type

Description

Example

Array

defines a table of
multiple occurrences of
a single data type.

Declare a as an array of 10 integers and initialize.

integer a[10]; //Declaration

integer i; //Declaration of ‘i’, which is
/lused to initialize array ‘a’
i=1; //Initialization of ‘i’

/Mnitialization of the variable array ‘a’
while i <11 do
begin
ali] = 0;
i=it+1;
end

Declare p as an array of 50 10-character strings and
initialize.

string[10] p[S0]; //Declaration

integer i; //Declaration of ‘i’, which is
/lused to initialize array ‘p’
i=1; //Mnitialization of ‘i’

//Initialization of the variable array ‘p’
while i <51 do
begin
p[l] = “”;
i=i+1;
end

Object

is used for user exits; it
exposes the internal
functions of an ActiveX
Automation Server to
Gentran:Server.

Declare ob as an object and initialize.

object ob; //Declaration
ob = CreateObject(“ADODB.Connections”);
/MMnitialization of ‘ob’
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Statements

Introduction  The actual work performed by an extended rule is defined in the statements section. A rule
consists of a statement or a combination of statements (to perform more complex
operations). A statement is a single operation that consists of a combination of
expressions, keywords, commands, operators, and symbols.

Whatis an  An expression is a logical unit (e.g., A =B or A + B) that the system evaluates. The
expression? statements section consists of a sensible combination of keywords, operators, and
symbols.

Reference
Each of these components is explained in detail in Extended Rule Syntax on page 6 - 17.
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When Extended Rules are Processed

Introduction

Levels of extended
rules

Scope

You can specify pre- and post-session rules on the Session Rules dialog box. Pre-session
extended rules are processed before the translation object, and are in scope for every
extended rule defined in the translation object. Post-session rules are executed after the
translation object is processed.

You can attach extended rules to three different levels of map components:
» EDI file and application file groups, using the Loop Level Extended Rules dialog box.

»  Groups, sub-groups, repeating records, and repeating segments, using the Loop Level
Extended Rule dialog box.

» Fields and elements, using the Field Level Extended Rule dialog box.

The scope of an extended rule determines which variables are accessible from within a
given extended rule. The scope varies depending on the current state of the map. This list
defines the scope of an extended rule.

» Pre-session extended rules (defined on the Session Rules dialog box) are in scope for
every rule in the translation object.

» On Begin extended rules (defined on the Loop Level Extended Rules dialog box) are
in scope until the conclusion of its companion On End rule (also defined on the Loop
Level Extended Rules dialog box).

» Field level extended rules are only in scope for the duration of the field or element.

An extended rule attached to the current map component depends on the type and state of
the map component.

Example

If a current group to which the rule is attached is subordinate to another group, the parent
group is automatically in scope for the duration of the entire child group, and the current
hierarchical structure is also in scope for the duration of the child by using an addressing
method that is explained on 6 - 21.

An extended rule that is attached to a field or element is only in scope for the duration of
the field or element. Field level extended rules are always processed after standard rules.

A variable is considered to be “in scope” if it was declared in the current rule, in the On
Begin rule of a group that contains the current map component, or in the Pre-Session rule.

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
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Scope (contd)

Input rule
processing

When Extended Rules are Processed

The translator builds the data storage area for a map based on the structure of the Input
side of the map (the source side of the map). Therefore, extended rules address the map
based on the hierarchy of the Input side. When you use extended rules, you must be
careful to always address the Input side of the map so the translator can locate the map
component that the rule accesses. On the Output side of a map, extended rules only have
access to the current record and the entire Input side of the map. However, from the Input
side of a map, you have access to the entire file structure. As long as you address the
source end of a link, you can write to any field on the Output side, even fields that have
already been written.

The translator processes the Input side of the map first and then the Output side. This table
lists the sequence of how the translator processes rules on the Input side of a map.

Step Action
1 Load the Input definition.
2 Read the Input file.
3 Determine if data is present for the first/next group and then run the

group On_Begin rule, if present.

4 Load each field within the first/next record within the current group and
then execute field level rules (for each field) in the following sequence:

» standard rules

» extended rules

5 At the end of the group, execute the On_End rule, if present.

6 Repeat steps 2 - 5 for each group in the Input file.
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Output rule This table lists the sequence of how the translator processes rules on the Output side of a
processing  map.

Step Action
1 Verify whether or not data exists for the first/next record.
2 If the record is the first record of a group, run On_Begin rule, if present.
3 For each field in the record, execute field level rules (for each field) in

the following sequence:
» Run standard rules

» Run extended rules

4 Format data according to specified field properties (on Field Properties
dialog box).

5 Write the record to the Output file.

6 At the end of the group, execute On_End rule, if present.

7 Repeat steps 1 - 6 for each record in the Output file.

8 Create or update the document entry in the database.
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Rule processing This diagram illustrates when loop level (On Begin and On End) extended rules and field
diagram level extended rules are processed in relation to the system process flow.
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Overview Using Extended Rules

Defining Extended Rules

Overview

Introduction The map component that an extended rule accesses depends on what you want the scope
of the rule to be. You also need to determine when you want the rule to be executed (e.g.,
before or after the map component is processed.

The process you need to follow to define an extended rule varies slightly, depending on
whether you are defining a session rule or a rule for a map component. You can define
extended rules to access three different levels of map components.

» the entire session (input and output sides of the map)
» looping map components (groups, segments, etc.)
» fields
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Using Extended Rules

How to Define a Session Rule

How to Define a Session Rule

Introduction Pre-session rules are used to define variables that must have global scope (can be accessed
from any other extended rule in the map). Pre-session extended rules are processed before
the translation object, and are in scope for every extended rule defined in the translation

object.

Post-session rules are executed after the translation object is processed and thus have no
permanent scope.

You can define both a Pre-session and a Post-session rule for a given session.

Procedure  Use this procedure to define a session rule.

Step

Action

1

From the Edit menu, select Session Rules.

System response
The system displays the Session Level Extended Rules dialog box.

Do you want to define a pre-session rule?
» Ifyes, click the Pre-session option.

» Ifno (you want to define a Post-session rule), click the Post-session
option.

In the Editor list, type the extended rule.

Note

The Session Level Extended Rules dialog box contains line and
character number (within a line) indicators. These indicators, which are
displayed to the lower right of the Editor box (the first indicator
references the line number and the second references the character
number), enable you to easily debug compile errors.

Do you want to check the rule for errors?
» Ifyes, click Compile to compile the extended rule.

System response
Any warnings or errors are displayed in the Errors list. Double-click
an error to instantly navigate to the line containing the error.

» Ifno, continue with step 6.

Note

The Compile function gives you immediate feedback about the accuracy
of your rule. The rule is compiled when you compile the entire
translation object.

Application Integration User’s Guide
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How to Define a Session Rule Using Extended Rules

(Contd)
Step Action
5 Correct any errors that the system flagged and click Compile again.
Note
Repeat this process until there are no errors generated.
6 Click OK to add the extended rule.
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How to Define a Map Component Rule

How to Define a Map Component Rule

Procedure  Use this procedure to define an extended rule for a map component.

Step

Action

1

Right-click the map component and select Rules (Extended Rule if the
map component is a field, element, or TFD) from the shortcut menu.

System response

» The system displays the Loop Level Extended Rules dialog box if
the map component is an EDI file, application file, group, sub-
group, repeating record, or repeating segment.

» The system displays the Field Level Extended Rule dialog box if
the map component is a field or element.

Do you want the extended rule to be executed before the system
processes the map component?

» Ifyes, select the On Begin option.

» Ifno (you want the rule to be executed when the system concludes
its processing of that map component), select the On End option.

Note
You can define both an On Begin and an On End rule for the a single
map component.

In the Editor list, type the extended rule.

Reference
See Alphabetic Language Reference on page 6 - 47 for more
information on rule syntax.

Note

The Extended Rules dialog boxes contain line and character number
(within a line) indicators. These indicators, which are displayed to the
lower right of the Editor box (the first indicator references the line
number and the second references the character number), enable you to
easily debug compile errors.

Application Integration User’s Guide
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How to Define a Map Component Rule Using Extended Rules

(Contd)
Step

Action

4

Do you want to check the rule for errors?
» Ifyes, click Compile to compile the extended rule.

System response
Any warnings or errors are displayed in the Errors list. Double-click
an error to instantly navigate to the line containing the error.

» Ifno, continue with step 6.

Note

The Compile function gives you immediate feedback about the accuracy
of your rule. The rule is compiled when you compile the entire
translation object.

Correct any errors that the system flagged and click Compile again.

Note
Repeat this process until there are no errors generated.

Click OK to add the extended rule.

Note
When an element contains an extended rule a black asterisk appears to
the right of the element icon.

6
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Using Extended Rules Overview

Extended Rule Syntax

Overview

Introduction The statements section of an extended rule consists of a sensible combination of
keywords, operators, and symbols. The correct syntax for each of these component is
explained below.

Note
You use spaces and operators to separate keywords and symbols. You cannot string two
keywords sequentially together without an operator.
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Keywords and Commands Using Extended Rules

Keywords and Commands

Introduction A keyword is a fixed defined use of a word that indicates how the programming language
should be interpreted. There are two types of keywords. The first type of keyword controls
the flow of execution of the defined rule. These keywords are used to evaluate conditions
and perform looping operations.

The second type of keyword is a command. Commands perform actions on variables and
are responsible for the movement of data.

List of keywords  This is a list of Gentran:Server execution control keywords.

» IF

» THEN

» ELSE

» BEGIN

» END

» WHILE

» DO

» CONTINUE
» BREAK

List of commands This is a list of Gentran:Server commands.

» AUDITLOG
» GET

» SET

» STRDATE
» CONCAT
» LEN

» ATOI

» ATON

» CERROR
» EMPTY

» EXIST

» INDEX

» NTOA

» COUNT
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List of commands
(contd)

DELETE

FSEEK

FTELL
READBLOCK
UNREADBLOCK
READBYTES
LEFT

MID

RIGHT

SELECT
UPDATE

INSERT
WRITEBLOCK
WRITEBYTES
CREATEOBIJECT
DELETEOBIJECT
QUERYOBIJECT
GETIID
WINEXEC

DATE

EXEC

PARAM

Note
A statement must be terminated with a semicolon ().

Application Integration User’s Guide
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Operators

Operators

Using Extended Rules

Introduction Operators define the simplest operation in an expression.

List of keywords  This table lists the operators that can be used in extended rules and their functions.

Part Function
+ addition, concatenation
- subtraction
* multiplication
/ division
= assignment, equality
> greater-than
< less-than
>= greater-than or equal to
<= less-than or equal to
I= not equal to
! logical not
& logical and
| logical or
<< date modification
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Symbols

Introduction

Symbol syntax

Symbols

Operations are performed on symbols. The symbols that you can use in Gentran:Server
extended rules are variables, constants, map components/internal storage, arrays, and
accumulators.

You can address existing map components and you also have the ability to create
additional instances of map components, as long as the map component is originally
defined in internal storage.

Example
You can use this function to create extra line items when one line item field is already
defined in internal storage.

You must address each type of symbol in the proper syntax.

String constant

To address a string constant, you must enclose the constant value in quotes:
#fieldname = "HDR";

where HDR is the constant value

Addressing or creating a field in internal storage

To address a field or create a field in internal storage, within the scope of the current
mapping action, the syntax is #FIELD _NAME

#field_1=2;

where 2 is a numeric constant value

Addressing or creating a field in a group
To address a field within a group or create a field within a group in internal storage within
the scope of the current hierarchy, the syntax is SGROUP#FIELD NAME
$N1.#0234
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Symbols Using Extended Rules

Symbol syntax Addressing or creating a group in internal storage

(contd.) To fully address a group in the entire internal storage area or create a group in internal
storage, the syntax is SLOOP[index1][index2][index3] where the index entries indicate
the hierarchical structure of the loop and enable you to address specific instances of a
group:
$Group_C|[3][2].#Field 2
where you are specifying the second instance of Group_C within the third instance of
Group_B:

Group A

Group B

Group C

TR

Addressing an array
To address an array (of any type), you address each element of the array individually. For
example, if array_1 is an array (of integers) and is declared:

integer array_1[5]

With variables 0 through 4, each element of the array is addressed individually as follows:
array_1[0]

array_1[1]

array_1[2]

array_1[3]

array_1[4]

Accessing an accumulator

An accumulator can be accessed in the same manner as variables or internal storage. To
address an accumulator, use the syntax accum(n) where “n” is the number (not the name)
of the accumulator:

accum(2) = 5;
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Symbol syntax
(contd.)

Application Integration User’s Guide

Symbols

Accessing repeating elements
You can access a specific occurrence of a repeating element (for EDI data) and access a
specific occurrence of a field within a repeating composite (for EDI data).

This is the syntax for accessing a specific occurrence of a repeating field and a field within
a repeating composite.

field name[index_variable] = string;

where: integer variable = integer variable that indicates the
specific occurrence of a repeating field or field

within a repeating composite.

This is an example of accessing a specific occurrence of a repeating field and a field
within a repeating composite.

#*Gentran Application Integration - [ncp2edi.s =10l =]
é’ File Edit Functions Yiew OQpkions  window  Help =&l =]
) (=2 = N 5 il 1 I e R S R

- CODE_B1-M-1E] =

HEADER -C - 1 [
01 F1 -M - Sting 2 ¥
02f2-M - 105king 10 @
repeat - M - 10 B
0363 -C - Shing 10 "]

gmﬂmmm -C- 1PATIEN

04 f4-C-5Sking 10 @
05f5-C-5Sting 10 @

o : o

L b

4 |

For Help, press F1

string [32]strMsg;

strMsg = "Test";
#£f2[1] = strMsg;
//access single repeating field

#£3[1] = strMsg;

//access a field within a repeating composite

//The rule assigns a string value to 2 different fields, which are
//displayed in the diagram above, #£f2 and #f3 -- #£f2 is a single
//repeating field that can loop up to 10 times and #f3 is a field
//within a repeating composite where the composite can loop up to
//10 times.
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Example of a This diagram illustrates an example of a simple statement.
simple statement

IF THE
|SBGroup_Name.#Field_Namell ?#Field_Name|2;
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Using Extended Rules Overview

Common Statements and Examples

Overview

Introduction This section lists examples of some of the common statements.
» assignment
» datetime expressions
» conditional logic
» string conditions and functions
» numerical functions
» raise compliance error function
» remove field value function

» existence of data function
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Assignment

Introduction  The assignment statement is the most powerful and most often used extended rule
statement. In the most simple form, it is written as follows:

variable=expression

However, you can use this statement in more flexible and complex ways, defined as
follows:

numeric_variable=numeric_expression
numeric_field=numeric_expression
string_variable=string_expression
string_field=string_expression
datetime_variable=datetime_expression
datetime field=datetime expression

Numeric A numeric expression can consist of numbers, numeric fields, numeric variables, and
expression  numeric functions combined with the standard arithmetic operators.

String expression A string expression can consist of string constants, string fields, string variables, and
string functions concatenated with the “+” operator.

Datetime A datetime expression can consist of a datetime constant, datetime field or datetime
expression  variable.

Examples Some examples of assignment expressions are as follows:

= 5;
b + c;

= "hello";

= s + "world";

n n o o
I
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Datetime Expressions

Introduction Datetime expressions consist of a datetime variable and (optionally) datetime modifiers.
Datetime expressions can be written using datetime constants if you are using the standard
syntax, as follows:

year/month/day
hour:minute:second
year/month/day/hour:minute:second

Datetime expressions can also be written with datetime fields, variables, or using date and

time functions.

Date syntax Date functions are written as follows (month specified as 1-12):

datetime d;

d = date(1995,4,6);
d = date(1995,4,6,12,0);
d = date("%y/%m/%d", "95/4/6");

The d = date(" %Yy/%m/%d", ''95/4/6"); format enables you to convert any string format
type into a datetime format type by indicating a format mask ("' %y/%m/%d") along with
the string (''01/4/6"') you want to convert. You use this function if you are using non-
standard syntax and need to specify the syntax you are using.

<< operator You can use the << operator to modify your datetime variable by adding time increments
(e.g., days, weeks, years). For example:

datetime d;
d=d <<weeks (2);
//This adds 2 weeks to d.

Time syntax  Time functions are written as follows:

d
d

time (12,0);
time (12,0,59);

You can use the << operator to modify your datetime variable by adding time increments
(e.g., seconds, minutes, years). For example:

datetime d;
d=d <<seconds (1) ;
//This adds 1 second to d.
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Get and set syntax The get and set functions enable you to access (get) or modify (set) individual components
of a datetime type. These functions are used as follows:

integer a;
datetime d;

a = get days (d
a = get hours (
set hours(d,a);
set days (d,a);

)i
d);
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Conditional Logic

Introduction Gentran:Server uses conditional logic to test conditions and then, depending on the results
of the test, perform different operations. Conditions can be nested to any level. Do not end
conditions with a semicolon (;) — this terminating syntax is necessary for statements on/y.

IF..THEN...  You can use the IF/THEN keywords to execute one or more statements conditionally. The
ELSE condition is typically a comparison, but it can be any expression that concludes with a
numeric value. Gentran:Server interprets the value as either frue or false. The system
interprets a zero value as false and a nonzero value as true.

Note

If you include more than one statement in the body of an IF/THEN loop, you must
surround the statements with the BEGIN/END keywords. If you only use a single
statement, you can omit the BEGIN and END.

Gentran:Server evaluates the IF/THEN condition, and if it is true, the system executes all
the statements that follow the THEN keyword. If the condition is false, none of the
statements following THEN are executed.

You can use the ELSE keyword in conjunction with IF/THEN to define several blocks of
statements, one of which is executed. Gentran:Server tests the first IF/THEN condition. If
the condition is false, the system proceeds to test each sequential condition until it finds
one that is true. The system executes the corresponding block of statements for the true
condition. If none of the IF/THEN conditions are true, the system executes the statements
following the ELSE keyword.

Syntax
IF condition THEN

BEGIN
statementl;
statement2;

END

ELSE

BEGIN
statement3;
statement4;

END
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Example

Using Extended Rules

An example of when you may use conditional logic is if you need to evaluate whether an
N1 or NAD group contains billing or shipping information (this depends on the qualifier
that a field in the group contains), and then map that information to the appropriate

application fields.

For this example, you need to add an On End extended rule to the N1/NAD. The rule is
executed when the group terminates. An example of the syntax of the rule follows:

IF #0098 = "BT"

BEGIN
$Group Name.
$Group Name.
$Group Name.
$Group_ Name.
$Group_ Name.
$Group_ Name.

END

IF #0098 = "sT"

BEGIN

$Group Name.
$Group Name.
$Group Name.
$Group Name.
$Group Name.
$Group Name.

END

THEN

#BILLTONAME =
#BILLTOADDRL
#BILLTOADDR2
#BILLTOCITY
#BILLTOSTATE
#BILLTOPCODE

THEN

#SHIPTONAME
#SHIPTOADDRL1
#SHIPTOADDR2
#SHIPTOCITY
#SHIPTOSTATE
#SHIPTOPCODE

Gentran:Server for Windows — August 2008

#0093;
= #0166;
= #0166:2;
= #0019;
= #0156;
= #0116;

= #0093;
#0166;
#0166:2;
= #0019;
= #0156;
#011l6;
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String Conditions and Functions

Introduction You can use string conditions in IF/THEN and IF/THEN/ELSE statements to perform
comparisons between strings. Examples of the syntax are as follows:

IF sl = s2 THEN
IF sl < s2 THEN
IF sl > s2 THEN

The following string functions are also available for you to use:

» left

» right

» mid

» strdate
D concat
D strstr

Left, right, mid The left, right, and mid functions enable you to extract substrings from a string. The left
syntax function extracts a specified number of characters from the left of the string variable or
field and returns the result as a string. The right function extracts a specified number of
character from the right of the string variable and returns the result as a string. The mid
function extracts from a specified position in the string to the right, for a specified number
of characters. This is an example of how the statements are used.

string[10] s;
string[3] sl;
string[3] s2;
string[4] s3;
string[7] s4;

s = "abcdefghij";
sl = left(s,3);
s2 = right(s,3);
s3 = mid(s,3,4);

Strdate syntax The strdate function converts a datetime type into a string using a format that you specify.
This function allows you to include static characters such as a slash (/), which gives you
access to full date support.

Syntax
datetime d;
string[8] s;

strdate(d, "$y/%m/%d", s) ;
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Concat syntax The concat function concatenates a specified number of characters from one string onto
the end of another string. The following example demonstrates the syntax to concatenate
five characters from string “s2” onto the end of string “s1”:

string[10] sl1,s2;
concat (sl,s2,5);

Strstr syntax The strstr function finds a substring inside a string. This function returns the position of
the first instance of the designated substring. If this function does not find the specified
substring inside the string, it returns a value of -1.

Syntax

integer d;

d = strstr("hello", "el");
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Numerical Functions

Introduction The numerical functions enable you to convert one data type to another. The numerical
functions that are available for you to use are the following:

» len
» atoi
» aton
D ntoa

Len syntax The len function counts and returns the number of characters in a string.

Example
integer a;
a = len("hello");

Atoi, aton, ntoa The atoi function converts strings into integers.

syntax
The aton function converts string into real numbers.

The ntoa function converts integers and real numbers into strings.

Example
integer a;
real b;
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Raise Compliance Error Function (CERROR)

Introduction The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the translation report.

Syntax
cerror (100, SILD[0][1][1].#VATC);

The above example raises compliance error 100 on the VATC element of the specified
instance of the ILD group. You typically specify this function as a action to be performed
if a condition is false.
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Using Extended Rules Remove Field Value Function (EMPTY)

Remove Field Value Function (EMPTY)

Introduction The empty function sets the value of a field in internal storage to null. This function is not
the same as setting the value of a field to a zero length string (" ") or to zero.

Syntax
empty (SILD[0] [1] [1].#VATC) ;

The above example sets the value of the specified instance of the VATC element to null.
This function is typically used to prevent output to the specified field.
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Existence of Data Function (EXIST)

Introduction

The exist function tests to determine if a field is empty (null). It returns a non-zero (true)
value if there is data in a specified field in internal storage. If data is not present in the
specified field, this function returns a zero (false) value. This function is typically used as
a part of a condition.

Syntax
IF exist (SILD[O0][1][1].#VATC) THEN

The above example returns a non-zero value if the condition is true (data is present in the
specified instance of the VATC element). A zero value is returned if the condition is false
(no data is present in the specified instance of the VATC element).

There are some situations when the IF EXIST returns a non-zero (true) value whether or
not the condition is true. You can work around this by only using IF EXIST for date- and
number-type fields. Be certain that all references to the field which is interrogated are

nested within the IF EXIST begin block. For string-type fields, use the following format:

IF Fieldl =" "
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Count Function (COUNT)

Introduction The count function returns the total number of times a group (or repeating record) has
iterated.

Syntax
count (GROUPNAME [3] [*]) ;

The above example returns the total iterations of the GROUPNAME group within the
third iteration of the parent group.
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Delete Function (DELETE)

Introduction The delete function deletes the specified iteration of a repeating record or group.

Syntax
delete (GROUPNAME [iteration]) ;
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File Pointer Functions (FSEEK, FTELL)

Introduction The fseek function moves the file pointer to a new location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of the file or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current file is “0.” To
invoke the fseek function against the output file, the value for current file is “1.” The
fseek function is typically only used in conjunction with the ftell, readblock, and
writeblock functions.

Syntax

fseek (current file,offset,origin);

The ftell function obtains the current position of the file pointer and returns it as an integer.
To invoke the ftell function against the input file, the value for current_file is “0.” To
invoke the ftell function against the output file, the value for current file is “1.” The fseek
function is typically only used in conjunction with the fseek, readblock, and writeblock
functions.

Syntax

numeric variable = ftell (current file);
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Block of Data Functions (READBLOCK, WRITEBLOCK)

Introduction

The readblock function reads a block of data (segment or record) from the input file and
places it into the argument of a string variable. The writeblock function writes the data
contains in the argument of a string variable to the output file.

The readblock and writeblock functions are used in conjunction with each other to pass a
block of data from the input file to the output file without compliance checking or testing
for proper EDI syntax. Together these functions provide a more efficient alternative of
using “wildcard” segments, which are typically implemented in build and break maps.

Syntax

readblock (string variable);
writeblock(string variable);

Note
See the “XML Build and Break Maps” appendix in the XML User's Guide for special
considerations when using these functions with XML data.

6
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Using Extended Rules Select Function (SELECT)

Select Function (SELECT)

Introduction The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and “receiverlist” can be a string field, string
variable, or string literal. It is important to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax
select fieldname into receiverlist from tablename where key
expression [and key = expression];
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Update Function (UPDATE)

Introduction

The update function allows information in the database tables to be updated. This function
is similar to the Update standard rule, except that it provides more flexibility. Only the
tables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It is important to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax

update tablename set fieldname =expression [fieldname =expression]
where key = expression [and key = expression];

6
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Using Extended Rules Insert Function (INSERT)

Insert Function (INSERT)

Introduction The insert function allows information in the database tables to be updated.

Syntax

insert into tablename [ (fieldlist) ] [ (valuelist) 1,
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User Exit Function (EXEC)

What is a user
exit?

Placing the
extended rule

Allowable data
types

A user exit is an extended rule that enables the map to temporarily exit translation to
enhance your functionality or fulfill specific requirements that Gentran:Server does not
perform during normal translation.

Reference
See the User Exits, Appendix B, for more information on user exits.

You can use the exec function in an extended rule for a map component at any hierarchical
level, including field level extended rules, if appropriate.

Note
When you apply a user exit to a map component, subordinate map components may also
be able to execute the same user exit.

These are the extended rule data types that you can use with exec:

» INTEGER
» REAL

» STRING
Note

You cannot use date and time data unless you process it as a string data type.

6
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Using Extended Rules ActiveX and User Exit Functions

ActiveX and User Exit Functions

Introduction  Gentran:Server now supports additional extended rule functionality to allow you to use
Microsoft’s ActiveX Data Objects (ADO) from within extended rules, as well as
providing enhancements to user exit support.

ActiveX indexed  Gentran:Server now supports ActiveX indexed properties, specifically these types of
properties  index:

» variant
» numeric

» string

The index support allows you to use these syntaxes (if they are supported by your
Automation server):

n = ob.propertyl[l];
n = ob.property[“Count”];
ob.property[ob.method()];

n

Gentran:Server also supports chaining of ActiveX method calls and properties, which
simplifies extended rules for Automation servers with moderately complex object models
(e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.item[“MessageId”].value

Createobject The createobject function enables you to create an instance of an ActiveX Automation
syntax Server.

Syntax
object = createobject (“ProgID”);

ProgID is the programmatic identifier. An example of a ProgID is:
“InternetExplorer.Application”
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Deleteobject
syntax

Getiid syntax

Queryobject
syntax

The deleteobject function enables you to delete an instance of an ActiveX Automation
Server. An object must be deleted before the end of the map that uses it. It is more efficient
to delete the object immediately on completion (using the DELETEOBJECT command),
although the Gentran:Server translator will delete the object automatically at the end of
the map. Also, if you assign one object to another one, both copies of the object must be
deleted for that object to be properly unloaded.

Syntax
deleteobject (object) ;

The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

Syntax

string variable = getiid (“ProgID”, “InterfaceID”);

InterfaceID (IID) is the interface identifier. An example of an IID is:
“I'WebBrowser2”

The queryobject function is used to request a different interface on an existing object.

Syntax
object2 = queryobject (objectl, "{IID}");

Note

You may not use extended rules that compare two ActiveX properties or method results, or
any combination of properties or method results. This type of comparison is invalid
because property and method types are unknown prior to compilation and thus it is not
possible to generate the correct comparison code.

6
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Using Extended Rules Overview

Alphabetic Language Reference

Overview

Introduction This section contains an alphabetic reference for the Gentran:Server proprietary
programming language keywords and commands. This enables you to quickly and easily
refer to information on specific keywords or commands.

Typeface  This table lists the typeface conventions used in this section.

conventions
IF the typeface follows this
example... THEN it is used to indicate...
While what you need to type.
condition in syntax, information that you need to provide.
[1] that, in syntax, items inside square brackets are
optional.

Typeface The following programming guidelines are utilized in this section:
conventions » Keywords and commands are shown in all lower case letters.
» Map components are shown in all upper case letters.

» A double slash (//) introduces comments.

» Lines that are too long to fit on one line in this section may be continue on the next
line using a line-continuation character (A).
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atoi

Introduction The atoi function is a numerical function that converts strings into integers. The numerical
functions enable you to convert one data type to another.

Syntax  int = atoi(string);

where: int = integer variable
string =  string variable

Example integer a;
string[20] s;
s = "5";
a = atoi(s);
// "a" contains the value 5
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Using Extended Rules aton

aton

Introduction The aton function is a numerical function that converts strings into real numbers. The
numerical functions enable you to convert one data type to another.

Syntax  real = aton(string);

where: real = real number variable
string =  string variable

Example real a;
string[20] s;
s "5.5";
a = aton(s);
// "a" contains the value 5.5
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auditlog

Introduction

Syntax

MessagelD

Type

Key

Using Extended Rules

The auditlog function enables you to write user-defined audit messages to the
Gentran:Server Audit Log. When an extended rule that calls an auditlog operation is
executed, it writes the specified user-defined message to the Audit Log.

Note
This function does not return a value.

auditlog(MessagelD, Type, Key, [, stringl] [, string2] [, string3] [, string4] [, string5]
[, string6] [, string7];

The first parameter, MessagelD, is the user-defined audit message identifier, which much
be an integer value.

The second parameter, Type, is a keyword that identifies the type of audit message. These
pre-defined keywords are valid for Gentran:Server:

» AL PROC (processing)
» AL MSG (message)
Note

You may also supply an integer value to account for a type for which a keyword is
not currently defined.

The third parameter, Key, is a keyword that is either zero (if the type of parameter two is
“AL_PROC?”) or the identification of a piece of data of the specified type. These pre-
defined keywords are valid for Gentran:Server:

» AL KEY INPUT
» AL KEY OUTPUT
Note

You may also supply an integer value to account for a key for which a keyword is
not currently defined.
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Using Extended Rules auditlog

Parameters 4 Parameters four through ten are optional string values that the user-defined message may
through 10 require to fill in variables defined in the audit message.

Examplel auditlog (MessageID, AL PROC, 0, ...);
//Issues a processing message in any map.

Examplez auditlog (MessageID, AL MSG, Oatoi(param(l)), ...);
//Issues a data audit for the message which is currently
//processing.
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begin

Introduction Gentran:Server uses conditional logic to test conditions and then, depending on the results
of the test, perform different operations. Conditions can be nested to any level. You can
use the if/then keywords to execute one or more statements conditionally. If you include
more than one statement in the body of an if/then loop, you must surround the statements
with the begin/end keywords. If you only use a single statement, you can omit the begin
and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statementl;
statement2;
end
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Using Extended Rules break

break

Introduction The break function terminates the execution of the nearest enclosing while loop, and
passes control to the statement that follows the end keyword. The break keyword is
generally used in complex loops to terminate a loop before several statements have been
executed.

Exanqﬂe integer 1
i=0;

While i<10 do

Begin
#Total = Total + 50;
i=1i+ 1;

If #Total > 100000
Break;
Else
Continue;
End
//While the value contained in the variable "i" is less than ten,
//50 will be added to the field Total.
//If the value in the field Total becomes greater than 100000
//before "i" equals 10, break out of the while loop else continue
//processing until "i" equals 10.
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cerror

Introduction

Syntax

Example

Compliance error
codes

Using Extended Rules

The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the translation report. You typically specify this function as a
action to be performed if a condition is false. This table describes when the cerror function
is supported in Gentran:Server.

IF the map/form is of
type... THEN the cerror function is...

Screen entry Not valid.
Print Not valid.
Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.
Break (Interchange, Only valid on the input side of the map.
Group, or Transaction
Set)
Build (Interchange, Not valid.
Group, or Transaction
Set)

cerror(error_number, 5GROUP_NAME][index][index][index].
A#FIELD NAME);

cerror (100, $ILD[O] [1][1].#VATC);
//This raises compliance error 100 on the VATC element of the
//specified instance of the ILD group

The compliance error codes are as follows

Error
Number Error Generated
100 Mandatory Element
105 Conditional Element
110 Incorrect Element Format
111 Invalid Date
112 Invalid Time
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cerror

(Contd)
Error
Number

Error Generated

113

Invalid String

114

Invalid Number

115

Incorrect Element Length

116

Element Too Short

117

Element Too Long

118

Invalid Overpunch Data

119

Invalid Numeric XData

120

Too Many Components

121

Too Many Elements

125

Element Delimiter

130

Conditional Relation

135

Element Code

140

Standard Rule Failure

145

Binary Substitution Failed

200

Mandatory Component

205

Conditional Component

210

Incorrect Component Format

215

Incorrect Component Length

220

Component Delimiter

225

Component Code

300

Mandatory Segment

305

Segment Sequence

310

Invalid Start End

315

Incorrect Block Format

320

Segment Terminator

Application Integration User’s Guide
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Using Extended Rules

(Contd)
Error

Number Error Generated
330 Unexpected Segment
400 Session Error
405 Unknown Partner
410 Invalid Control Number
415 Invalid Sub Count
420 Unknown Relationship
425 Unknown Standard
430 Unknown Version
435 Unknown Transaction
440 Duplicate Control Number
445 Duplicate Doc Name
500 ActiveX Bad Param Count
505 ActiveX Bad Argument Type
510 ActiveX Unknown Name
515 ActiveX Type Mismatch
520 ActiveX Missing Required Param
525 ActiveX Server Unavailable
530 ActiveX Object Not Created
535 ActiveX Other Error
600 XML Element Type Match
601 XML Element Root Type
602 XML Element Required
620 XML Attribute Undeclared
621 XML Attribute Not Unique
622 XML Attribute Required
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cerror

(Contd)
Error

Number Error Generated
623 XML Attribute Fixed Error
624 XML Attribute ID Not Unique
625 XML Attribute ID REF Match
630 XML Attribute Parse Name Error
631 XML Attribute Parse Equal Error
632 XML Attribute Parse OQuote Error
633 XML Attribute Parse CQuote Error
640 XML Attribute Name Error
641 XML Attribute Names Error
642 XML Attribute NMToken Error
643 XML Attribute NMTokens Error
644 XML Attribute Entity Error
645 XML Attribute Entities Error
660 XML Reference Char Invalid
661 XML Reference Entity Recursion
662 XML Reference Entity Undeclared
699 XML Unknown Error
700 ODBC Data Source Open Error
701 ODBC Data Source Rollback
702 ODBC Data Source Commit Error
703 ODBC Data Source Rollback Error
710 ODBC Query Open Error
711 ODBC Command Error
712 ODBC Cursor Error
720 ODBC Output Table Error

Application Integration User’s Guide
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Using Extended Rules

(Contd)
Error

Number Error Generated
721 ODBC Output Operation Error
730 ODBC Mandatory Element
731 ODBC Data Conversion Error
732 ODBC Incorrect Element Format
733 ODBC Standard Rule Failure
799 ODBC Unknown Error
800 NCPDP BFHS Missing
801 NCPDP BFHS Seg ID Error
802 NCPDP BFHS Transmission Type Error
803 NCPDP BFHS Sender ID Missing
804 NCPDP BFHS Batch ID Error
805 NCPDP BFHS File Type Error
806 NCPDP BFHS Receiver ID MIssing
807 NCPDP BFDDR Missing
808 NCPDP BFDDR Seg ID Error
809 NCPDP BFDDR Transaction Ref Missing
810 NCPDP BFTR Missing
811 NCPDP BFTR Seg ID Error
812 NCPDP BFTR Batch ID Error
813 NCPDP BFTR Record Count Error
814 NCPDP BFTR Record Count Mismatch Error
815 NCPDP DR Repeating Segment Error
816 NCPDP DR Transaction Code Error
817 NCPDP DR Transaction Count Error
818 NCPDP DR Transaction Count Mismatch Error
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Using Extended Rules cerror

(Contd)
Error

Number Error Generated
819 NCPDP DR Header Response Code Error
820 NCPDP DR Transaction Response Code Error
830 NCPDP Null Char
832 NCPDP Invalid Char
833 NCPDP Unexpected EOF
835 NCPDP Unexpected STX
836 NCPDP Unexpected ETX
837 NCPDP Missing Stream Separator 1
838 NCPDP Missing Stream Separator 2
839 NCPDP Unexpected Separator
840 NCPDP Unexpected FS
841 NCPDP Unexpected GS
842 NCPDP Missing GS
845 NCPDP Positional Segment Tag Off
855 NCPDP Delimited Segment Empty
856 NCPDP Delimited Segment Missing First FS
857 NCPDP Delimited Field ID Invalid
858 NCPDP Delimited Field ID Invalid Char
859 NCPDP Delimited Field ID Null Char
860 NCPDP Delimited Field ID Incomplete
861 NCPDP Delimited Field Data Missing
862 NCPDP Delimited Field Data Null Char
863 NCPDP Delimited Field Data Invalid
864 NCPDP Delimited Field Data Invalid Char
865 NCPDP Delimited Segment ID Invalid

Application Integration User’s Guide Gentran:Server for Windows — August 2008
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(Contd)
Error

Number Error Generated
866 NCPDP Delimited Segment ID Invalid Char
867 NCPDP Delimited Segment ID Null Char
868 NCPDP Delimited Segment ID Incomplete
869 NCPDP Delimited Field ID Size
885 NCPDP Batch Nothing After STX
886 NCPDP Batch Unexpected STX
887 NCPDP Batch Missing ETX
888 NCPDP Batch Data File Open
890 NCPDP Data Field String Separator
891 NCPDP Data Field String No Filename
892 NCPDP Data Field String Start Byte
893 NCPDP Data Field String End Byte
894 NCPDP Data Field String Incomplete
895 NCPDP Data Field String Extra Characters
896 NCPDP Data Field Size Incorrect
897 NCPDP Data Field Start Out of Bounds
898 NCPDP Data Field Start Beyond End
899 NCPDP Unknown Error
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concat

Introduction The concat function concatenates a specified number of characters from one string onto
the end of another string.

Syntax concat(string,string,num_char);

where: string = string variable
num_char number of characters from the second string onto the
end of the first string

Note
You may not use an ActiveX property as the first parameter of the concat function because
the length of the property is unknown prior to compilation.

Example string[20] sl,s2;
sl = "Sterling";
s2 = "Commerce";

concat (sl,s2,8);
//Concatenate eight characters from string "s2" onto the end of

//string "sl1"
// sl will now contain the value "Sterling Commerce".
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continue

Introduction  The continue function continues the execution of the innermost loop without processing
the statements in the loop that follow the continue statement.

Exanqﬂe integer 1
i=0;

While i<10 do

Begin
#Total = Total + 50;
i=1i+ 1;

If #Total > 100000
Break;
Else
Continue;
End

//While the value contained in the variable "i" is less than ten,
//50 will be added to the field Total.

//1f the value in the field Total becomes greater than 100000
//before "i" equals 10, break out of the while loop else continue
//processing until "i" equals 10.
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count

Introduction The count function counts and returns the number of iterations of a group. An example is
as follows:

integer i;
i = count ($N1[*]);

//The [*] is a wildcard that counts the number of iterations of the //
N1 group.
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createobject

Introduction The createobject function enables you to create an instance of an ActiveX Automation
Server.

Syntax object = createobject("ProgID");

where: ProgID = programmatic identifier

Example object ob;
ob = createobject ("InternetExplorer.Application");
//Creates an instance of the default interface of an ActiveX
//Automation Server.
//Note:
//The createobject command is more efficient if you use the IID
//instead of the interface name.
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date

Introduction

Syntax

Example

Format specifiers

date

The date function converts a string type into a datetime type using a format that you
specify. This function allows you to include static characters such as a slash (/), which
gives you access to full date support.

Datetime = date("format",string);

where: datetime = datetime variable (month specified as 1-12)
format = desired date format
string = string variable

datetime d;

d = date(1995,4,6);

d = date(1995,4,6,12,0);

d = date("%y/%m/%d","95/4/6");
d = date("%y/%m/%d", #strdate) ;

This table lists the format specifiers.

Format Specifier Description

%8 ISO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
seconds in Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z)

Note
This date format cannot be combined with any other
format specifier.

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%d Day of the month as a decimal number (01 —31)
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(Contd)
Format Specifier Description

%D ISO-8601 date format (date component only)
Format
YYYYMMDDZ
Note
This date format cannot be combined with any other
format specifier.

%H Hour in 24-hour format (00 — 23)

%I Hour in 12-hour format (01— 12)

%j Day of the year as a decimal number (001 — 366)

%m Month as a decimal number (01 — 12)

%M Minute as a decimal number (00 — 59)

%S Second as a decimal number (00 — 59)

%U Week of the year as a decimal number, with Sunday as the
first day of the week (00 — 51)

Yow Weekday as a decimal number (0 — 6, with Sunday as “0”)

%W Week of the year as a decimal number, with Monday as the
first day of the week (00 — 51)

%y Year without the century as a decimal number (00 — 99)

%Y Year with the century as a decimal number

%% Percent sign

( Gentran:Server for Windows — August 2008 Application Integration User’s Guide



Using Extended Rules delete

delete

Introduction The delete function deletes a specified occurrence of a group.

Syntax  delete(SGROUP_NAME[N));

where [n] is the occurrence of the group that you wan to delete.

Example  delete(s11D([2]);
//Deletes the second occurrence of the ILD group.
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deleteobject

Introduction

Syntax

Example

Using Extended Rules

The deleteobject function enables you to delete an instance of an ActiveX Automation
Server. An object must be deleted before the end of the map that uses it. It is more efficient
to delete the object immediately on completion, although the Gentran:Server translator
will delete the object automatically at the end of the map. Also, if you assign one object to
another one, both copies of the object must be deleted for that object to be properly
unloaded.

deleteobject(object);

object ob;

ob = createobject ("InternetExplorer.Application”);
deleteobject (ob) ;

//Deletes the instance of the object.

6
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empty

Introduction

Syntax

Example

empty

The empty function sets the value of a field in internal storage to null. This function is not
the same as setting the value of a field to a zero length string (" ") or to zero.

empty($GROUP_NAME]index][index][index]. #FIELD NAME)

empty (SILD. #VATC) ;

//Set the value of the specified instance of the VATC element
//to null
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end

Introduction Gentran:Server uses conditional logic to test conditions and then, depending on the results
of the test, perform different operations. Conditions can be nested to any level. You can
use the if/then keywords to execute one or more statements conditionally. If you include
more than one statement in the body of an if/then loop, you must surround the statements
with the begin/end keywords. If you only use a single statement, you can omit the begin
and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statementl;
statement2;
end
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€xec

Introduction The exec function invokes the execution of a batch file or program. The translator waits
until the script finishes before continuing with translation. After the script runs and returns
a numeric return code, the exec function:
» Retrieves the return code
» Returns to translation

» Uses the return code in translation.

Note
You must set an integer value equal to the return value of the exec (...) call for the
rule to compile.

Syntax  nReturn = exec(string)

where:
nReturn = return value
string = string variable or literal value that represents the shell script

Example integer nReturn;
nReturn = 0;
nReturn = exec (“c:\addrunm.sh”);
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exist

Introduction

Syntax

Example

Using Extended Rules

The exist function tests to determine if a field is empty (null). It returns a non-zero (true)
value if there is data in a specified field in internal storage. If data is not present in the
specified field, this function returns a zero (false) value. This function is typically used as
a part of a condition.

There are some situations (for example, if the field or element has a "Use Code" standard
rule applied to it) when the IF EXIST returns a non-zero (true) value whether or not the
condition is true. You can work around this by only using IF EXIST for date- and number-
type fields. Be certain that all references to the field which is interrogated are nested
within the IF EXIST begin block.

For string-type fields, use the following format:

IF Fieldl =""

if exist(SGROUP_NAME[index][index][index]. #FIELD_NAME) then

if exist (SILD.#VATC) then
#TEMPiFIELD = #VATC;

//Return a non-zero value if the condition is true (data is present
//in the

//specified instance of the VATC element). A zero value is returned
//if the condition is false (no data is present in the specified
//instance of

//the VATC element).
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fseek

Introduction

Syntax

Example

fseek

The fseek function moves the file pointer to a new location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of the file or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current file is “0.” To
invoke the fseek function against the output file, the value for current file is “1.” The
fseek function is typically only used in conjunction with the ftell, readblock, and
writeblock functions.

fseek(current_file,offset,origin);

where: current file = 0 indicates the input file; 1 indicates the output file

offset The position to which the file pointer is moved relative

to the origin.

origin = The keyword depends on the starting location:
begin = start at beginning of the file
end = start at the end of the file

current = start at the current position in the file

string[1024]temp buffer;
Integer Position;

Position = ftell (0);

while readblock(temp buffer) do

begin
if left(temp buffer,3) = "IEA" then
begin
fseek (0, Position,begin);
break;
end

writeblock (temp buffer);
Position = ftell (0);

end
//Read a segment from input file and place in temp buffer. Look for
//"IEA" segment tag. If found, reset file pointer to where it was
//before the "IEA" segment was read. Write contents of temp buffer
//to output file. Set "Position"™ = the current file pointer
//position.
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ftell

Introduction

Syntax

Example

Using Extended Rules

The ftell function obtains the current position of the file pointer and returns it as an
integer. To invoke the ftell function against the input file, the value for current file is “0.”
To invoke the ftell function against the output file, the value for current file is “1.” The
fseek function is typically only used in conjunction with the fseek, readblock, and
writeblock functions.

numeric_variable = ftell(current_file);

string[1024]temp buffer;
Integer Position;
Position = ftell (0);
while readblock(temp buffer) do
begin
if left(tem buffer,3) = "IEA" then
begin
fseek (0, Position,begin);
break;
end
writeblock (temp buffer);
Position = ftell(0);
end
//Read a segment from input file and place in temp buffer. Look for
//"IEA" segment tag. If found, reset file pointer to where it was
//before the "IEA" segment was read. Write contents of temp buffer
//to output file. Set "Position"™ = the current file pointer
//position.
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get

Introduction The get function enables you to access individual components of a datetime variable.

Syntax integer variable = get datetime component (datetime_variable);

where: integer variable = integer variable

datetime _component individual component of the datetime
variable
datetime variable of which you want to
access a component part

datetime variable

Exanqﬂe integer temp days;
integer temp hours;
datetime d;
temp days = 0;
temp hours = 0;
d = '12/25/2001 12:15:30"';//A fields value in the map can be
// assigned to the datetime variable "d"
//or a hard coded value can be assigned.

temp days = get days (d);
temp hours = get hours (d);

//Accesses the days from the datetime variable "d" and loads into
//variable " temp days ". Accesses the hours from the datetime
//variable "d" and loads into variable "temp hours".
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getiid

Introduction

Syntax

Example

Using Extended Rules

The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

This creates an instance of the default interface of an ActiveX Automation Server.
string_variable = getiid("ProgID");
This looks up the InterfacelD (IID) of an interface.

string_variable = getiid("ProgID", "Interface Name or {Interface ID}");

object ob;

string[50] iid;

iid = getiid("InternetExplorer.Application", "IWebBrowser2");
ob = createobject ("InternetExplorer.Application™, iid);
ob.Visible = 1;

//Displays the Internet Explorer on the desktop by setting a
//property value in an ActiveX Automation Server.

6
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if then...else

Introduction The if, then, and else keywords allow the use of conditional logic. Gentran:Server uses
conditional logic to test conditions and then, depending on the results of the test, perform
different operations. Conditions can be nested to any level. You can use the if/then
keywords to execute one or more statements conditionally. The condition is typically a
comparison, but it can be any expression that concludes with a numeric value.
Gentran:Server interprets the value as either true or false. The system interprets a zero
value as false and a nonzero value as true.

Gentran:Server evaluates the if/then condition, and if it is true, the system executes all the
statements that follow the then keyword. If the condition is false, none of the statements
following then are executed.

You can use the else keyword in conjunction with if/then to define several blocks of
statements, one of which is executed. Gentran:Server tests the first if/then condition. If the
condition is false, the system proceeds to test each sequential condition until it finds one
that is true. The system executes the corresponding block of statements for the true
condition. If none of the if/then conditions are true, the system executes the statements
following the else keyword.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Example  if condition then
begin
statementl;
statement2;
end
else
begin
statement3;
statement4;
end
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index

Introduction

Syntax

Example

Using Extended Rules

The index function enables you to determine which instance of a particular loop the
translator is currently accessing.

index(integer variable);

where: integer variable = integer variable that indicates the
hierarchical level for which you want to
determine the loop count

index (1)

//This extended rule is located on the ILD group in the diagram
//below. This determines the current loop count for the first level
//(0ODD) in the hierarchical structure.

INVOIC -M- INVOICE DETAILS £F
00D -M- 993399 £F-
ILD M- 999999 &7
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insert

Introduction The insert function allows information in the database tables to be updated.

Syntax insert into tablename [ (fieldlist) ] [ (valuelist) 1],

where: tablename DivisionLookup | PartnerLookup | DivisionLocation
PartnerLocation | DivisionXref | PartnerXref

fieldlist ( fieldname [, fieldname | )
fieldname The name of one of the fields in the table.
valuelist ( String [, String ] )

Notes
» A list of the tables is available later in this chapter.

» The fieldlist lists one or more fieldnames to which data is to be added.
» The fieldnames can be listed in any order.

» The valuelist must be in the same order as the field list.
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Exanuﬂe updateStatus = update PartnerLookup
set Description = "Lookup Update
Test", Textl="TextlUpdated", Text2="Text2Updated", Text3="Text3Updated", T
ext4="Text4Updated"
where TableName = "PartLkp" and Item = "1";

if updateStatus = 1 then

begin

_ messagebox ("Update PartnerLookup: Record Not Found, Attempting
Alnsert...",1);

. insertStatus = insert into PartnerLookup( PartnerKEY, TableName,

AlItem,Description, Textl, Text2,Text3, Text4)
Ava}ues ("PETZONE", "PartLkp","1", "Lookup Insert
ATest","Textl","Text2","Text3","Text4");

if insertStatus = 0 then
begin
messagebox ("Insert PartnerLookup: Failed",1);
end
end

if updateStatus = 2 then
begin

messagebox ("Update PartnerLookup Failed with OtherError",1);
end
//Example assumes that a lookup table named "PartLkp" has been
//created.
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left

Introduction The left function extracts a specified number of character from the left side of a string
variable or field and returns the result as a string.

The syntax is as follows:
string_variable = left(string variable,num_char)

where: num _char = integer variable

Note
You may not use an ActiveX property as the first parameter of the left function because
the length of the property is unknown prior to compilation.

Example string [25]name;
string [5]temp variable;
name = "Acme Shipping Company"
temp variable = left (name,4);
// "temp variable" would contain "Acme"
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len

Introduction The len function is a numerical function that counts and returns the number of characters
in a string. The numerical functions enable you to convert one data type to another.

Syntax number_char = len(string);

where: num_char = integer variable

Example integer a;
a = 0;
a = len("hello");
// "a" contains the value 5
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messagebox

Introduction

Syntax

Example

Defined
numbers

messagebox

The messagebox function enables you to display a message box for which you have
designated the format and content. You can specify the number and type of buttons on the
message box, the message icon (e.g., hand, question mark, exclamation point, or asterisk),
and the message displayed. You can also issue a return value based on the chosen action.

Note
Only String values can be displayed in a message box.

messagebox("message",defined number)
where:  message = message string

defined number defined number of the desired buttons plus the
defined number of the desired icon (if used)

if messagebox ("Do you really want to delete this object?",36) = 6
begin

end

//Displays a message box with the given string as the message, Yes
//and No buttons (4) and a question mark icon (32). The number and
//type of buttons (4) plus the icon (32) equals the defined number

//(36). If the user clicks the Yes button (return value "6"), the
//statements in the begin/end loop are executed.

This table lists the defined numbers for the button and icon types.

Defined_Number Button or Icon Types
0 OK button only
1 OK and Cancel buttons
4 Yes and No buttons
16 Icon Hand
32 Icon Question Mark
48 Icon Exclamation Point
64 Icon Asterisk
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Message box  This table lists the message box return values.
return values

Return Value Action Selected
1 OK selected
2 Cancel selected
6 Yes selected
7 No selected
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mid

Introduction The mid function extracts from a specified position in a string, either to the end of the
string or for a specified number of characters and returns the resultant string. This function
is zero-based.

Syntax string_variable = mid(string_variable,start pos,num_char)

where: start_pos = integer variable
num_char integer variable

Note
You may not use an ActiveX property as the first parameter of the mid function because
the length of the property is unknown prior to compilation.

Example string [25]name;
string [10]temp variable;
name = "Acme Shipping Company"
temp variable = mid(name,5,8);
// "temp variable" will contain "Shipping"
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ntoa

Introduction

Syntax

Example

Using Extended Rules

The ntoa function is a numerical function that converts integers and real numbers into
strings. The numerical functions enable you to convert one data type to another.
string = ntoa(integer/real,string);

where: integer/real = integer or real number variable
string string variable

Integer b;

string[8] s;

b = 5.5;

ntoa (b, s) ;

//The variable "s" contains the string "5.5".

6
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param

Introduction

Syntax

Example

param

The param function is used to read the value of the PARAM(n) variable. The extended
rule allows you to reference values that have been passed into the translator via the
command line. The -u switch can be used during the invocation of the translator to pass
values in so they can be referenced by an extended rule. Typically, the param extended
rule is not used by maps that are running within the Gentran:Server for Windows
environment because Gentran:Server does not use the -u switch when invoking the
translator. However, if you are invoking the translator to perform translation outside of
Gentran:Server (tx32 -f <inputfile> <templatefile> <outputfile> <reportfile>), you have
the option to pass values into the translator via the -u switch and reference those values
using the param extended rule.

param(integer PARAM number);
where: interger PARAM_ number = the number of the pre-defined variable

For example, if you invoke TX32.EXE in the following manner:

tx32.exe -f input.txt 850.tpl output.txt out.rpt -u
"PurchaseOrderNumber" -u 12345 -u 500.25

Then you could write an extended rule in the \GENSRVNT\Tutorial\Pet 850.map that
looks like the following:

string [32] strDescription;
string [32] strPONbr;
string [32] strTotalCost;
real nTotalCost;

strDescription = param(0);
strPONbr = param(l);
strTotalCost = param(2);
nTotalCost = aton(strTotalCost);

if nTotalCost > 200 then
begin

messagebox ("Get approval from boss",0);
end

You can run this rule from any scope in your map (e.g., pre-session, post-session, group
onbegin, field, etc.).
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queryobject
Introduction The queryobject function is used to request a different interface on an existing object.

Syntax object2 = queryobject(objectl, "{IID}");

where: object2 = is the result that contains the requested interface to
the object
11D = is the interface identifier of the requested interface
objectl = an existing object

Example object ob, ob2;
ob = createobject ("InternetExplorer.Application”);
ob2 = queryobject (ob, "{EAB22AC1-30C1-11CF-A7EB-A0000CO5BAEOB}") ;
//Uses the Interface ID of the desired interface to obtain another
// (different) interface of the existing object (objectl).
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readblock

Introduction The readblock function reads a block of data (segment or record) from the input file and
places it into the argument of a string variable.The readblock and writeblock functions are
used in conjunction with each other to pass a block of data from the input file to the output
file without compliance checking or testing for proper EDI syntax. Together these
functions provide a more efficient alternative of using “wildcard” segments, which are
typically implemented in build and break maps.

Note
See the “XML Build and Break Maps” appendix in the XML User's Guide for special
considerations when using this function with XML data.

Syntax readblock(string_variable);

Note
You may not use an ActiveX property as the first parameter of the readblock function
because the length of the property is unknown prior to compilation.

Example while readblock(temp buffer) do
begin
if left(temp buffer,3) = "IEA" then
begin
fseek (0, Position,begin);
break;
end
writeblock (temp buffer);
Position = ftell(0);
end
//Read segment from input file and place in temp buffer. Look for
//"IEA" segment tag. If found, reset file pointer to where it was
//before the "IEA" segment was read. Write contents of temp buffer
//to output file. Set "Position"™ = the current file pointer
//position.
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readbytes

Introduction  The readbytes function reads a number of bytes from the input file. This function is used
in conjunction with the writebytes function. Used together, the readbytes and writebytes
function provide an efficient method of passing data through a map if the data does not
need to be compliance checked or altered in any way.

Readbytes is similar to the readblock function, but readblock only works with entire
blocks (i.e., an entire segment or record), and readbytes works with any quantity of data,
whether it is smaller or larger than a block.

The readbytes function uses two parameters, first the string variable into which the data
being read will be stored, and second the number of bytes to read.

Syntax readbytes(read from_buffer, num_bytes);

where: read from_ buffer= string variable into which the data being read will be
stored
num_bytes = integer value representing the number of bytes to read
from the input file.

Note
Readbytes returns the number of bytes it was actually able to read.

Example string [1024] tempBuffer;
while readbytes (tempBuffer,1024) do
begin
writebytes (tempBuffer,1024);
End
//Read 1024 bytes from input file and place in string variable
//named tempBuffer.

writebytes (""0D"0A",2) ;
//Appends a CRLF to the end of the output file.

6
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right

Introduction The right function extracts a specified number of characters from the right side of a string
variable or field.

Syntax string_variable = right(string_variable,num_char)

where: num_char = integer variable

Note
You may not use an ActiveX property as the first parameter of the right function because
the length of the property is unknown prior to compilation.

Example string [25]name;
string [10]temp variable;
name = "Acme Shipping Company"
temp variable = right (name,7);
// "temp variable" would contain "Company"
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select

Introduction

Syntax

Example

Using Extended Rules

The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and "receiverlist” can be a string field, string
variable, or string literal. It is important to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

select fieldname into receiverlist from tablename where key = expression [and key =
expression];

string[l0]temp varl, temp var2,temp var3;

select Textl, Text2, Text3 into temp varl, temp var2, temp var3 Afrom
Partnerlookup where Tablename = "Test" and Item ="widgit"

//Example assumes that a Lookup table named "Test" has been
//created.

6
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set

Introduction The set function enables you to define individual components of a datetime variable.

Syntax set datetime component (datetime variable,integer variable);

where: datetime_component = individual component of the datetime
variable
datetime variable = datetime variable of which you want to

access a component part
integer variable

integer variable

Exanqﬂe integer temp days;
datetime d;
temp days = 15;
d = '12/25/2001"';//A fields value in the map can be
// assigned to the datetime variable "d"
//or a hard coded value can be assigned.

set days (d,temp_days);

//Defines the days of the datetime variable "d" from variable
//"temp days".
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strdate

Introduction The strdate function converts a datetime type into a string using a format that you specify.
This function allows you to include static characters such as a slash (/), which gives you
access to full date support.

Syntax strdate(datetime,"format",string);

where: datetime = datetime variable (month specified as 1-12)
format = desired date format
string = string variable

Example datetime d;
string[8] s;

d = #DateField;
strdate(d, "$y/%m/%d", s) ;

//Converts a datetime variable into an eight character string in
//the format "year/month/day".

Format specifiers  This table lists the format specifiers.

Format Specifier Description

%8 ISO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
seconds in Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z)

Note
This date format cannot be combined with any other
format specifier.

%a Abbreviated weekday name
%A Full weekday name

%b Abbreviated month name
%B Full month name
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strdate

(Contd)
Format Specifier

Description

%d

Day of the month as a decimal number (01 —31)

%H

Hour in 24-hour format (00 — 23)

%l

Hour in 12-hour format (01— 12)

%0j

Day of the year as a decimal number (001 — 366)

%m

Month as a decimal number (01 — 12)

%M

Minute as a decimal number (00 — 59)

%S

Second as a decimal number (00 — 59)

%U

Week of the year as a decimal number, with Sunday as the
first day of the week (00 — 51)

Y%w

Weekday as a decimal number (0 — 6, with Sunday as “0”)

%W

Week of the year as a decimal number, with Monday as the
first day of the week (00 — 51)

Yoy

Year without the century as a decimal number (00 — 99)

%Y

Year with the century as a decimal number

%%

Percent sign

Application Integration User’s Guide
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Introduction
zero-based.
Syntax integer = strstr("string

where: integer
string
substring

Example integer d;

strstr

Using Extended Rules

The strstr function finds a substring inside a string. This function returns the position of

the first instance of the designated substring within the specified string. If this function
does not find the specified substring in the string, it returns a value of -1. This function is

d = 0;

nn

E

substring");

integer variable
string
part of the string

d = strstr("mississippi","is");

//Finds the first instance of the substring "is" inside the string
//"mississippi" and returns the position of that first substring.

6
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unreadblock

Introduction The unreadblock function provides a method of moving the input file-pointer back one
block (a block of data is equivalent to one EDI segment or one positional record). This
function unreads the block of data that was just processed by the readblock function.

Note
Unreadblock should only be used in conjunction with the readblock function. The
unreadblock function will only unread the most recent block of data processed.

Unreadblock is provided as an alternative to using the fseek and ftell functions, and is the
preferred method of moving the file pointer back one block of data. Unreadblock allows
the translator to correctly track the number of bytes read and number of segments read
during the translation process by moving the file-pointer back and decrementing the
segment and byte counts accordingly.

Syntax unreadblock();

Example string[1024] tempBuffer;

while readblock (tempBuffer) do
begin
if left (tempBuffer,3) = "IEA" then
begin
unreadblock () ;
break;
end
writeblock (tempBuffer);
end

//Read segment from input file and place in tempBuffer variable.
//Look for the "IEA" segment tag and, if found, reset the file-
//pointer to where it was located before the "IEA" segment was
//read. Write contents of tempBuffer to output file.
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update

Introduction

Syntax

Example

Using Extended Rules

The update function allows information in the database tables to be updated. This
function is similar to the Update standard rule, except that it provides more flexibility.
Only the tables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It is important to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

This table describes how the update function is supported in Gentran:Server.

IF the map/form is of
type... THEN the update function is...

Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.
Break (Interchange, Only valid on the input side of the map.
Group, or Transaction
Set)
Build (Interchange, Only valid on the input side of the map.
Group, or Transaction
Set)
Print Not supported.
Screen entry Not supported.

update tablename set fieldname =expression [fieldname =expression] where key =
expression [and key = expression];

string[l5]temp variable;

temp variable = "5 Pound Hammer";
update PartnerXref set Textl = temp variable where MyItem = " and
ATablename = "Tools";

//Example assumes that a cross-reference table named "Tools" has
//been created.
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while...do

Introduction The while...do function executes a statement repeatedly until the specified termination
condition evaluates to zero. The system tests the terminating condition before each
iteration of the loop, so a while loop executes zero or more times depending on the value
of the termination expression.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Example integer i
i=0;

While i<10 do

Begin
#Total = Total + 50;
i=1i+ 1;

If #Total > 100000
Break;
Else
Continue;
End

//While "i" is less than 10 execute the loop.
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winexec

Introduction

Syntax

Example

Window display
numbers

Using Extended Rules

The winexec function enables you to execute another program while running the
translator. This program is executed asynchronously. You specify the program and
determine how you want the program window displayed. You can also return an error
code, if desired. If the error code is greater than 32, the program ran without errors. If the
error code is less than 32, the program did not run because of an error. If the error code is
“0,” the system is out of memory. If the error code is “2,” you didn’t specify a file name.
The error code is not the return value from the program you executed.

Note
» Ifyou specify a program on another machine or in another domain, you must have the
appropriate permission to access the specified folder.

» Iftranslation is executing from an unattended process control command, the user ID
under which that service is running must have the appropriate permission to access
the specified file.

winexec("program",window_display)

where: program = executable program name string (if necessary,
including UNC or direct file path)
window_display = number that indicates how you want the program

window displayed

winexec ("program.exe", 3)

//Exits Gentran:Server and executes the "program.exe"
//program asynchronously. The system displays the program window
//maximized (3).

The window_display numbers that control the appearance of the program window are as
follows (you must use the number to indicate how you want the program window
displayed, not the window_display value):

Number Window_Display Definition
0 SW_HIDE Hides the window and activates another
window.
1 SW_SHOWNORMAL Activates and displays a window. If the

window is minimized or maximized, it is
restored to the original size and position.
This flag should be specified when
displaying a window for the first time.

6

Gentran:Server for Windows — August 2008 Application Integration User’s Guide



Using Extended Rules

winexec

(Contd)
Number

Window_Display

Definition

1

SW_NORMAL

Activates and displays a window in the
original size and position.

SW_SHOWMINIMIZED

Activates the window and displays it as a
minimized windows.

SW_SHOWMAXIMIZED

Activates the window and displays it as a
maximized window.

SW_MAXIMIZE

Maximizes the window.

SW_SHOWNOACTIVATE

Displays the window in its most recent
size and position, but does not activate it
(the current active window remains
active).

SW_SHOW

Activates the window and displays it in
its current size and position.

SW_MINIMIZE

Minimizes the window.

SW_SHOWMINNOACTIVE

Displays the window as a minimized
window without activating it (the current
active window remains active).

SW_SHOWNA

Displays the window in its most recent
size and position without activating it
(the current active window remains
active).

SW_RESTORE

Activates and displays the window. If the
window was minimized or maximized, it
is restored to its original size and
position.

10

SW_SHOWDEFAULT

Activates the window and allows
Windows to determine the size and
position.
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writeblock

Introduction The writeblock function writes the data contains in the argument of a string variable to the
output file.The readblock and writeblock functions are used in conjunction with each other
to pass a block of data from the input file to the output file without compliance checking
or testing for proper EDI syntax. Together these functions provide a more efficient
alternative of using “wildcard” segments, which are typically implemented in build and
break maps.

Note
See the “XML Build and Break Maps” appendix in the XML User's Guide for special
considerations when using this function with XML data.

Syntax writeblock(string_variable);

Example while readblock(temp buffer) do
begin
if left(temp buffer,3) = "IEA" then
begin
fseek (0, Position,begin);
break;
end
writeblock (temp buffer);
Position = ftell(0);
end
//Read segment from input file and place in temp buffer. Look for
//"IEA" segment tag. If found, reset file pointer to where it was
//before the "IEA" segment was read. Write contents of temp buffer
//to output file. Set "Position"™ = the current file pointer
//position.
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writebytes

Introduction  The writebytes function writes a specified number of bytes to the output file. This
function is used in conjunction with the readbytes function. Used together, the readbytes
and writebytes function provide an efficient method of passing data through a map if the
data does not need to be compliance checked or altered in any way.

Note
The system does not append a segment terminator to the end of the string value written to
the output file.

Writebytes is similar to the writeblock function, but writeblock only works with entire
blocks (i.e., an entire segment or record), and writebytes works with any quantity of data,
whether it is smaller or larger than a block.

The writebytes function uses two parameters, first the string variable containing the data
to be written to the output file, and second the number of bytes to write.

Syntax  writebytes(write to buffer, num_bytes);

where: write to buffer = string variable containing the data to be written to the
output file
num_bytes = integer value representing the number of bytes to read
from the write to_buffer variable and write to the
output file

Note
If hex values are used in constants, use \Ox instead of .

Example  string [1024] temp buffer;
while readbytes (temp buffer,1024) do
begin
writebytes (temp buffer,1024);
End
writebytes (""0D"0A",2) ;

//Read 1024 bytes from input file and place in string variable Snamed
temp buffer.
//Bppends a CRLF after the while loop finishes executing.
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Select and Update Available Options

Introduction

Document

The following section contains the database table names and the associated field names
that are available when using the select and update extended rules. Additional keys are
also available for certain tables. Where applicable, a description of the key follows the
field name.

Note

When you use extended rules to reference a Gentran:Server database table, the syntax
used is different from the actual table name. The appropriate referencing syntax is outlined
for each table in this section.

Example
To refer to the Document_tb in an extended rule, you would reference Document.

These are the field names that are available when using the select or update extended rules
on the Document Table (Document _tb).

Note
This sub-table can only be accessed from the following map types; Transaction Break/
Build, Import, Export, Print, Screen, Group Build, and Interchange Build.

The information that is accessed will be the information of the last document that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to this table as Document.

» TESTMODE

» AGENCY
» VERSION
» TRANSACTIONSETID
» RELEASE

» DOCUMENTTYPE
» REFERENCEDATA
» DOCUMENTNAME
» APPFIELDI

» APPFIELD2

» APPFIELD3

» APPFIELD4

» APPFIELDS

6
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Document
(contd)

Partner

Division

Select and Update Available Options

» APPFIELD6

» DOCUMENTPARTNERKEY
» CONTROLNUMBER

» PARTNERKEY

» TABLEKEY (Select only)

These are the field names that are available when using the select or update extended rules
for a non-division partner on the Partner Table (Partner tb).

Note
Refer to this table as Partner.

» PARTNERNAME
» EDICODE
» APPLICATIONPARTNERKEY

These are the additional keys that are available for the Partner table.
» PARTNERKEY

» ALTERNATEKEY (refers to Application Key)

» APPLICATIONPARTNERKEY (refers to Application Key)

These are the field names that are available when using the select or update extended rules
to reference the division partner on the Partner Table (Partner tb).

Note
Refer to this table as Division.

» PARTNERNAME
» EDICODE
» APPLICATIONPARTNERKEY
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Using Extended Rules

PartnerLocation These are the field names that are available when using the select or update extended rules
for a non-division location on the Location Table (Location_tb).

Note

Refer to this table as PartnerLocation.

CONTACTNAME
NAME

ADDRESSI
ADDRESS?2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARYREFCODE
SECONDARYREFCODE
FAX

DivisionLocation  These are the field names that are available when using the select or update extended rules
to reference a division location on the Location Table (Location_tb).

Note

Refer to this table as DivisionLocation.

CONTACTNAME
NAME

ADDRESSI
ADDRESS?2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARYREFCODE
SECONDARYREFCODE
FAX
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Using Extended Rules Select and Update Available Options

PartnerLookup These are the field names that are available when using the select or update extended rules
for a non-division lookup on the Lookup Table (Lookup _tb).

Note

Refer to this table as PartnerLookup.
» ITEM

» DESCRIPTION

» TEXTI

» TEXT2

» TEXT3

» TEXT4

This is an additional key that is available for the PartnerLookup table.
» TABLENAME

DivisionLookup These are the field names that are available when using the select or update extended rules
to reference a division lookup on the Lookup Table (Lookup _tb).

Note

Refer to this table as DivisionLookup.
» ITEM

» DESCRIPTION

» TEXTI

» TEXT2

» TEXT3

» TEXT4

This is an additional key that is available for the DivisionLookup table.

» TABLENAME
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PartnerXref

DivisionXref

These are the field names that are available when using the select or update extended rules
for a non-division cross-reference on the Cross-reference Table (CrossReference tb).

Note
Refer to this table as PartnerXref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXTI
» TEXT2
» TEXT3
» TEXT4

This is an additional key that is available for the PartnerXref table.
» TABLENAME

These are the field names that are available when using the select or update extended rules
to reference a division cross-reference on the Cross-reference Table (CrossReference tb).

Note
Refer to this table as DivisionXref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXTI
» TEXT2
» TEXT3
» TEXT4

This is an additional key that is available for the DivisionXref table.

» TABLENAME

6
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Select and Update Available Options

Interchange These are the field names that are available when using the select or update extended rules
on the Interchange Table (Interchange tb).

Note
This sub-table can only be accessed from the following map types: Interchange Break or
Build, Group Break, Transaction Break, and Export.

The information that is accessed will be the information of the last interchange that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to this table as Interchange.

TESTMODE
CONTROLNUMBER
VERSION
APPFIELDI
APPFIELD2
APPFIELD3
APPFIELD4
APPFIELDS
APPFIELD6
AGENCY
PARTNERKEY
TABLEKEY (Select only)
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Group These are the field names that are available when using the select or update extended rules
on the Group Table (Group_tb).

Note
Can only be accessed from the following map types: Group Break or Build, Transaction
Break, Export, and Interchange Build.

The information that is accessed will be the information of the last group that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to this table as Group.

TESTMODE
CONTROLNUMBER
FUNCTIONALGROUPID
VERSION

APPFIELDI1

APPFIELD2

APPFIELD3

APPFIELD4

APPFIELDS

APPFIELD6

AGENCY

TABLEKEY (Select only)

6
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GenericEnvelope These are the field names that are available when using the select extended rule on the
Segment  Generic Envelope Segment Table (GenericEnvelopeSegment_tb).

Note
Refer to this table as GenericEnvelopeSegment.

» CONTROLNUMBER
» SUBCOUNT

» FIELDI

» FIELD2

» FIELD3

» FIELD4

» FIELDS

» FIELD6

» FIELD7

» FIELDS

» FIELDY9

» FIELDIO
» FIELDII
» FIELDI2
» FIELDI13
» FIELDI14
» FIELDI5
» FIELDI6
» FIELDI17
» FIELDI8
» FIELDI9
» FIELD20
» FIELD21
» FIELD22
» FIELD23
» FIELD24
» FIELD25
» FIELD26
» FIELD27
» FIELD28
» FIELD29
» FIELD30
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GenericEnvelope » FIELD31
Segment (contd.) |, FIELD32

» FIELD33
» FIELD34
» FIELD35
» FIELD36
» FIELD37
» FIELD38
» FIELD39
» FIELDA40
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Overview Error Messages

Overview

Introduction The Gentran:Server error messages and other informational messages are noted in the
Compile Errors dialog box when you compile the translation object or in the Error section
of the Extended Rules dialog boxes when you compile an extended rule containing errors
prior to compiling the translation object, and when you commit an erroneous action in
Gentran:Server.

The informational messages are dependent on the context of the program, and are intended
to be self-explanatory. The error messages are described in the topics accessed below,
along with the actions you can take to correct the problem.

In this appendix  This appendix explains how to determine the action you should take when you receive an
erTor message.
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Error Messages

Compile Error Messages

Compile Error Messages

Introduction The Compile Error Messages are displayed in the Compile Errors dialog box if you
compile a translation object with errors. Or, error messages are displayed in the Error
section of an Extended Rule dialog box if you compile the extended rule containing errors
prior to compiling the translation object. After you correct the cause of the errors, click the
Compile button again to ensure that the rule is error-free.

Messages The compile error messages are listed by the four- or five-digit message number and the
error message text. The error definitions contain the actions that you can take to correct
the problem (if appropriate) and a description that includes possible causes of the error.

Msg ID Message Text Explanation/Your Action

1000 expected "' Explanation
The rule does not have the required “.” between a group name
and a field name.
Your action
Insert a “.” between the group name and field name.

1001 no statement to Explanation

compile The rule is does not contain any statements.

Your action
Add a statement or statements to the rule.

1002 unexpected end of Explanation

program The rule was not complete.

Your action
Finish the rule.

1003 expected ', Explanation
The rule does not have the required “,” between parameters.
Your action
Insert a “,” between parameters.

1004 expected °;’ Explanation
A statement was not terminated properly.
Your action
Terminate the statement in an appropriate manner.

Application Integration User’s Guide
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(Contd)
Msg ID Message Text Explanation/Your Action
1006 no statements to Explanation
compile The body of an IF/ELSE or WHILE condition was empty.
Your action
Complete the body of the unfinished condition.
1007 syntax error ... Explanation
The map component contains a syntax error.
Your action
Correct the syntax error.
1008 expected '#' Explanation

The rule does not have the required “#” before a field name.

Your action
Insert a “#” before the field name.

2000 group ... undefined Explanation
The rule references a group that does not exist.

Your action
Change the reference to an existing group or delete the reference.

2001 ... is not a member of | Explanation
The rule references a field that does not belong to the specified

group.

Your action
Change the reference to an existing field in the specified group.

2002 insufficient indices to | Explanation
access group ... The rule does not give the full addressing for a group.

Your action
Complete the addressing for the group.

2003 too many indices to Explanation
access group... The rule uses too many addresses for the group.

Your action
Address the group correctly.

2004 ... has not been Explanation
defined The rule references an undefined variable.

Your action
Define the variable in the declarations section.
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Compile Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
2005 out of temporary Explanation
variables The rule could not be compiled because some expressions are too
complex.
Your action
Simplify the expressions and compile the rule again.
2008 field type unknown Explanation
The compiler was unable to determine the type of a field.
Your action
Verify that a Data Type is selected for this field.
2009 cannot reference a Explanation
local field with no The rule (probably pre- or post-session) references a local field,
current group but is not associated with any group.
Your action
Reference the field using the proper addressing.
2010 instances of '%]1" are Explanation
transient and cannot The rule references an output group using full addressing. This
be accessed form of addressing is only appropriate for input groups.
Your action
Reference the output group with the proper address.
2011 no field specified Explanation
The rule omits a field reference.
Your action
Add the field reference to the rule.
2012 group ... is promoted | Explanation
and cannot be You attempted to access a promoted group in a COUNT or
accessed in this DELETE rule.
manner
Your action
Do not COUNT or DELETE a promoted group.
2100 ... s not an array Explanation
variable The rule uses array indexing for a variable that is not an array.
Your action
Use the proper indexing for the variable.
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Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
2101 .... array index Explanation
required The rule uses an array variable without using the necessary array
indexing.
Your action
Add the necessary indexing to the array variable.
2102 .... array overflow Explanation
The rule uses an invalid array index.
Your action
Use the proper array index for the array variable.
2103 only one wildcard Explanation
index is permitted The rule uses more than one wildcard index.
Your action
Only one wildcard index is permitted per rule.
2104 a wildcard index must | Explanation
be specified The rule does not specify a wildcard index when required.
Your action
Add a wildcard index where necessary.
2200 expected a string Explanation
A required string or string variable is not supplied.
Your action
Add the required string or string variable.
2201 string overflow Explanation
A string overflow occurred.
Your action
Verify that the size of a target string is equal to or greater than the
source string.
3000 array size expected in | Explanation
declaration of ... Invalid array declaration.
3001 declaration of ... Explanation
missing ']’ Invalid array declaration.
3002 string size expected Explanation
Invalid string declaration.
3003 string size missing ']' | Explanation
Invalid string declaration.
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(Contd)
Msg ID Message Text Explanation/Your Action
3004 variable name Explanation
expected Invalid variable declaration.
3005 ... already defined Explanation
Two variables with the same name are defined at the same scope.
Your action
Rename one of the two variables.
3006 expected an Explanation
accumulator number, | Invalid accumulator reference.
found ...
3007 ... s not a valid Explanation
accumulator number Invalid accumulator reference.
4000 expected a numeric Explanation
expression, found ... You specified something other than the expected numeric
expression.
Your action
Specify the correct numeric expression.
4001 expected a term, Explanation
found ... You specified something other than the expected term.
Your action
Specify the correct term.
4002 expected '+' or '-' Explanation
You specified something other than the expected “+” or
Your action
Specify “+” or “-”.
4003 expected "*' or /' Explanation
You specified something other than the expected “*”” or
6(/,’.
Your action
Specify ““*”or*/”.
4004 expected ')’ Explanation
You specified something other than the expected ).
Your action
Specify “)”.

Application Integration User’s Guide Gentran:Server for Windows — August 2008 (



Compile Error Messages Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
4005 expected a factor, Explanation
found ... Invalid numeric expression.
4006 expected '(" Explanation
You specified something other than the expected “(”.
Your action
Specify “(”.
4007 ... is of incorrect type | Explanation
The specified expression is of an incorrect type.
Your action
Specify the correct type for the expression.
4008 expected a relational Explanation
operator You specified something other than the expected relational
operator.
Your action
Specify the correct relational operator.
4009 missing argument Explanation
A required parameter was omitted.
Your action
Add the required parameter.
4010 assignment expected | Explanation
The assignment operator was omitted from an assignment
statement.
Your action
Add the correct assignment operator to the statement.
4011 operator ... requires Explanation
two arguments Only one parameter was supplied for a binary operator.
Your action
Supply a second parameter for the binary operator.
4012 converting real to Explanation
integer may lose You are converting a real number to an integer.
significant digits .
Your action
Verify that losing decimal places is acceptable in this instance.
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Compile Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
4013 expression too Explanation
complex, use sub- A mathematical expression contains too many terms.
expressions
Your action
Group some of the terms of the mathematical expression in
parentheses.
4014 expected an integer, Explanation
found ... The compiler expected to find an integer instead of [...].
Your action
Supply the correct value for [...].
4015 no valid condition Explanation
specified You did not specify a valid IF or WHILE condition.
Your action
Supply a valid condition in the IF or WHILE statement.
4100 expected a date, found | Explanation
A date is required but not supplied.
Your action
Specify a date.
4101 expected a date Explanation
modifier, found ... A date modifier was required but not supplied.
Your action
Specify a date modifier.
4102 ... is not a date Explanation
Invalid date expression.
5000 THEN expected Explanation
The compiler expected a THEN condition.
5001 DO expected Explanation
The compiler expected a DO condition.
5002 END expected Explanation
The compiler expected a END condition.
5004 FROM expected Explanation
The compiler expected a FROM condition.
5005 INTO expected Explanation
The compiler expected a INTO condition.
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Error Messages

(Contd)
Msg ID

Message Text

Explanation/Your Action

5006

END without BEGIN

Explanation
An END statement was found without a corresponding BEGIN
statement.

Your action
Insert a BEGIN statement in the correct location.

5016

misplaced ‘BREAK’

Explanation
The compiler found BREAK outside of a loop.

Your action
Remove the BREAK or place it inside a loop.

5017

misplaced
‘CONTINUE’

Explanation
The compiler found CONTINUE outside of a loop.

Your action
Remove the CONTINUE or place it inside a loop.

5018

too many parameters

Explanation
Too many parameters were supplied for a function.

Your action
Remove the unnecessary parameters.

5019

too few parameters

Explanation
Too few parameters were supplied for a function.

Your action
Add the necessary parameters.

6000

expected a database
table name

Explanation
The compiler expected a database table name.

Your action
Insert a database table name in the necessary location.

6001

expected a database
column name

Explanation
The compiler expected a database column name.

Your action
Insert a database column name in the necessary location.

6002

too many column
receivers specified

Explanation
The number of columns specified did not match the number of
receivers in a SELECT statement.

Your action
Correlate the number of columns specified in the SELECT
statement to the number of receivers.
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(Contd)
Msg ID

Message Text

Explanation/Your Action

6003

too few column
receivers specified

Explanation
The number of columns specified did not match the number of
receivers in a SELECT statement.

Your action
Correlate the number of columns specified in the SELECT
statement to the number of receivers.

6004

WHERE expected

Explanation
The compiler expected a WHERE statement.

6005

expected a database
key

Explanation
An invalid database key was specified in a WHERE statement.

Your action
Specify the correct database key in the WHERE statement.

6006

WHERE not allowed
with this database
table

Explanation
A WHERE statement is not necessary to access the specified
database table.

Your action
Remove the WHERE statement.

6007

invalid key
combination

Explanation
The combination of keys specified in the WHERE statement is
not a valid unique compound key to the table.

Your action
Specify a valid combination of keys in the WHERE statement.

7000

... 1s not a valid seek
type

Explanation
You used an invalid seek type in FSEEK.

Your action
Use BEGIN, END, or CURRENT.

20001

Record ..., Field ... :
date field missing date
format

Explanation
The specified field does not have a date format.

Your action
Edit the field and choose a date format.

20003

Field ... : constant
used in standard rule
does not exist

Explanation
The standard rule for the specified field uses an invalid constant.

Your action
Correct the standard rule or create the constant.
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Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
20004 Field ... : code list Explanation
used in standard rule The standard rule for the specified field uses an invalid code list.
does not exist
Your action
Correct the standard rule or create the code list.
20005 Field ... : the qualifier | Explanation
field specified inause | The standard rule for the specified field uses an invalid qualifier.
constant standard rule .
is invalid Your action
Correct the standard rule.
20006 Field ... : the field Explanation
specified to store the The standard rule for the specified field designates an invalid
code description in a field for the description.
use code standard rule .
is invalid Your action
Correct the standard rule.
20007 Record ... : the Explanation
specified key field ... : | The key field for the specified record uses an invalid constant.
uses an undefined .
constant Your action
Correct the key field.
20008 Record ... : the Explanation
specified key field ... : | The key field for the specified record uses an invalid code list.
uses an undefined .
code list Your action
Correct the key field.
20010 Record ... : the Explanation
specified key field ... : | The key field for the specified record is inactive.
is inactive
Your action
Activate the key field.
20700 only one binary data Explanation
and one binary length | You have more than one binary data and/or more than one binary
field are permitted length element in one segment.
Your action
Remove the additional binary data and/or binary length elements
from the segment.
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(Contd)
Msg ID Message Text Explanation/Your Action
20701 binary length must Explanation
precede binary data The binary length element must be sequenced before the binary
data element in the segment so the translator knows how much
data to expect.
Your action
Move the binary length element to before the binary data
element.
20702 incomplete binary Explanation
data You marked a segment as binary, but did not include either a
binary length element or a binary data element (or both).
Your action
Add a binary length element and/or a binary data element to the
segment.
20703 group ... has no active | Explanation
child objects You tried to compile the translation object, but the specified
group is empty.
Your action
Activate at least one child object in the group.
20704 Element ..., Attribute | Explanation
.... enumerated The specified XML attribute is configured to use an enumeration
attribute declared but there is no code list standard rule that defines the allowed
without values.
accompanying .
standard rule Your action . .
Define a use code list standard rule for the specified attribute.
20705 Element ..., Attribute | Explanation
.... code list used in The code list for the specified enumerated XML attribute does
enumerated attribute not exist.
does not exist.
Your action
Define the code list.
20706 Element ..., Attribute | Explanation
.... default value is not | The specified default value is not in the code list for this XML
valid ... attribute.
Your action
Ensure that the specified default value is in the code list.
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(Contd)
Msg ID Message Text Explanation/Your Action
20707 Codelist ..., Attribute | Explanation
.... value used in A value in the enumeration code list is not valid for XML.
enumerated attribute .
code list does not Your action o . .
match XML Verify that all th§ value specified in the code list are valid (legal)
NMTOKEN for an XML attribute.
production
20708 Entity ... : Entity value | Explanation
is invalid The value of the specified entity is not valid (legal) in XML.
Your action
Correct the entity value.
20709 ... : llegal use of Explanation
reference character An entity reference was not terminated properly.
Your action
Correct the entity reference.
20710 ... - Malformed Explanation
character reference An XML character reference was not terminated properly.
encountered
Your action
Correct the character reference.
20711 ... . Invalid character Explanation
referenced An XML character reference is invalid.
Your action
Correct the character reference.
20712 ... - Reference to Explanation
undefined entity The referenced entity is not defined.
encountered
Your action
Define the correct entity.
20713 ... : Circular entity Explanation
references An entity references an entity that in turn references the original
encountered entity.
Your action
Do not reference the original entity in a circular manner.
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(Contd)
Msg ID

Message Text

Explanation/Your Action

20714

.... default does not
match the attribute

type

Explanation
The default value is the wrong type for the attribute.

Your action
Either correct the type of the attribute or the default value.

20715

.... Contains illegal
character (‘<°)

Explanation
The default value contains the illegal character ‘<.

Your action
Correct the default value.
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Gentran:Server Error Messages

Error Messages

Introduction The Gentran:Server error messages are displayed when you commit an erroneous action.
When the system displays an error message, you must first acknowledge the message by
either clicking OK, and then take the appropriate action.

Messages The error messages are listed alphabetically below by the first letter of the error message
text. The error definitions contain the actions that you can take to correct the problem (if
appropriate) and a description that includes possible causes of the error.

Message Text

Explanation/Your Action

A code list entry must have a code
value

Explanation
You attempted to add a code without an
associated code value.

A code list must have an element id

Explanation
You attempted to create a code list without an
element ID.

A code list for this element already
exists. You must use another element
id or delete the original code list first

Explanation

You attempted to create a code list with the
same element ID as an already existing code
list.

Your action
Either change the element ID or delete the
original code list.

A condition field is required

Explanation
You established a conditional relationship that
requires a condition field, but did not specify a
condition field.

A data type is required.

Explanation
You did not specify the Data Type of a field.

A field must have a name that is
unique within its parent group

Explanation

You tried to give a field a name that is already
in use by another field within the same group
(not necessarily the same record).

A group must have a unique name

Explanation
You tried to give a group a name that is already
used by another group or record.
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Message Text

Explanation/Your Action

A group or record with a maximum
usage of 1 cannot be split or promoted

Explanation

You attempted to split or promote a single-
occurrence group or record. This is not a valid
action.

A key field has been selected but no
key value has been specified.

Explanation
You established a key field without specifying
a key value.

A Memory Exception has occurred.

Explanation
A system error occurred.

Your action
Exit Gentran:Server and restart Windows.

A name must be entered

Explanation
You did not specify a name for an object.

A problem occurred while attempting
to close loop .... This is probably due
to incorrect standards.

Explanation
An error occurred when reading from the
standards.

A record must have a unique name

Explanation
You tried to give a record a name that is
already used by another group or record.

A Resource Exception has occurred.

Explanation
A system error occurred.

Your action
Exit Gentran:Server and restart Windows.

A serious error was encountered
whilst accessing the clipboard and the
action was abandoned

Explanation
The system aborted a cut, copy, or paste
operation because a serious error occurred.

Your action
Perform the cut, copy, or paste operation again.

A system error was encountered
while compiling the translation object

Explanation

While compiling a translation object, a system-
related problem, such as lack of memory,
prevented the compile from completing.

Your action

Close unnecessary applications to free
memory, and reboot your computer (if
necessary), and then recompile the translation
object.
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Message Text

Explanation/Your Action

A TDF could not be generated due to
a lack of available memory. Either
restart Windows or close down other
applications, then try again

Explanation
While generating a TDF, the system ran out of
memory.

Your action
Exit Gentran:Server, restart Windows and
regenerate the TDF.

An accumulator must be chosen for
this entry

Explanation
You did not specify the accumulator to be used
in a Use Accum standard rule.

An invalid usage count has been
entered

Explanation
You entered an invalid usage count for a record
or group.

No actions have been chosen for this
accumulator entry

Explanation

You selected an accumulator but did not
specify any actions for it in a Use Accum
standard rule.

No alternate accumulator has been
selected

Explanation

In a Use Accum standard rule, you attempted
to create an accumulator entry that used an
alternate accumulator, but did not specify
which alternate accumulator should be used.

No character ranges have been
specified for this token.

Explanation
You did not specify the characters allowed for
a syntax token.

No fields have been used in this
relationship

Explanation
You established a conditional relationship but
did not specify the fields involved.

No more accumulator entries can be
created

Explanation

You attempted to create more than six
accumulator entries in a Use Accum standard
rule.

No more field mappings can be
created

Explanation
You attempted to create more than eight field
mappings for a Select standard rule.
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Message Text

Explanation/Your Action

The constant ID must be unique.

Explanation

You entered a literal constant identifier in the
ID field that is already used in an existing
constant.

Your action
Type a unique literal constant identifier in the
ID field.

The contents of the clipboard cannot
be pasted into the translation object at
this point

Explanation

Either the Clipboard does not contain copied or
cut data, or you are trying to paste XML
information into a positional file format or
paste position information into an XML file
format.

The file format cannot be deleted

Explanation
You tried to delete a file format object.

The Maximum Usage must be greater
then zero and not less than the
Minimum Usage.

Explanation
You entered an invalid maximum usage count.

The number of entries to be split must
be greater than zero and less than the
maximum number of entries in the
original

Explanation

You entered an invalid number in the Split
dialog box. The number to be split must be
greater than zero and less than the maximum
number of entries in the original.

The translation object could not be
compiled

Explanation
The translation object is not ready to be
compiled.

The token code must be unique.

Explanation

You attempted to create a syntax token with the
same token identifier as an existing syntax
token.

Your action
Type a unique token identifier in the Token
field.

These fields cannot be linked because
the input field is deeper than the
output field. The translator would be
unable to address the input field.

Explanation

You are attempting to create an invalid link. A
valid link involves an Input field and an Output
field that are at the same level.

This code already exists. You must
use another code or delete the original
code first

Explanation
You attempted to add a code to a code list that
already contained that code.
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Message Text

Explanation/Your Action

This field cannot be linked to another
field

Explanation
Due to an unknown error, Gentran:Server was
unable to begin creating the link.

This file is not a valid Gentran
translation object

Explanation
You attempted to open (load) a file that is not a
translation object.

You have entered an invalid character
or character code in Record Delimiter
1

Explanation

You entered an invalid Record Delimiter 1 on
the Positional File Format Properties dialog
box.

You have entered an invalid character
or character code in Record Delimiter
2

Explanation

You entered an invalid Record Delimiter 2 on
the Positional File Format Properties dialog
box.

You have entered an invalid decimal
separator or character code.

Explanation
You entered an invalid decimal separator.

You have entered an invalid element
delimiter character or character code

Explanation
You entered an invalid element delimiter.

You have entered an invalid Pad
character or character code

Explanation
You entered an invalid pad character for a
positional field.

You have entered an invalid release
character or character code

Explanation
You entered an invalid release character.

You have entered an invalid sub-
element delimiter character or
character code

Explanation
You entered an invalid sub-element delimiter.

You have entered an invalid tag
delimiter character or character code

Explanation
You entered an invalid tag delimiter.

You must enter a description of the
translation object.

Explanation

You attempted to save the translation object
without entering the translation object
description on the Translation Object Details
dialog box.

Your action

Type the translation object description in the
Description field on the Translation Object
Details dialog box. This field must be unique
because it is used by the system to identify the
map.
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Message Text

Explanation/Your Action

You must enter a subtable name.

Explanation

For a Select or Update standard rule, the
selected table requires you to specify a table
name in the Sub Table field.

You must enter a valid character
range.

Explanation
You entered an invalid character range for a
syntax token.

You must enter a valid syntax token.

Explanation

You did not enter a valid token identifier in the
Token field when creating or editing a syntax
token.

You must enter a value for this
constant.

Explanation

You did not specify a value for the constant in
the Value field when creating or editing a
syntax token.

You must enter an ID.

Explanation

You did not specify a literal constant identifier
for the constant in the ID field when creating
or editing a syntax token.

You must enter the name of the author
of this translation object

Explanation

You attempted to save the translation object
without entering the name of the translation
object author on the Translation Object Details
dialog box.

You must select a constant type.

Explanation
You did not select a constant type from the
Type list when creating or editing a constant.

You need to specify Input and Output
File Types for the new translation
object

Explanation

You clicked OK on the Create New
Translation Object dialog box without
selecting both the Input Format Type and
Output Format Type.
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Translator Report Error Messages

Introduction The Document and Interchange Translator Report error messages are displayed on the
Document Translator Report and the Interchange Translator Report under the Message
Number and Message columns.

Message number  The Message Number column on the translator report contains a prefix (INF, EDI, or
column POS), a dash (“-”), and a four digit number that identifies the error. The prefixes are
described in the following table

Prefix Description

INF Used only with information messages, which are not defined in this chapter
because they are intended to be self-explanatory.

EDI Used with all the messages listed below that are not informational. It is used
if the error is related to an EDI file.

POS Used with all the messages listed below that are not informational. It is used
if the error is related to a positional flat file.

Message column The Message column on the translator report contains the actual error message text.
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Translator error The translator report error messages are listed below by the last three digits of the message
messages  number and the error message text.

Msg ID Message Text Explanation/Your Action
100 Mandatory Element Explanation
Missing An element that the translation object designated as “Mandatory”

was not created in an Outbound document or was not received in
an Inbound document.

Your Action

Use the Segment/Record ID, Sequence, and Element fields on
the Translator Report to determine which mandatory element in
the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and complete the missing field. If you imported the
document into your system, delete the document and then import
that document after the import file has been corrected. See Using
Documents in the User s Guide for more information on opening
and deleting, and importing documents.

Inbound
Contact your trading partner and determine what action you
should take.
110 Incorrect Element Explanation
Format An element was entered or received with an incorrect format.

Some examples of incorrect format are: a numeric field that
contains non-numeric characters, and a field that exceeds the
maximum length or is less than the minimum length (as defined
in the standard) and invalid dates.

Your Action

Use the Segment/Record ID, Sequence, and Element fields on
the Translator Report to determine which element in the
document is invalid.

Outbound
Correct the data source.

Inbound
Contact your trading partner and determine what action you
should take.
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(Contd)
Msg ID Message Text Explanation/Your Action
120 Too Many Explanation
Components in A composite element in a document you received has more
Composite component elements (sub-elements) than allowed by the
standard.
Your Action
Use the Segment/Record ID, Sequence, and Element fields on
the Translator Report to determine which element in the
document is invalid.
Outbound
If the document was entered using the Document Editor, open the
document and correct the invalid field. If you imported the
document into your system, delete the document, correct the
data, and then import that document again. See Using
Documents in the User s Guide for more information on opening
and deleting, and importing documents.
Inbound
Contact your trading partner and determine what action you
should take.
130 Invalid Conditional Explanation
Relationship A conditional relationship in the document is not valid.
Your Action
Use the translator report to determine where in the document the
error occurred.
Outbound
If the document was entered using the Document Editor, open the
document and correct the conditional relationship. If you
imported the document into your system, delete the document
and then import that document again.
Inbound
Contact your trading partner and determine what action you
should take.
140 Implicit Rule Failure | Explanation
A validation rule set up against this field failed in the translator.
Typically, this occurs when the Exclusive flag is set for a
standard rule, and the field value does not match the data table.
Your Action
Check the data value that you received against the valid data that
is allowed for the field.
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Component Missing

(Contd)
Msg ID Message Text Explanation/Your Action
200 Mandatory Explanation

A component (sub-element) of a composite element that the
translation object designated as “Mandatory” was not created in
an Outbound document or not received in an Inbound document.

Your Action

Use the Segment/Record ID, Sequence, Element, and Composite
fields on the Translator Report to determine which mandatory
component in the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and complete the missing field. If you imported the
document into your system, delete the document and then import
that document again.

Inbound

Contact your trading partner and determine what action you
should take.

210

Incorrect Component
Format

Explanation

A component (sub-element) of a composite element that the
translation object designated as “Mandatory” was entered
(Outbound) or received (Inbound) with an incorrect format.
Some examples of incorrect format are: a numeric field that
contains non-numeric characters, and a field that exceeds the
maximum length or is less than the minimum length (as defined
in the standard).

Your Action

Use the Segment/Record ID, Sequence, Element, and Composite
fields on the Translator Report to determine which element in the
document is invalid.

Outbound

If the document was entered using the Document Editor, open the
document and correct the invalid field. If you imported the
document into your system, delete the document, correct the
data, and then import that document again.

Inbound
Contact your trading partner and determine what action you
should take.
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(Contd)
Msg ID Message Text Explanation/Your Action

220 Component Delimiter | Explanation
A component delimiter was encountered instead of the expected
element.

Your Action
Contact either/or your trading partner or the translation object
creator and determine what action you should take.

300 Mandatory Segment Explanation

A segment that the translation object designated as “Mandatory”
was not created in an Outbound document or was not received in
an Inbound document.

Note

This error can be generated in a variety of circumstances. The
most common is that the input data sequence does not
correspond to the data sequence defined in the translation object
used to translate the data. If this is the case, the information
provided with the message may indicate a segment in the data.

Your Action
Use the Segment/Record ID field on the Translator Report to
determine which mandatory segment in the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and key data into the fields that are necessary to
generate the segment. If you imported the document into your
system, delete the document, add the data that is necessary to
generate the segment, and then import that document again.

Inbound
Contact your trading partner and determine what action you
should take.

310 Invalid Loop Start/ Explanation
End Structure An invalid Loop Start/Loop End was found in an Inbound
document.

Your Action

Use the information in the translator report to determine which
LS/LE pairing is invalid. Contact your trading partner and
determine what action you should take.
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(Contd)
Msg ID

Message Text

Explanation/Your Action

315

Invalid Segment or
Record Structure

Explanation

A segment (in an EDI file) or a record (in a positional flat file) in
an inbound file did not match what the translation object was
expecting.

Your Action

From viewing the information in the translator report and
viewing the “Raw EDI” interchange, determine which segment
or record is invalid. Contact your trading partner to determine
what action you should take. See How to View Interchanges in
the Users Guide for more information.

405

Unknown Partner

Explanation
An Interchange was received but the system cannot determine
which partner sent it.

Your Action

From viewing the information in the translator report and
viewing the “Raw EDI” interchange, determine which partner
sent you the interchange. If the partner is not listed on your
system, create the partner and a relationship, and attach the
interchange to that partner. If the partner already exists on your
system, attach the interchange to that partner and then determine
why the system did not automatically identify the partner.

410

Header/Trailer
Control Numbers do
not match

Explanation
The control numbers on the header and trailer do not match, as
specified by the standard.

Your Action

Check the “Raw EDI” view to determine which control numbers
are in the EDI file, and then contact your trading partner to
determine what action you should take. See How to View a
Document in the User s Guide for more information on viewing
a document.

415

Control Total
Incorrect

Explanation

The EDI control total in the Segment Identified field of the
translator report does not equal the value that was calculated by
the Compliance Checker.

Your Action

Check the “Raw EDI” view to determine what the control total
should be, and then contact your trading partner to determine
what action you should take. See How to View a Document in
the User s Guide for more information on viewing a document.
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(Contd)
Msg ID Message Text Explanation/Your Action

420 Unknown Explanation
Relationship A document was received but the Partner Profile for that partner
does not include a corresponding Inbound Relationship.

Your Action

From the viewing the information in the translator report and
viewing the “Raw EDI” interchange, determine which
relationship the document requires and create that inbound
relationship for the partner. See How to View Interchanges in the
Users Guide for more information on viewing interchanges. See
How to Create a New Inbound Relationship in the User s Guide
for more information on creating inbound relationships.

460 Invalid Test Mode Explanation

Flag The partner relationship was found but the test mode flag in the
data did not match the test mode defined in the inbound partner
relationship.

Your Action

Change the test mode of the inbound partner relationship to
match the test mode of the data. See How to Create a New
Inbound Relationship in the User's Guide for more information
on creating inbound relationships. Then, ask your trading partner
to change the test mode of the data they are sending to match that
defined by the inbound relationship.

User Level Error  User-level type errors can occur when extended rules are used in the map.

Messages

The user-level error messages are listed below in numerical order based on their Message
ID. The table also includes an explanation of the error and an action you can take to
correct the error.

Msg ID Message Text Explanation/Your Action

800 Batch File Header Explanation

Section Missing The system cannot find a header section record within the batch
file.

Your action
Contact your Trading Partner.
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Msg ID Message Text Explanation/Your Action

801 Unexpected Header Explanation

Segment ID A value other than “00” is in the header section record segment

Identifier field (701).
Your action
Contact your Trading Partner.

802 Unexpected Explanation

Transmission Type A transmission value other than T (Transaction), R (Response),

or E (Error) is in the transmission type (880-K6) field of the
header section record.
Your action
Contact your Trading Partner.

803 Sender ID Missing Explanation
The system cannot find a value in the sender ID (880-K1) field in
the Header Section Record.
Your action
Contact your Trading Partner.

804 Invalid Batch Number | Explanation
The batch number field (806-5C) contains a format other than the
YYDDD format, where:
» YY=Year
» DDD=Julian date
Your action
Contact your Trading Partner.

805 Unexpected File Type | Explanation
A value other than P (Production) or T (Test) is in the File Type
field (702).
Your action
Contact your Trading Partner.

806 Receiver ID Missing | Explanation
The system cannot find a value in the receiver ID field (880-K7)
of the header section.
Your action
Contact your Trading Partner.
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(Contd)
Msg ID

Message Text

Explanation/Your Action

807

Batch File Detail Data
Record Missing

Explanation
The system cannot find a Detail Data Record within the batch
file.

Your action
Contact your Trading Partner.

808

Unexpected Data
Segment ID

Explanation
A value other than “G1” is in the segment identifier field of the
Detail Data Record (701).

Your action
Contact your Trading Partner.

809

Transaction Reference
Number Missing

Explanation
The system cannot find a value in the transaction reference
number field of the Detail Data Record (880-K5).

Your action
Contact your Trading Partner.

810

Batch File Trailer
Record Missing

Explanation
The system cannot find the trailer record within the batch file.

Your action
Contact your Trading Partner.

811

Invalid Trailer
Segment ID

Explanation
A value other than “99” is in the segment identifier field (701) of
the trailer record.

Your action
Contact your Trading Partner.

812

Unexpected Batch
Number

Explanation
The batch number field (806-5C) of the trailer record does not
match the batch number field (806-5C) of the header record.

Your action
Contact your Trading Partner.

813

Invalid Record Count

Explanation
The record count field (751) of the trailer record contains an
invalid number.

Your action
Contact your Trading Partner.

() Gentran:Server for Windows — August 2008

Application Integration User’s Guide



Error Messages

Translator Report Error Messages

Transaction Code

(Contd)
Msg ID Message Text Explanation/Your Action
814 Processed DDRs Explanation
Mismatch Record The actual count of Detail Data Records is different from the
Count value in the record count field (751) of the trailer record.
Your action
Contact your Trading Partner.
815 Duplicate Segment Explanation
Within Transaction A segment occurs more than one time within the transaction.
Your action
Contact your Trading Partner.
816 Unexpected Explanation

A value other than a value listed below is in the transaction code
field (103-A3) of the request transaction header segment or
response header segment.

» El = Eligibility Verification

» Bl =Billing

» B2=Reversal

» Pl=Re-bill

» P2=P.A. Request & Billing

» P3=PA. Inquiry

» P4=PA.Request Only

» NI = Information Reporting

» N2 =Information Reporting Reversal

» N3 =Information Reporting Re-bill

» CI1 = Controlled Substance Reporting

» C2=Controlled Substance Reporting Reversal
» (3 =Controlled Substance Reporting Re-bill

Your action
Contact your Trading Partner.
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(Contd)
Msg ID

Message Text

Explanation/Your Action

817

Invalid Transaction
Count

Explanation

A value other than a value listed below is in the transaction count
field (109-A9) of the request transaction header segment or the
response transaction header segment.

» Blank = not specified

» 1 =0ne Occurrence (Default)

» 2 =Two Occurrence (Except Transaction Code E and P)
» 3 =Three Occurrence (Except Transaction Code E and P)
» 4 =Four Occurrence (Except Transaction Code E and P)

Your action
Contact your Trading Partner.

818

Processed
Transactions
Mismatch Transaction
Count

Explanation

The actual count of the transactions is different from the value in
the transaction count field (109-A9) of the response header
segment.

Your action
Contact your Trading Partner.

819

Unexpected Header
Response Status Code

Explanation
A value other than A (Accepted) or R (Rejected) is in the header
response status field (501-F1) of the response header segment.

Your action
Contact your Trading Partner.

820

Unexpected
Transaction Response
Status Code

Explanation
A value other than a value listed below is in the transaction
response status field (112-AN).

» A= Approved

» C=Captured

» D =Duplicate of Paid

» F=PA Deferred

» P=Paid

» Q= Duplicate of Capture

» R =Rejected

» S =Duplicate of Approved

Your action
Contact your Trading Partner.
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Translator Report Error Messages

Core translator type errors can occur when you are receiving or sending data.

The core translator error messages are listed below in numerical order based on their
Message ID. The table also includes an explanation of the error and an action you can take

to correct the error.

Text

Msg ID Message Text Explanation/Your Action
830 Null Character Explanation
The data file contains binary data.
Your action
Contact your Trading Partner.
833 Unexpected End of Explanation
File A field of a specified length is incomplete.
Your action
Contact your Trading Partner.
835 Unexpected Start of Explanation

The record does not contain End of Text character.

Your action
Contact your Trading Partner.

836

Unexpected End of
Text

Explanation
The record does not contain Start of Text character.

Your action
Contact your Trading Partner.

837

Missing Stream
Separatorl

Explanation
The system is reading non-streamed data with a template from a
map where “stream segments” box is unchecked.

Your action
Contact your Trading Partner.

838

Missing Stream
Separator2

Explanation
The system reading non-streamed data with a template from a
map where “stream segments” box is unchecked.

Your action
Contact your Trading Partner.

839

Unexpected Separator

Explanation
A group separator, segment separator, field separator, STX, or
ETX is present in the data.

Your action
Contact your Trading Partner.
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Msg ID

Message Text

Explanation/Your Action

840

Unexpected Field
Separator

Explanation
Based on the map, two field separators occur consecutively or a
different separator is expected.

Your action
Contact your Trading Partner.

841

Unexpected Group
Separator

Explanation
Based on the map, a group separator occurs when none was
specified.

Your action
Contact your Trading Partner.

842

Missing Group
Separator

Explanation
Based on the map, a group separator is missing.

Your action
Contact your Trading Partner.

843

Unexpected Stream
Separatorl

Explanation
Based on the map, a stream separatorl is occurs when none was
specified.

Your Action
Contact your Trading Partner.

845

Positional Tag
Defined Beyond EOS

Explanation
The position of the transaction code (Positional Record Tag) is
specified to start beyond the end of the segment.

Your action
Change the value of the positional segment under the NCPDP
Properties tag to start before the end of the segment.

855

Delimited Segment
Has No Fields

Explanation
The delimited segment must have at least the mandatory fields.

Your action
Contact your Trading Partner.

856

Missing Delimited FS
After SS

Explanation
The delimited field separator is not present after the segment
separator.

Your action
Contact your Trading Partner.

() Gentran:Server for Windows — August 2008

Application Integration User’s Guide



Error Messages

Translator Report Error Messages

(Contd)
Msg ID Message Text Explanation/Your Action
857 Field ID Data Does Explanation
Not Match Map Field | The field ID data is different from the defined delimited field ID
ID tag.
Your action
Contact your Trading Partner.
858 Unexpected Char(s)in | Explanation
Delimited Field ID A separator was found in the delimited field ID data.
Your action
Contact your Trading Partner.
859 Null Character in Explanation
Delimited Field ID The delimited field ID contains binary data.
Your action
Contact your Trading Partner.
860 Incomplete Delimited | Explanation
Field ID The field ID data is shorter than expected.
Your action
Contact your Trading Partner.
861 Missing Delimited Explanation
Field Data No data is found after a delimited field ID.
Your action
Contact your Trading Partner.
862 Null Character in Explanation
Delimited Field Data | The delimited field data contains binary data.
Your action
Contact your Trading Partner.
865 Segment ID Data Explanation
Does Not Match Map | The segment ID data is different from the defined delimited
Segment ID segment ID field.
Your action
Contact your Trading Partner.
866 Unexpected Char(s)in | Explanation
Delimited Segment ID | A separator was found in the delimited segment ID.
Your action
Contact your Trading Partner.
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Msg ID Message Text Explanation/Your Action
867 Null Character in Explanation
Delimited Segment ID | The delimited segment ID contains binary data.
Your action
Contact your Trading Partner.
868 Incomplete Delimited | Explanation
Segment ID The delimited segment ID is shorter than expected.
Your action
Contact your Trading Partner.
869 Field ID Size Differs | Explanation
From Global Field ID | The computed size of the segment/field ID is different from the
Size value of the global field ID length.
Your action
Contact your Trading Partner.
885 No Data after STX in | Explanation
Batch Segment The batch record does not contain any data.
Your action
Contact your Trading Partner.
886 Unexpected STX in Explanation
Batch Segment The batch record does not contain an ETX character.
Your action
Contact your Trading Partner.
887 Missing ETX in Batch | Explanation
Segment The batch record does not contain an ETX character.
Your action
Contact your Trading Partner.

6

Gentran:Server for Windows — August 2008

Application Integration User’s Guide




Error Messages Translator Report Error Messages

Core Translator Core translator errors can also occur when you are sending batch data using the NCPDP
Error Messages: Data Record field to your Trading Partner. Many times the error results because the Batch
sending batch data File string is missing a portion of the Batch File or a value in the string is incorrect.

using the NCPDP
Data Record field To prevent errors from occurring verify that the Batch File string follows the detail data
record (DDR) format:
<separator>filename<separator>StartOffset<separator>EndOffset<separator>.
The core translator error messages are listed below in numerical order based on their
Message ID. The table also includes an explanation of the error and an action you can take
to correct the error.
Msg ID Message Text Explanation/Your Action
888 Could Not Open Explanation
NCPDP Data File The NCPDP data file either does not exist or it is not readable.
Your action
Verify that the file you are selecting is the correct filename or
supply the information that is missing from the string field.
890 Missing Separator in Explanation
DDR Info String A separator is missing from the DDR string field.
Your action
Insert a “;” in the DDR string field.
891 Missing Filename in Explanation
DDR Info String The filename is not in the DDR string field.
Your action
Add the filename to the DDR.
892 Invalid Start byte Explanation
Offset in DDR Info The system found non-numeric data at start of set.
String
Your action
Add a valid start of set (numeric) value.
893 Invalid End Byte Explanation
Offset in DDR Info The system found non-numeric data at end of set.
String
Your action
Add a valid end of set (numeric) value or remove the data if data
up to end of file should be processed.
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Msg ID Message Text Explanation/Your Action
894 Missing Start/End Explanation
Byte Offset in DDR The Start/End Byte Offset is not in the DDR string field.
Info String
Your action
Add the Start/End Byte Offset to the DDR string field or remove
extra separators.
895 Extra Data in DDR Explanation
Info String The DDR string contains extra data.
Your action
Remove the extra data from the DDR string.
896 Total Bytes Read Explanation
Mismatch Total Bytes | The actual number of bytes read is less than the number of bytes
to Read specified in the set.
Your action
Verify the Start/End Byte Offsets or remove the end byte offset if
data up to end of file should be processed.
897 Start Byte Offset is Explanation
Beyond End of File The position of the Start Byte Offset is specified to start after the
end of the file.
Your action
Change the start position of the Start Byte Offset.
898 Start Byte Offset is Explanation
Beyond End Byte The position of the Start Byte Offset starts after the position of
Offset the End Byte Offset.
Your action
Change the position of the Start Byte Offset to start before the
End Byte Offset, or change the position of the End Byte Offset to
start after the Start Byte Offset.
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Overview

Assumptions

Restrictions

User Exits

Use of this appendix assumes that you:
»  Are familiar with the use of ActiveX Automation Servers and languages such as
Visual Basic.

» Know the Translator Programming Language (TPL) constructs for creating,
manipulating, and deleting ActiveX objects.

» Know the ProgID of the ActiveX object and all its exposed interfaces.

» Understand how and when extended rules are invoked and their scope.

Advanced feature
User exits are an advanced feature of Gentran:Server that should only be used with the
above prerequisites.

Gentran:Server extended rules selectively support ActiveX technology.

Supported
Gentran:Server extended rules support:

» ActiveX Automation Servers.

» Some ActiveX Controls, but only those that work as Automation Servers.

Not supported
Gentran:Server does not support:

» ActiveX controls that are not ActiveX Automation Servers. Such ActiveX controls
must be hosted in a graphical user interface (GUI) display, and therefore cannot be
used from extended rules.

» ActiveX Arrays (e.g., the VT _ARRAY data type modifier)

» References (e.g., the VT_BYREEF data type modifier) except for output parameters in
method calls. In this instance, references are only valid for the duration of the method
call.

» Gentran:Server does not read registry entries or type libraries when compiling
extended rules to verify the accuracy of programmatic identifiers (ProgIDs) or
interfaces.

» Extended rules that compare two ActiveX properties or method results, or any
combination of properties or method results. This type of comparison is invalid
because property and method types are unknown prior to compilation and thus it is
not possible to generate the correct comparison code.
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Definition of ActiveX Terminology

Definition of ActiveX Terminology

What is ActiveX?

What is an
ActiveX
automation
server?

What is the
IDispatch
interface?

What is a method?

What is a
property?

What are ActiveX
controls?

Application Integration User’s Guide

ActiveX is a term that encompasses a set of rules that define how applications should
share information. ActiveX grew out of technologies developed by Microsoft, specifically
Object Linking and Embedding (OLE) and Component Object Model (COM).

An ActiveX automation server is an ActiveX component (a .DLL or .EXE program) that
can expose part of its functionality, specifically properties and methods, via the IDispatch
interface to another program on the system.

Some ActiveX controls function as automation servers.

The IDispatch interface is a standard COM interface. Automation Servers typically expose
their methods and properties through this interface.

A method is an action or function that is performed by an object (e.g., a calculation or a
search).

A property is a characteristic or parameter of an object (e.g., type, size, or creation date).

ActiveX controls are a specifically defined method of implementing ActiveX
technologies. Basically an ActiveX control is a software component that executes
common tasks and can integrate into the user interface of an application that provides the
necessary ActiveX control host functionality.

The ActiveX control specification enables you to build component software that interacts
with your application and Gentran:Server. ActiveX controls require a user interface, so
they are not appropriate for translation user exits. These controls can be developed in a
variety of programming languages, including Visual Basic.
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Gentran:Server User Exit Overview

Why use user
exits?

User exits with
Gentran

User exits allow you to enhance your functionality or fulfill specific requirements that
Gentran:Server does not perform during normal translation.

Gentran:Server supports user exits in all types of translation objects through extended
rules that enable the use of Microsoft’s ActiveX technology. This feature allows you to use
extended rules to invoke custom functionality that was created as an ActiveX Automation
Server.

Specifically, you can:

D create objects,

» delete objects,

» query objects,

D access properties, and
» invoke methods.
Note

You can create your own custom functionality as an ActiveX Automation Server, or you
can use third party Automation Servers.

Gentran:Server supports ActiveX indexed properties, specifically these types of index:
» variant
» numeric

» string

The index support allows you to use these syntaxes (if they are supported by your
Automation server):

n = ob.property[l];

n ob.property[“Count”];

n ob.property[ob.method () ];

Gentran:Server also supports chaining of ActiveX method calls and properties, which
simplifies extended rules for Automation servers with moderately complex object models
(e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.item[“MessageId”].value
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Examples of user
exits

Data types
supported

Data type
conversion

Objects

Gentran:Server User Exit Overview

User exits may be used in the following manner.

» To access your database table to perform cross-reference or lookups instead of using
the Gentran:Server tables.

» To perform complex pricing calculations (e.g., involving multiple customers, where
they are located, and where the product is sold).

The following table lists the extended rule data types and the corresponding ActiveX data
types that are supported for use with user exits:

Extended Rule Data Type ActiveX Data Type
INTEGER VT 14
REAL VT RS
DATETIME VT DATE
STRING VT BSTR
OBJECT VT DISPATCH

The Gentran:Server translator automatically converts the extended rule data type to the
ActiveX data type, whenever possible. If the conversion cannot be performed, a type
mismatch error is written to the Audit Log and the extended rule is immediately
terminated. An error is also written to the translator report, if one is used by the operation.
Since an export operation does not generate a translator report, any conversion errors
during export translation are only written to the Audit Log.

ActiveX automation servers use the datatype OBJECT, which consists of two elements:
properties (a defined set of data) and methods. A method is a function that is defined by
the interface of the object.

All objects that are automation servers provide the default interface IDispatch, which
exposes the internal functions of an application to Gentran:Server. You can also expose
other interfaces.

Example
Internet Explorer exposes the interface IWebBrowser2.
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Syntax

Location

The object must be declared and then created via the CREATEOBJECT command, by
pointing to the object’s IDispatch interface. Then, the object’s methods may be invoked
using the syntax object.method(parameters).

The user may specify the ProgID and an optional InterfaceID (IID). If you just specify the
ProgID, Gentran:Server uses the default IDispatch interface. The IID is a machine-
readable identifier that uniquely identifies the interface of an object (e.g., {00020300-
00B000-C00004005300} ). Interfaces can also be identified by their human-readable name
(e.g., IDispatch).

Note
Each IID must be enclosed in braces {}.

The location of the user exit in the map depends on what the user exit needs to do and
what you want the scope of the rule to be. Typically, you might:

» declare an object in the On Begin rule of the Input side of the map (Loop Level
Extended Rules dialog box of Input positional file),

» create and use the object in the On Begin rule of the Input side of the map (Loop
Level Extended Rules dialog box of Input positional file), and

» delete the object in the On End rule of the Output side (Loop Level Extended Rules
dialog box of Output EDI file).

Note

The sample above is intended as an example only. You can declare, create, use, and delete
an object in an extended rule for a map component at any hierarchical level, including
field level extended rules, if appropriate.

Reference
See Defining Extended Rules on page 6 - 12 for more information on creating extended
rules for various map components.

6
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Examples of User Exits

Introduction This section contains examples of the construction of user exits. In this section the
following conventions apply:

» Bold typeface is used to express what you need to type.

» Lines that are too long to fit on one line in this section may be continued on the next
line using a line-continuation character (A).

» A double slash (/) introduces comments.

Defining object  This example defines a variable that represents an ActiveX Automation Server:
variable
object ob;

Creating a default This example creates an instance of the default interface of the Internet Explorer ActiveX
interface  Automation Server:

object ob;

ob = createobject (“InternetExplorer.Application”);

//Creates an instance of the default interface of an ActiveX
//Automation Server.

Creating a specific  This example creates an instance of the Internet Explorer ActiveX Automation Server and
interface  requests a specific interface:

object ob;

ob = createobject (“InternetExplorer.Application”, “{EAB22AC1-30C1
A-11CR-A7EB-000C05BAEOB}”) ;

//Creates an instance of a specific interface of an ActiveX Automation
//Server. In this case, the IID is known (specified in braces).
//Note:

//The createobject command is more efficient if you use the IID
//instead of the interface name.

This example creates an instance of the Internet Explorer ActiveX Automation Server,
where the interface identifier of the desired interface is unknown, but the name of the
interface is IWebBrowser:

object ob;

string[50] iid;

iid = getiid(“InternetExplorer.Application”, “IWebBrowser2”);

ob = createobject (“InternetExplorer.Application”, iid);

//Creates an instance of a specific interface of an ActiveX
//Automation Server. In this case, the IID is not known, so the
//ProgID and name of the interface (IWebBrowser) are specified and
//Gentran:Server looks up the IID. The IID is loaded into the
//string variable “iid” and then that value is used to create the
//object.
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Deleting an object

Getting a property
value

Setting a property
value

Passing
parameters to a
method

An object must be deleted before the end of the map that uses it. It is more efficient to
delete the object immediately when you no longer need it, although the Gentran:Server
translator deletes the object automatically at the end of the map. Also, if you assign one
object to another one, both copies of the object must be deleted for that object to be
properly unloaded.

This example deletes the object “ob” that was used in the previous examples:

deleteobject (ob) ;

This example obtains a property value from an ActiveX Automation Server:

object ob;

string[50] iid;

iid = getiid(“InternetExplorer.Application”, “IWebBrowser2”);
ob = createobject (V“InternetExplorer.Application”, iid);

IF ob.Visible = 1 THEN

BEGIN

//The property value is accessed.

END

//Test to see if the system displays the Internet Explorer.

This example sets a property value in an ActiveX Automation Server:

object ob;

string[50] iid;

iid = getiid(“InternetExplorer.Application”, “IWebBrowser2”);
ob = createobject (“InternetExplorer.Application”, iid);
ob.Visible = 1;

//The property value is set.

//Display Internet Explorer on the desktop.

To pass parameters to a method, use the syntax objectname.methodname(parameters).
The Gentran:Server translator automatically converts the extended rule data type of the
property to the ActiveX data type, whenever possible. If there is no directly corresponding
type in the extended rules, the conversion is performed as well as possible by the operating
system.

Note

Gentran:Server relies on default data types. For example, Gentran:Server converts

VT CURRENCY (which is an unknown data type to the translator programming
language) to a real or numeric data type. If the conversion cannot be performed, a type
mismatch error is written to the Translator Report and the extended rule is immediately
terminated.
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Passing  Example
parameters to a This example navigates to a web page by passing the URL to the Navigate method of
method Internet Explorer:

(contd) object ob;
string[50] iid;
iid = getiid(“InternetExplorer.Application”, “IWebBrowser2”);
ob = createobject (V“InternetExplorer.Application”, iid);
ob.Navigate (“www.sterlingcommerce.com”) ;
//Navigates to the Sterling Commerce web page by passing the URL to
//the Navigate method of Internet Explorer. Note: URL must be
//enclosed in quotation marks.

Returning values To return values in output parameters, use the syntax
in output  objectname.methodname(InputParameter, OUT OutputParameter).

arameters
p Note

» Input and output parameters may occur anywhere in the parameter list.
» Output parameters must be preceded by the OUT keyword.

» When an extended rule variable is used as an output parameter, the ActiveX datatype
must match exactly.

Reference
See Data types supported on page B - 5 for a list of ActiveX data types and the analogous
extended rule data type for each.

Example
This example decrypts data in a field:

object ob;
ob = createobject (“YourCompany.DecryptionUserExit”) ;
ob.Decrypt (“EncryptionKey”, OUT #Field Name) ;

Testing successful  This example tests the value of an object against zero to determine if it was correctly
object creation  created:

object ob;

ob = createobject (“YourCompany.DecryptionUserExit”) ;

IF ob = 0 THEN

BEGIN

//Object not created properly; perform task X.

END

//Test to see if the object was created successful. If it was not
//created, perform the specified task.
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Obtaining another
interface of an
existing object

Accessing a
database

This example uses the IID of an object to obtain a different interface of an existing object
(objectl):

object ob, ob2;

ob = createobject ("InternetExplorer.Application");

ob2 = queryobject (ob, "{EAB22AC1-30C1-11CF-A7EB-0000CO5BAEOB}") ;

If the IID of the desired interface is unknown, use the getiid function
to determine the correct IID and then use the queryobject function, as
this example demonstrates:

object ob, ob2;

string[50] iid;

ob = createobject ("InternetExplorer.Application");

iid = getiid("InternetExplorer.Application”, "IWebBrowser2");

ob2 = queryobject (ob, iid);

This example uses a user exit to cross-reference a UPC code with a value in a database to
return an SKU number. This example adds the user exit to an invoice (import) map (refer
to the Gentran:Server TUTORIAL folder, PET 810.MAP for an example). The user exit
code is implemented by increments in the map, with each section added to the logical map
component.

On Begin Extended Rule
Type the following code into the On Begin extended rule of the INPUT positional file:

//Declare the object

object ob;

//Create an instance of the Visual Basic Active X Automation Server
ob = CreateObject ("SCUPCSKU.SKUResolve") ;

//To create an instance of the C++ ActiveX Automation Server

//use the following command instead:

//ob = CreateObject (“UpcSku.Application”) ;

if ob = 0 then

begin

MessageBox ("Create Object failed",O0);
end

INVDETAIL.UPCCODE Field Extended Rule
Type the following code into the UPCCODE field extended rule on the Input side of the
map (INVDETAIL record):

string [100] msg;
msg = "UPC Code = ";
concat (msg, #UPCCODE, 12) ;

//Call the automation server
#UPCCODE = ob.ResolveSKU (#UPCCODE) ;
concat (msg, ", SKU Code = ",13);
concat (msg, #UPCCODE, len (#UPCCODE) ) ;

//Display message box to user listing UPC code and SKU matches
MessageBox (msg, 0) ;
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Accessinga  On End Extended Rule
database Type the following code into the On End extended rule of the INPUT positional file:

(COIltd) //Delete the object
deleteobject (ob) ;

Note

See Examples of Automation Servers on page B - 12 for sample automation servers
(written in Visual Basic and C++) that access a Microsoft Access Database to cross-
reference a UPC code with an SKU code.
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Examples of Automation Servers

Introduction

Visual Basic
Automation Server

The following pages contain sample automation servers that access a Microsoft Access
Database to cross-reference a UPC code with an SKU code. The first example is written in
the Visual Basic programming language and the second one in C++.

Note
Both of the following automation servers could be used with the “Accessing a database”
user exit extended rules on Accessing a database on page B - 10.

This sample automation server was written in the Visual Basic programming language. It
accesses a Microsoft Access Database to cross-reference a UPC code with an SKU code.
The syntax is: ResolveSKU(UPCCode as String). Note that after compiling the
Automation Server (SCUPCSKU.EXE), it was registered using REGSRV32.EXE because
it was not self-registering.

//This is a Visual Basic Active X EXE project. All code shown here
//resides
//in the SKUResolve class. (Class 1 was renamed to SKUResolve).
//To access the database, the following reference was included in
//the project: Microsoft DAO 2.5/3.5 Compatibility Library.
//The following line forces the compiler to make sure all variables
//are declared prior to use within the program.
Option Explicit
//This function receives a UPC code as it’s only parameter and
//cross-references it with a value in the database to get the
//corresponding SKU code.
Public Function ResolveSKU(UPCCode As String) As String
Dim DB As Database, RS As Recordset
Set DB = DBEngine.Workspaces (0) .OpenDatabase
A("c:\GENSRVNT\tutorial\upcsku.mdb")
Set RS = DB.OpenRecordset ("UPCSKU", dbOpenDynaset)
//Make sure there are no trailing spaces on the parameter passed
//to this function.
UPCCode = Trim (UPCCode)
//Since the database is case-sensitive make sure that the parameter
//has all capitalized letters in it.
UPCCode = UCase (UPCCode)
RS.MoveFirst
//Loop until we find the UPC code or until the end of the recordset
//is found.
While Not RS.EOF
//If we find the UPC code, return the 'SKU code associated with it.
If RS ("UPCCode") = UPCCode Then
ResolveSKU = RS ("SKUCode")
Exit Function
End If
RS.MoveNext
Wend
//No matching UPC code was found for the parameter passed to the
//function. Return a value stating that there was no SKU found.
ResolveSKU = "No Record Found"
End Function
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C++ Automation This sample automation server was written in the C++ programming language. It performs
Server exactly the same function as the previous Visual Basic sample user exit—accessing a
Microsoft Access Database to cross-reference a UPC code with an SKU code. Note that
after compiling the Automation Server (UPCSKU.DLL), it was registered using
REGSRV32.EXE because it was not self-registering.

// This is a MFC AppWizard (dll) project with the Automation option
//selected. All code shown here resides in the CUpcSkuMain class
//which is derived from CCmdTarget. When the class was created in
//ClassWizard, the ProgID

//"UpcSku.BApplication" was specified in the "Createable by type
//ID:" field.

// This ProgID is different than the one used for the VB example so
//that both Automation servers can co-exist in the registry.

// To access the database, a class (CUpcSkuDaoRecordset) derived
//from CDaoRecordset is needed. DAO and Snapshot options were
//selected and the location of the database (Upcsku.mdb) was
//specified during the creation of the class in ClassWizard.

// Include the header file for the derived recordset class
#include "UpcSkuDaoRecordset.h"

// This function is called when the last reference for this
//automation object is released

void CUpcSkuMain::OnFinalRelease ()
{
CCmdTarget::0OnFinalRelease () ;

// Since we used DAO to access the database,
// terminate DAO now so the DLL can unload.

if (AfxOleCanExitApp())
AfxDaoTerm() ;
}
// This function receives a UPC code as it’s only parameter and
//cross-references it with a value in the database to get the
//corresponding SKU code.

BSTR CUpcSkuMain::ResolveSKU (LPCTSTR UPCCode)
{

CString strResult;

CString sUPCCode = UPCCode;

CDaoDatabase DB;
DB.Open ("C:\\GENSRVNT\\Tutorial\\Upcsku.mdb", FALSE, TRUE);

CUpcSkuDaoRecordset RS (&DB) ;
RS.Open () ;
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C++ Automation

Server // Make sure there are no trailing spaces on the parameter passed
(contd) //to this function.

sUPCCode.TrimRight () ;

// Since the database is case-sensitive make sure that the
//parameter has all capitalized letters in it.

sUPCCode.MakeUpper () ;
RS.MoveFirst () ;
// Loop until we find the UPC code or until the end of the recordset
//is found.
while ( !RS.ISEOF() )
{
// If we find the UPC code, return the SKU code
// associated with it.
if ( RS.m _UPCCode == sUPCCode )
{
strResult = RS.m_ SKUCode;

RS.Close () ;
DB.Close () ;

return strResult.AllocSysString();
}

RS.MoveNext () ;
// No matching UPC code was found for the parameter passed to the
// function. Return a value stating that there was no SKU found.
strResult = "No Record Found";

RS.Close () ;
DB.Close () ;

return strResult.AllocSysString();
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How to Create a User Exit

Before you begin  The ActiveX Automation Server must be installed on the same machine as the
Gentran:Server translator (where you are using the translation object that contains the user
exit).

Procedure  Use this procedure to create a user exit.

Step Action
1 Start the Gentran:Server Application Integration subsystem.
2 Open the map in which you want to apply a user exit.
3 Determine where the user exit will be located in the map (e.g., session
rule or extended rule).
Note

When you apply a user exit to a map component, subordinate map
components may also be able to execute the same user exit.

4 Construct the user exit.
Reference

» See Defining Extended Rules on page 6 - 12 for more information on
creating extended rules for various map components.

» See Alphabetic Language Reference on page 6 - 47 for more
information on the createobject, deleteobject, and getiid commands.
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Introduction

Introduction

In this appendix

What is

GentranEx.DLL?

Assumptions

Using GentranEx.DLL

This appendix describes how to use GentranEx.DLL, the Gentran:Server in-process
automation server.

Note
GentranEx.DLL is automatically installed during the Gentran:Server installation process.

GentranEx.DLL is an in-process automation server that extends the flexibility of the
Gentran:Server MAPPER.EXE (Application Integration) and TX32.EXE (translator)
programs by using COM technology and the IDispatch interface.

GentranEx.DLL enables you to perform several functions that exceed the scope of normal
Gentran:Server operation, including:

» accessing any GentranDatabase table,

» gathering information from a translation session and writing that information to a log
file, and

» extending the functionality of Application Integration extended rules.

This list contains the items with which this appendix assumes you are familiar.
» Gentran:Server for Windows,

» the Application Integration subsystem,

D  your operating system,

] automation servers,

» how and when extended rules are invoked and their scope, and

» how to create extended rules.

Reference

See Using Extended Rules, chapter 6, for more information on Application Integration
extended rules.

6
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Database Access

Overview

Introduction GentranEx.DLL allow access to any GentranDatabase table through the TSql statements
UPDATES and INSERTS. The GentranEx.DLL uses ODBC and the Gentran:Server
ODBC DSN (typically GentranDatabase) to connect to the database.

Note

The TSql statement must be generated by the user and passed to the Execute method. To
support a connection to an Oracle® database the TSql statements must enclose
Tablenames and Columnames in square brackets. These square brackets are automatically
converted to double quotes before the statement is executed.
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Implementing Database Access

Prog]I) "GentranEx.DispatchDBAccess"
Interface ID {860AAE85-7DA8-11D2-ABDB-00C04FF3971C}

Methods This table contains the database access methods.

Method Description
short ExecuteSQL (BSTR Returns "1" for success and "-1" for failure. Errors
IpszSQLString) are written to the Application Event Viewer.
BSTR GetLastError () Returns a string containing the error of the most

recent attempt to invoke the ExecuteSQL method.
If the last attempt was successful this call returns a
null string.

BSTR GetLastSQL() Returns a string containing the most recently
executed SQL statement using the
ExecuteSQL ( ... ) function.

Properties  None.

Extended rule  This is an example of an extended rule using GentranEx.DLL to access the
example  GentranDatabase.

Object obDBAccess;
Integer result;

String [64] szPartnerKEY;
String [1024] szMsg;

obDBAccess = CreateObject ("GentranEx.DispatchDBAccess");

szTSQL = "Update [interchange tb] Set [AppField6]=""+
#STATUS+

"" where [PartnerKEY]=""+

szPartnerKEY+

"" and [Direction]=1 and [ControlNumber]=""+#REF+"";
result = obDBAccess.ExecuteSQL (szTSQL) ;
if result = -1 then
Begin
szMsg = obDBAccess.GetLastError();
messagebox (szMsg, 0) ;
szMsg = obDBAccess.GetLastSQL () ;
messagebox (szMsg, 0) ;
End

deleteobject (0cbDBAcess) ;

Gentran:Server for Windows — August 2008 Application Integration User’s Guide
() g pp g



Using GentranEx.DLL
Debugging

Overview

Overview

Introduction GentranEx.DLL enables you to gather information from any translation session executed
on the machine on which GentranEx.DLL is installed, and write that information to a log
file. This function does not require any interaction from the user and thus is an efficient
alternative to using the Messagebox function when debugging map.

Each entry made to the log file contains the following information, which provides clarity
and readability to the log:

» date and time stamp,

» name of the log owner,

» source of the message, and
» the message.

Note

The name of the log owner, the source of the message, and the message are all supplied by
the user via the OpenLog() and WriteLog() functions.
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Implementing Debugging

Prog]I) "GentranEx.TraceLog"

Using GentranEx.DLL

Interface ID {7DA17F77-8090-11D2-ABE4-00C04FF3971C}

Methods  This table contains the debugging methods.

Method

Description

PathFilename,
Owner, short
WriteMode)

short OpenLog (BSTR

BSTR

» Returns "1" for success, "-1" for failure, and "-2" if
the file is already open.

» Argument 1 is the path and filename of the log file
to be created.

» Argument 2 is the owner of the log. This value is
written to the log file and is included to make the
log easier to read.

» Argument 3 is the writemode (i.e., | = append (this
is the default) and 2 = truncate).

» The "Owner" column in the generated log file is 20
characters wide — therefore Argument 2 is
truncated at that value (20) when written to the log
file.

short Open()

Opens a trace log file (named "GentranTrace.log") in
the GENSRVNT home directory. The file is opened in
Append mode and is assigned an Owner name of
"GentranEx".

Source, BSTR
Message)

short WriteLog (BSTR

» Returns "1" for success and "-1" for failure.

» Argument 1 is the source of the message that is
written.

» Argument 2 is the message text. Both Arguments 1
and 2 are written in separate columns in the log file
for clarity.

» The "Source" column in the log file is 20 characters
wide and thus Argument 1 is truncated at that value
(20).

» The "Message" column in the log file is 256
characters wide and thus Argument 2 of this
function is truncated at that value when written to
the log file.
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Using GentranEx.DLL Implementing Debugging

(Contd)
Method Description
BSTR GetLastError () Returns a string containing the error of the most recent
attempt to open the log file.
short CloseLog() Closes the log file and returns "1" for success or "-1" for
failure.
Note

The file should always be closed before your trace
object goes out of scope.

Properties  None.

Extended rule  This is an example of an extended rule using GentranEx.DLL for debugging.

exanqﬂe Object obTrace;

Integer result;
String [32] szPartnerKEY;

obTrace = CreateObject ("GentranEx.TracelLog");
result = obTrace.OpenLog ("D:\GENSRVNT\TraceTest.txt", "ICLANA",2) ;
if result = -1 then

Begin

obTrace.WriteLog ("Start of Log", "Trace Test");
obTrace.WriteLog ("Converted TUN#",szPartnerKEY) ;
End
obTrace.CloseLog () ;
deleteobject (obTrace) ;
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Overview Using GentranEx.DLL

Rules Extensions

Overview

Introduction GentranEx.DLL provides methods and properties that extend the functionality of the
Application Integration extended rules logic. For example, there are methods that allow
the conversion of strings from uppercase to lowercase, which allows greater control over
string comparison logic. Also, there are functions available that return the current date
and/or time. GentranEx.DLL also provides a property that can be referenced to determine
whether the automation server is running in a non-interactive environment.
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Using GentranEx.DLL

Implementing Rules Extensions

Prog ID

Interface ID

Methods

Properties

"GentranEx.Rules"

{387CO0F34-82F5-11D2-ABEA-00C04FF3971C}

This table contains the rules extension methods.

Implementing Rules Extensions

Method

Description

DATE GetDate()

Returns the current date. The assignment
operator (=) can be used to set any date/time
variable or date/time type field equal to the
value returned by this method.

DATE GetTime ()

Returns the current time. The assignment
operator (=) can be used to set any date/time
variable or date/time type field equal to the
value returned by this method.

BSTR ToUpper (BSTR szMixedCase)

Uses the string to be converted as its
argument.

Returns the original string converted to
uppercase. Any string variable, string
field, or string literal can be supplied as
the first argument.

BSTR ToLower (BSTR szMixedCase)

Uses the string to be converted as its
argument.

Returns the original string converted to
lowercase. Any string variable, string
field, or string literal can be supplied as
the first argument.

short InteractiveState
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Implementing Rules Extensions Using GentranEx.DLL

Extended rule  This is an example of an extended rule using GentranEx.DLL to exceed normal extended
example  rule logic.

Object obRules;

String [32] szLowerCaseStr;
String [32] szUpperCaseStr;
String [32] szResultString;
date d;

//Initialize values of string variables
szLowerCaseStr = "abcdefg";
szUpperCaseStr = "WXYZ";

//Create the Rules object
obRules CreateObject ("GentranEx.Rules") ;

//Test string conversion methods and display results
szResultString = obRules.ToUpper (szLowerCaseStr) ;
messagebox (szResultString,0) ;

szResultString = obRules.ToLower (szUpperCaseStr) ;
messagebox (szResultString,0) ;

//Test date methods
d = obRules.GetDate();
#TimeField = obRules.GetTime () ;

//Test whether running interactively
if obRules.InteractiveState = 1 then
messagebox ("We’ re running on the desktop",0);
else
Begin
//use the TracelLog object to write to a log file since we’re
//running non-interactively
End

deleteobject (obRules) ;
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Introduction Using the Translator Command Line Interface

Introduction

In this appendix  This appendix describes how to use translator command line interface to invoke the
services of TX32.EXE, including generating a translator report in XML format.

Notes
» Ifyou do not specify the XML format parameter, the report in generated in binary
form by default.

» This interface is currently used by all applications that invoke the services of the
TX32.EXE translator.
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Using the Translator Command Line Interface Command Line Syntax

Command Line Syntax

Introduction  The syntax of the command line is:

tx32 n]l [-qg]

a server]

e eventid]

i ipckey [hwnd] ]

-f infile templatefile outfile report file]
u param -u param ..]

t tracefile]

x XMLformattedreport]

Syntax parameters  This table describes the command line syntax parameters.

Parameter Description
-n Do not move document to InDrawer after print or export
-q Quiet mode (does not display message boxes or status dialog box)
-a Server (name of audit server to which TX32.EXE connects)
-e EventID (identifier of an audit event to which this translator belongs)
-1 Inter-process communication (IPC) mode
Subparameter Description
ipckey Key to ipcfile (translator will use the IpcMsg
folder and add .IPC)
hwnd Number representation of the parent
applications’s main window handle
-f Simple-translator mode
Subparameter Description
infile Path to file to be translated
templatefile Path to translation object to be used
outfile Path to file to write translated output
reportfile Path to create translator report
-u User-defined parameters accessible from extended rules
Subparameter Description
param Parameter value
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Command Line Syntax

Using the Translator Command Line Interface

Parameter Description
-t Trace mode
Subparameter Description
tracefile Path to trace the file to be used
-X XML formattedreport Generates the translator report in XML

format

Note

If you do not specify this parameter the
report in generated in binary form by
default.
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GLOSSARY

Glossary

?In Documents This Gentran:Server browser contains a list of documents that were received by the
system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents This Gentran:Server browser contains a list of documents that were imported into the
system via unattended processing but are invalid.

acknowledgement  This term is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When translating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  The Automotive Industry Action Group (ATAG) is the standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI  American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committee is the
chief EDI standards-setting organization for the United States.

application file  If you are creating an import or export map, you must define your application to
Gentran:Server. In Gentran:Server terminology, your application file is also referred to as
a fixed-format file or a positional file. Your application file must contain all the
information that you either need to extract from your partner’s document (if the map is
inbound) or need to send to your partner (if the map is outbound), so that your system can
accurately process the data.
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application system Glossary

application system

browser

button

check box

click

code list tables

colours

communications
session

Communicator

compile

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser is a window that displays a list of items, such as documents (transaction sets),
interchanges, translation objects, etc. A document browser displays only documents.

A button enables you to execute a command. You select a button either by clicking it or by
pressing TAB until the button you want is selected and then pressing ENTER.
Unavailable buttons are dimmed, and the currently selected button has a darker border
than the other buttons.

A check box enables you to select or clear options from a list. You can select as many
options from the list as you need. A selected check box contains a checkmark. The labels
of unavailable options are dimmed.

Click indicates that you should position your cursor on top of the designated item and
press and release your primary mouse button. The primary mouse button is the button you
access with your index finger, regardless of whether you are utilizing right-handed or left-
handed mouse operation.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visually define
the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one continuous period of
connection. This could include sending two or three interchange envelopes to a network,
each for a different trading partner.

This is the Gentran:Server communications software. The Communicator enables you to
send, receive, resend, establish communication port definitions, establish communication
profiles, establish communication scripts, and view and delete communication sessions.

This function compiles the map and creates a translation object. The map that you create
using Gentran:Server is a source map. When that source map is compiled, the result is a
compiled translation object. This translation object must be registered with the
Gentran:Server system before you can use it.
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Glossary

compliant

component data
element

composite data
element

conditions

constant

cross-reference
table

date/time

deactivation

default

dialog box
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compliant

This means that the document conforms to the EDI standards as defined by the translation
object.

A simple data element that belongs to a composite data element. Component data
elements are also called sub-elements.

A contains two or more component data elements or sub-elements. Composites are
defined by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

See relational condition on page 1 - 9.

This standard rule enables you to move a literal constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

This table is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

This type of field or element contains a date or time. If you specify that a field or element
is a date/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

A dialog box contains additional information or options that you need to act on. If you
specify any options, you can select a button to execute the command. Some dialog boxes
display warnings or messages indicating why a requested task cannot be accomplished. If
the dialog box has a title bar, you can move it to another location on your desktop.
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document

document

EANA

EDI

EDI standard

EDIA

EDIFACT

element

Glossary

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
as a single entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If a trading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

This is the rules for turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

This is the standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, as illustrated in the table below:

Data Element Definition
Simple data element A single piece of information defined by the standards.
Composite data element A data element that is made up of multiple component
elements.
Component data element A simple data element that belongs to a composite data
element. Component data elements are also called sub-
elements.
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Glossary

envelope

equalize

export map

export translation
object

extended rules

field

fixed-format file

font

envelope

A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and a trailer segment, which separate the envelope from other
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, as follows:

» Transaction Set
Each transaction set (business document) is contained within a transaction set
envelope.

» Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

» Interchange Envelope
All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term Transmission
Envelope to refer to this level of envelope. Since we use the term transmission for
other uses, we refer to Interchange Envelope only.

This function enables you to reinstate the two sides of the map with focus in equal
dimensions. The use of the Equalize function is optional.

This map defines how to move data from the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map on page 1 - 5.

These rules enable you to use a Gentran:Server proprietary programming language to
perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application file on page 1 - 1.

This feature enables you to globally change the font that is used in the display of all maps.
The default font that Gentran:Server uses is a Sans Serif 9 point. The Font feature enables
you to change the font type, style, and point size. This gives you the flexibility to shrink
the font if you need to view more of the map on your monitor, enlarge the font, or change
the type and style to be more easily readable by you.
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functional group Glossary

functional group

group

import

import map

import translation

object

inbound mapping

In Documents

In Drawer

integer

interchange

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of times that the loop is
allowed to repeat is exhausted. If you create a group that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (a loop within a loop). The
application (positional) file and the EDI file are both groups and therefore, they is visually
represented the same way as other groups and sub-groups in Gentran:Server.

This command enables you to import data from an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map on page 1 - 6.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To translate
inbound data, you need to create an export map.

This Gentran:Server browser contains a list of documents that the system received but that
have not yet been processed by the user. Once the documents are processed (printed or
exported) the documents are transferred to the In Drawer.

This Gentran:Server browser contains a list of documents that were received and
processed.

An integer is a number that has an implied decimal point (e.g., “2.01” is formatted as
4‘2013’).

The interchange contains all the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.
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Interchanges
browser

link

literal constant

location table

lookup table

loop count

loop start/loop end

map

menu

Interchanges browser

This Gentran:Server browser enables you to view a hierarchical list of all the interchanges
that were sent or received. It contains status information about the interchanges, (e.g.,
whether or not a functional acknowledgement was received and the status of that
acknowledgement). This browser also enables you to access the documents within the
interchanges. The Interchanges browser can always be accessed.

This function enables you to map a field or element from the Input side of the map to a
field or element on the Output side of the map. The link between two map components
(hereafter referred to as fields) is visually represented with a line connecting the two
fields.

These are used by the system as a repository to store information that is used at a later
point in the map. Typically, constants are used in an outbound map to generate a qualifier.

This is a table created in Partner Editor that is used to contain address-related information
about the partner.

This is a table created in Partner Editor that is used to select information related to a value
in inbound or outbound data.

This standard rule enables you to count the number of times a loop is repeated, if the
element or field is part of a loop. If the loop is a nested loop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the “3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and LE segments and depending on whether your map is inbound or
outbound, you need to define the LS and LE segments for the loops you are using in the
map in one of two different ways.

A set of instructions you define in the Gentran:Server Application Integration subsystem
that indicates the corresponding relationship between your application file and the EDI
standards, and defines how the system should translate data.

A list of items from which you can choose. Each item represents a command. Unavailable
items on a menu are dimmed to inform you they are disabled.
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menu bar

menu bar

network

number

ODETTE

outbound mapping

Out Documents

Out Drawer

partner

Partner Editor

positional file

post

predefined

Glossary

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for a trading partner to accept
them.

This type of field or element contains either an integer or real number. If you specify that a
field or element is a number type, you must designate the format by specifying a format of
either “N” (integer) or “R” (real) and the number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

The system translates your application file format to EDI standard formats, so you can
send documents to your partners. To translate outbound data, you need to create an import
map and a system import map in Gentran:Server.

This Gentran:Server browser contains a list of documents that are ready to be sent. After
the documents are successfully sent, they are automatically transferred to the Out Drawer.

This Gentran:Server browser contains a list of documents that were successfully sent out
by the system.

Another firm with which your company trades documents. Also referred to as a trading
partner.

This Gentran:Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file on page 1 - 1.

This Gentran:Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On a data entry translation object, a default value for a particular element. You can change
the value as necessary.
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printout

promote

qualifier

real number

receive

record

relational
condition

respond

responsible
agency
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printout

This is produced when data received from a trading partner passes through a print
translation object. You do not have to actually print the data. The printout could be to a file
on your hard disk.

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Gentran:Server specifies that only one-to-one (no loops) or many-to-many
(loop) mapping relationships are valid.

This is an element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01” is formatted as “2.01”), and
truncates trailing zeroes.

This Gentran:Server function enables you to manually initiate a communications session
to receive data from your trading partner.

Contains a group of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A is invalid unless Field B is present. Therefore, if you set up a condition
that pairs Fields A and B, the system generates a compliance error if one of those fields is
not present.

This Gentran:Server function enables you to create a turnaround document (using the Turn
Around translation object in the partner relationship) in response to one or more selected
documents in the In Drawer.

An organization that develops and updates standards for EDI communications. These
organizations include ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.
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segment

segment

select

send

set

simple mapping

split

standard rules

status bar

string

Glossary

A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someone to tell if the item is what is desired, whether the price is reasonable, etc. A
number of segments together form a transaction set.

This standard rule enables you to select entries from a location table, cross-reference table,
partner table, or lookup table (all tables created in the Gentran:Server Partner Editor). You
can then map the fields in those tables to one or more fields in the data. The Select
function uses the value of the current field to perform the selection.

This Gentran:Server function enables you to manually start a communications session to
send data to your trading partner. Only selected documents are enveloped and sent. If no
documents are selected, ALL documents are sent. Successfully sent documents are moved
to the Out Drawer.

See transaction set (document) on page 1 - 12.

See link on page 1 - 7.

This function enables you to split (break) a group or repeating segment into two loops.
You typically use this function when you need more than one instance of the same map
component that still occurs multiple times.

These rules give you access to functions that are necessary for mapping operations that are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

The status bar of an application window defines information about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM
for the “Num Lock” key, etc.).

This type of field or element contains one or more printable characters. If you specify that
a field or element is a string type, you must designate the format by specifying a syntax
token.
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syntax token

system import
map

system import
translation object

system translation
object

TDCC

TDF

third-party
network

title bar

toolbar
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syntax token

This function enables you to designate a “token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog box. This enables you
to define what type of characters should be used while compliance checking each element/
field (i.e., alphanumeric within a certain range, numeric within a certain range, etc.).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document. You need a system import map that is
defined in EDIMGR.INI to translate outbound data.

See system import map on page 1 - 11.

These translation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Gentran:Server system.

See EDIA on page 1 - 4.

TDF is the Transaction Data File. This file serves as a filter between your document files
and the Gentran:Server translator. For outbound processing, data is imported from a TDF
file and translated to EDI format using a TDF Import translation object. The data is then
ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Gentran:Server can be exported to a TDF-formatted file
using a TDF Export translation object. This data file is then ready to be processed or
converted to your internal application files.

See network on page 1 - 8.

The title bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the Menu Bar.
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TRADACOMS Glossary

TRADACOMS

trading partner

transaction set
(document)

translation object

translator

transmission

transmission
chain

turnaround
document

The U. K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

Another firm with which you company trades documents. Also referred to as a partner.

A business form as defined by the standards. Examples include an ANSI 850 purchase
order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the
relationships among them. This is also known as “message” in Europe.

A predesigned layout set up to ensure that input or output for a particular transaction set
exists and is presented in a usable fashion. You must specify which translation objects are
used by each partner relationship.

Inbound Translation Objects:

Turn Around: This translation object is used when a document is received, to
create the natural response document that contains as many elements from the
received document as possible.

Export File: This translation object indicates that when a document is received, it is
exported to a specified file format.

Print: This translation object is used to print documents.

Outbound Translation Objects:
Import: This translation object is used to import data from an application file.

Print: This translation object is used to print documents.

Data Entry: This translation object is used to enter data into the Document Editor facility.

This is the engine that processes data for Gentran:Server, the Application Integration
subsystem, and the Forms Integration subsystem.

See communications session on page 1 - 2.

A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

A document into which data elements from the source document have been automatically
transferred using a turnaround map.
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turnaround map

UCS

update

use accum

use code

user translation
object

version

turnaround map

A series of instructions that the system uses to create a turnaround document (a logical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elements in the target document (translation object).

The Uniform Communications Standard is the standard used by the grocery industry.

This standard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format type is
EDI), with the contents of the element or field.

Warning

This function updates the internal Gentran:Server database tables. We recommend
that you use this function only if you are sure you really want to update the internal
database tables.

Typically, you only use this function if you want to update the document name and
reference in the document table. Any other use of this function could have disastrous
consequences!

This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error is generated if the element or field does
not contain one of the values in the code table, and store a code’s description in another
element or field.

These translation objects control data entry, importing, exporting, document turnaround,
and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.

Each standards-setting body updates its standards on a regular basis. Each formal update is
referred to as a version.
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VICS Glossary

VICS The Voluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

Workspace This Gentran:Server browser contains a list of outbound “Work in Progress” documents. It
also contains recently imported or data entry documents.

X12 The ANSI committee that sets and publishes standards for EDI.
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